Full Circle
THE INDEPENDENT MAGAZINE FOR THE UBUNTU LINUX COMMUNITY

ISSUE #1 00 - August 201 5

ISSUE

1

S P EC I AL 1 0 0 T H B U M P E R I S S U E

LOOKING BACK AT UBUNTU, YOUR STORIES, AND MORE!
full circle magazine #1 00

1

Fu ll Ci rcle M a g a zi n e i s n e i th e r a ffi li a te d wi th , n o r e n d o rse d b y, Ca n o n i ca l Ltd .

contents ^

Full Circle

HowTo

THE INDEPENDENT MAGAZINE FOR THE UBUNTU LINUX COMMUNITY

Linux News

p.04

p.1 1

Chrome Cult

p.48

Ubuntu Phones

p.36

Linux in Industry

p.62

p.71

Letters

p.88

Tuxidermy

p.89

p.90

Linux Loopback

p.93

Ubuntu Games

p.95

Python

p.21

LibreOffice

p.23

Command & Conquer

p.1 9

Great Ancestor

Website From Scratch

p.26

Linux Labs

p.53

Programming COBOL

p.31

My Story

Inkscape

p.37

Q&A

Graphics

The articles contained in this magazine are released under the Creative Commons Attribution-Share Alike 3.0 Unported license.
This means you can adapt, copy, distribute and transmit the articles but only under the following conditions: you must attribute
the work to the original author in some way (at least a name, email or URL) and to this magazine by name ('Full Circle Magazine')
and the URL www.fullcirclemagazine.org (but not attribute the article(s) in any way that suggests that they endorse you or your use of the work). If
you alter, transform, or build upon this work, you must distribute the resulting work under the same, similar or a compatible license.
Full Circle magazine is entirely independent of Canonical, the sponsor of the Ubuntu projects, and the views and opinions in the
circle Canonical
magazine #1
00
2
magazine should in no way be assumedfull
to have
endorsement.
contents ^

ED I TO RI AL

This magazine was created using :

WELCOME TO THE 1 00TH ISSUE OF FULL CIRCLE.

W

ell, it's finally here. And I still can't believe it. One hundred issues of FCM. Incredible!
Again, a big thank you to all who've written for FCM, or help in the background with
proof reading or translation. Without you kind folks we wouldn't be here.
For this issue I thought we'd go off the beaten path for a change. The theme is somewhat
retrospective. What was Ubuntu like years ago? How did you get into Ubuntu (or Linux)? Has
Ubuntu changed things for you? Read on. It's a bumper issue. Almost double the norm.
Alan Ward starts off this issue with a look back at the grand daddy of them all, Warty
(4.1 0). We still have some HowTo articles for you, though. So fear not. Two new series start
this month. The first is on building a website from scratch. And we mean from nothing. This
series will take you from setting up an infrastructure to finally getting a site online. The
second is more historical. SJ Webb is starting with those early days of room sized computers
and discusses the earliest (allbeit harmless) viruses. I've written a couple of articles
discussing the FCM site, comparing 2007 to 201 4, revealing the results of your most
loved/hated *buntu releases, how Linux is used in several different industries, and telling
you my story of how I got into Ubuntu.
The big news this month regarding Ubuntu phones is that BQ is now shipping the Aquaris
E4.5 and E5HD worldwide! So all you folks outside of the EU can now buy one. Just check the
hardware specs against what's available in your part of the world.

All the best, keep in touch, and here's to another 1 00 issues!
Ronnie
ronnie@fullcirclemagazine.org

Full Circle Podcast

Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:

• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark
http://fullcirclemagazine.org
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U BUNTU 1 5.1 0 (WILY
WEREWOLF) I S N OW
REBASED ON LINUX KERNEL
4.2 RC5

kernel from the Linux 4.1 LTS
series.

successful had AMD shipped it with
the Catalyst 1 5.7 WHQL drivers
instead of waiting almost two
Source:
weeks after the release before
http://linux.softpedia.com/blog/ub updating it.
untu-1 5-1 0-wily-werewolf-is-nowThe company, however, seems
ccording to Mr. Salisbury, the rebased-on-linux-kernel-4-2-rc5to have mended its ways and is
Ubuntu Kernel Team managed 488521 .shtml
Submitted by: Arnfried Walbrecht now extending its efforts towards
to rebase the master-next branch
driver updates not only for
of the anticipated Ubuntu 1 5.1 0
Windows but other platforms as
(Wily Werewolf) operating system
well.
on the upstream Linux 4.2 RC5
N EW LINUX D RIVERS FOR
kernel, which was just announced
AMD G RAPHICS CARDS
A recent report from Chris
by Linus Torvalds this past
Hoffman
of PC World details AMD
weekend.
dvanced Micro Devices (AMD) driver's status for Linux-based
has recently released DirectX systems and the company's
"We have rebased our Wily
1 2 drivers for its GPU line.
endeavor in updating the said
master-next branch to the latest
However, it doesn't end there. The drivers. Hoffman noted that AMD
upstream v4.2-rc5 and uploaded to company has finally made efforts
currently has two main drivers for
our ~canonical-kernel-team PPA.
towards improving its drivers for
Linux: the open-source "Radeon"
We are resolving fallout from
Linux-based systems.
driver and the closed-source
DKMS packages at this time before
"Catalyst" driver.
we proceed uploading to the
Taking TDP out of the equation,
archive," says Joseph Salisbury.
driver support and stability have
Source:
always been two of the issues
Therefore, we can only assume thrown at AMD graphics cards. The http://www.latinopost.com/article
s/21 495/201 50805/new-linuxthat the final release of the
"fabless" chip designer has
drivers-amd-graphics-cards.htm
Ubuntu 1 5.1 0 (Wily Werewolf)
suffered in the desktop GPU
operating system, due for release market due to these issues. In fact, Submitted by: Arnfried Walbrecht
on October 22, 201 5, will be based many argue that the Fury X's
on the Linux 4.2 kernel series. At
release would have been more
the moment, the OS is based on a
full circle magazine #1 00
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FOR LINUX,
SUPERCOMPUTERS R U S

S

upercomputers are serious
things, called on to do serious
computing. They tend to be
engaged in serious pursuits like
atomic bomb simulations, climate
modeling, and high-level physics.
Naturally, they cost serious money.
At the very top of the latest
Top500 supercomputer ranking is
the Tianhe-2 supercomputer at
China’s National University of
Defense Technology. It cost about
$390 million to build.
But then there’s the
supercomputer that Joshua
Kiepert, a doctoral student at
Boise State’s Electrical and
Computer Engineering
department, created with
Raspberry Pi computers. It cost
less than $2,000.
No, I’m not making that up. It’s
an honest-to-goodness
supercomputer made from
overclocked 1 -GHz Model B
Raspberry Pi ARM1 1 processors
contents ^
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with Videocore IV GPUs. Each one
comes with 51 2MB of RAM, a pair
of USB ports and a 1 0/1 00 BaseT
Ethernet port.

interesting tutorial a couple of
days ago about how to install the
latest Linux 4.1 LTS kernel on
Ubuntu, Linux Mint, or Debian
distros.

Source:
http://linux.softpedia.com/blog/pl
PLEX M EDIA SERVER
2-8-now-has0.9.1 2.8 N OW H AS PROPER ex-media-server-0-9-1
proper-update-for-ubuntu488909.shtml
U PDATE FOR U BUNTU
And what do the Tianhe-2 and
Submitted by: Arnfried Walbrecht
the Boise State supercomputer
Therefore, we decided to test
lex Media Server can be used
have in common? They both run
Mr. Exton's guide on how to install
on a number of platforms,
Linux. As do 486 out of the world’s Linux kernel 4.1 LTS on an Ubuntu including Linux, Windows, and Mac
LINUS TORVALDS I S H APPY
fastest 500 supercomputers. It’s
or Debian GNU/Linux operating
OS X. It’s capable of connecting
part of a domination of the
system, as well as to post his
AGAIN WITH LINUX KERNEL
lots of smart devices. With the
category that began over 20 years tutorial here with detailed
right kind of setup, you can turn
4.2 RC6
ago. And now it’s trickling down to instructions for anyone to
almost any PC into a media center.
built-on-the-cheap
understand them. Before anything It can even be accessed over the
inus started this cycle by
supercomputers. Because Kiepert’s else, please note that the
Internet and not online in local
praising the developers for
machine isn’t the only budget
following guide is only for 64-bit
networks.
providing one of the biggest
number cruncher out there.
versions of Ubuntu and Debian.
releases made until now, but he
According to the changelog, a
soon realized that they weren't
Source:
Please also note that the
few regressions in Linux and NAS
stopping with the patches. His joy
http://www.computerworld.com/a following instructions will replace packaging in 0.9.1 2.7 have been
of seeing a large number of
rticle/2960701 /linux/for-linuxthe current kernel packages of
fixed, the remote access in certain developers pushing patches
supercomputers-r-us.html
your Ubuntu, Debian, or Linux Mint cases involving proxies has been
quickly turned to anger when RC5
Submitted by: Arnfried Walbrecht distributions with "kernel 4.1 .0-3corrected, the web player is now
also proved to be bigger than he
exton," which is the equivalent
restored on launch if the app was
expected.
version of the official Linux 4.1 .3
playing when page was
LTS kernel that can be downloaded reloaded/closed, deleting media
H OW TO I NSTALL LINUX
RC5 is usually passed at the
from the kernel.org website. It
files moves them to trash, the
halfway point in the cycle, so it's
KERNEL 4.1 LTS ON 64-BIT should work for any
upgrade system now works again
easy to understand why Linus
U BUNTU, LINUX M INT, AND Ubuntu/Debian-based OS.
properly for Drobo, Thecus,
doesn't like big changes so late. It
D EBIAN OSES
Ubuntu and other platforms, a case takes time to test everything and
Source:
where hitting the APPLY button
to determine if a release is stable.
http://news.softpedia.com/news/h
rne Exton, an independent
showed no remote access
That means that activity on the
ow-to-install-linux-kernel-4-1
-ltsGNU/Linux developer, known
incorrectly was solved, and the
developing front must slow down
on-64-bit-ubuntu-linux-mint-andfor many Linux kernel-based
enable / disable buttons in Remote towards the end. Fortunately,
debian-oses-488844.shtml
operating systems, posted an
Access are now much more visible. Linus seems to be happy again, so
Submitted by: Arnfried Walbrecht
full circle magazine #1 00
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it must mean that things are going
back to normal.
Source:
http://news.softpedia.com/news/li
nus-torvalds-is-happy-again-withlinux-kernel-4-2-rc6-488863.shtml
Submitted by: Arnfried Walbrecht

LINUX CONCERNS:
CONVENIENCE VS. SECURITY

O

nce upon a recent time, Linux
was more secure than it is
today. Only the root user could
mount external device, and in
many distributions, new users
were automatically assigned a few
groups that limited the hardware
they could access. Distributions
followed the principle of least
privilege (aka least access), under
which users, applications, and
devices receive only the access to
the system that they absolutely
require.
Applying least privilege makes
for a securer system, which is
where Linux gained its reputation.
However, a secure system is often
an inconvenient system, and hopes
of desktop domination put
pressure on distributions to match

the convenience of Windows. The
problem was not so much that
increased popularity encourages
the writing of viruses and malware
as that the hope of popularity
encouraged the relaxation of
security standards in dozens of
little ways.
A few changes had mixed
results. For example, the rise of
Ubuntu introduced the use of
sudo, which helps to reduce the
amount of time that the root user
is logged in. But, as implemented,
it can make possible the control of
a system from multiple accounts,
which means that Ubuntu
simultaneously increases and
decreases security. More often,
though, the changes were in the
name of being as convenient as
Windows, with the cumulative
effect.

CONTAINERS

I

n an interview, Canonical
strategic leader Dustin Kirkland
has revealed that Canonical,
Ubuntu Linux's parent company,
and Microsoft are working
together on the LXD container
hypervisor.

hypervisor into the faster, more
efficient world of containers."
Source:
http://www.zdnet.com/article/can
onical-and-microsoft-workingtogether-on-containers/
Submitted by: Arnfried Walbrecht

LXD is an open-source
ALIBABA, DCHQ,
hypervisor designed specifically for M EDIATEK , PAYPAL AND
use with containers instead of
WUHAN D EEPIN
virtual machines (VMs). Kirkland
said, "At Canonical, we've been
TECHNOLOGY J OIN LINUX
working on containers in Ubuntu
FOUNDATION
for more than half a decade,
providing a home and resources
he Linux Foundation, the
for stewardship and maintenance
nonprofit organization
of the upstream Linux Containers
dedicated to accelerating the
(LXC) project since 201 0."
growth of Linux and collaborative
Where Microsoft comes in is as development, today announced
that Alibaba, DCHQ Inc., MediaTek
a LXD partner.
Inc., PayPal, and Wuhan Deepin
Technology Co. Ltd are joining the
Source:
Microsoft is using LXC with
http://www.datamation.com/featu Windows API calls in place of Linux organization.
re/linux-concerns-convenience-vs.- API calls for its Docker containers.
Linux has become the de facto
security.html
LXC is one of the fundamental
means of collaborative
Submitted by: Arnfried Walbrecht Linux container technologies,
development in recent years, with
underlying Docker and other
important container specifications. no signs of slowing down. Today's
new members show how global
CANONICAL AND M ICROSOFT LXD runs on top of LXC, and
and ubiquitous Linux is, from
Kirkland said "endows the
WORKING TOGETHER ON
container-based solutions and
advantages of a traditional
virtual banking to the lightweight
full circle magazine #1 00
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computing solutions of tomorrow.
Organizations pick Linux for rapid
innovation and optimal
performance and stick with it for
its dynamic, inventive community,
which will meet in Seattle at
LinuxCon/CloudOpen North
America and ContainerCon Aug.
1 7-1 9, 201 5.

perspective, it's just another
reason to move to Linux.

Many journalists have treated
Windows 1 0 with a lot of lenience,
to say the least. Many have said
that Windows 1 0 does collect
plenty of data, but that it is OK
because others are doing it as well
and pointed fingers at Google or
Source:
Facebook. Just because others are
http://www.marketwatch.com/stor doing it doesn't mean that it's OK
y/alibaba-dchq-mediatek-paypalfor everyone involved. It's
and-wuhan-deepin-technologyinteresting to see how, in just a
join-linux-foundation-201 5-08-1 3
couple of years, we've moved from
Submitted by: Arnfried Walbrecht being apprehensive about sharing
our personal details online to
calling it an evolution.

LINUX N EVER H AD A B ETTER
CHANCE TO B EAT WINDOWS

W

indows 1 0 is out, and
everyone is talking about it.
It's clear that Microsoft did
something right for a change and
that the latest version of the OS is
better than the previous releases.
This is actually a good thing.
What's not great about it is the
fact that Windows 1 0 collects huge
amounts of data about your PC
and you as a user, and most media
outlets seem to think that it's OK
and that it's just an evolution of
the operating system. From my

Source:
http://lxer.com/module/newswire/
view/21 7961 /
Submitted by: Arnfried Walbrecht

FREEBSD 1 0.2 LANDS WITH
GNOME 3.1 4.2 AND KDE
4.1 4.3

U

sers might forget from time
to time that Linux is not the
only operating system out there
and that BSD is alive and thriving.
There are a number of BSD
derivatives in production, and
full circle magazine #1 00

FreeBSD is just one of them. Its
developers are quite active, and
updates are made all the time.

version 3.7.0, the NTP suite is now
at version 4.2.8p3, and Centos 6
ports are now supported.

To make things even more
interesting, FreeBSD comes with
support for a large number of
platforms, including 64-bit, IA64
(from Intel), PowerPC (older Mac
computers), and SPARC64. It takes
a lot of work to keep the support
going for these platforms,
especially since a few of them are
no longer in use.

Source:
http://news.softpedia.com/news/fr
eebsd-1 0-2-lands-with-gnome-31 4-2-and-kde-4-1 4-3-489345.shtml
Submitted by: Arnfried Walbrecht

The BSD platform is not as
strange as it might seem. For
example, the FreeBSD operating
system can use pretty much the
same components as any Linux OS,
including stuff like GNOME or KDE,
which coincidentally have been
updated as well in the repos.
"The FreeBSD Release
Engineering Team is pleased to
announce the availability of
FreeBSD 1 0.2-RELEASE. This is the
third release of the stable/1 0
branch, which improves on the
stability of FreeBSD 1 0.1 -RELEASE
and introduces some new
features," say the developers in
the official announcement.

I

According to the changelog,
resolvconf has been upgraded to

7

LINUX FOUNDATION
LAUNCHES O PEN
M AINFRAME PROJECT
t’s 201 5 and you might think of
the mainframe as a vestige of an
earlier computing era, but these
mega machines still play a role
inside large institutions running
intensive workloads.
And as though to prove its
ongoing utility, The Linux
Foundation announced it was
launching the Open Mainframe
Project today, an open source
endeavor devoted to helping
companies using mainframe
computers.
The new venture was driven in
large part by IBM, a primary
supplier of these machines. In fact,
it’s not a coincidence that it
contents ^
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announced a partnership with
Canonical today to build a Linux
mainframe running Ubuntu Linux.
It may surprise you to learn
Linux has been running on
mainframes for 1 5 years, and as
Linux usage has grown on
mainframes, a community of users
has built up. The project is a
response to that growing demand,
Jim Zemlin, executive director at
the Linux Foundation explained in
a statement.

Source:
http://techcrunch.com/201 5/08/1 6
/linux-foundation-launches-openmainframe-project/
Submitted by: Arnfried Walbrecht

LINUX M ANGAKA, U BUNTU
FOR M ANGA AND ANIME
FANS, D ROPS ELEMENTARY
OS STYLE FOR KDE

A

fter a single RC (Release
Candidate) version, Linux
The idea is that those
Mangaka Koe is finally here, but
companies participating in this
with a "big surprise" for all anime
project can work together, and
begin building a set of open source and manga fans who used the
previous versions of the
tools and technologies for Linux
distribution. The developers
mainframes, while helping one
decided to drop the elementary OS
another overcome common
style in favor of the KDE desktop
development issues in the same
manner as all open source projects. environment, so the Koe release of
Linux Mangaka is now based on
Kubuntu 1 4.04 LTS (Trusty Tahr).
“The Open Mainframe Project
gives these customers, vendors
"After the success releasing
and service providers one place to
NYU with a lot of passion, we
come together,” Ross Mauri,
general manager for IBM Systems decided to start creating KOE
which reached the final stage
explained.
yesterday," says Animesoft
International. "We beg for your
IBM is sweetening the pot by
patience at booting, the system
contributing 250,000 lines of
has not a boot-logo (to look more
mainframe code to the Linux
intuitive with the KDE desktop) but
community.
full circle magazine #1 00

positively it ships some
customization to fit the way as a
complete beautiful Operating
System made just for you!"
Source:
http://linux.softpedia.com/blog/lin
ux-mangaka-ubuntu-for-mangaand-anime-fans-drops-elementaryos-style-for-kde-489461 .shtml
Submitted by: Arnfried Walbrecht

In an interview Shuttleworth
said that Ubuntu Linux will be
available on the mainframe by
April 201 6 in the next long-term
support version of Ubuntu: Ubuntu
1 6.04. Canonical and IBM already
took the first move in this direction
in late 201 4 by bringing Ubuntu to
IBM's POWER architecture.

Before that, Canonical and IBM
almost signed the dotted line to
bring Ubuntu to IBM mainframes in
U BUNTU LINUX IS COMING TO 201 1 but that deal was never
finalized. This time, it's happening.
IBM MAINFRAMES

A

ccording to Ross Mauri, IBM's
General Manager of System z,
and Mark Shuttleworth, Canonical
and Ubuntu's founder, this move
came about because of customer
demand. For over a decade, Red
Hat Enterprise Linux (RHEL) and
SUSE Linux Enterprise Server
(SLES) were the only supported
IBM mainframe Linux distributions.
As Ubuntu matured, more and
more businesses turned to it for
the enterprise Linux, and more and
more of them wanted it on IBM big
iron hardware. In particular, banks
wanted Ubuntu there. Soon,
financial CIOs will have their wish
granted.

8

Source:
http://www.zdnet.com/article/ubu
ntu-linux-is-coming-to-themainframe/
Submitted by: Arnfried Walbrecht

LINUX FOUNDATION

ANNOUNCES OPEN SOURCE
BEST PRACTICES BADGE
PROGRAMME

T

he Linux Foundation has
announced its plans to
introduce a new badge programme
designed to help identify open
source projects that have made
security a priority. The new effort,
contents ^
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which is part of the Foundation's
Core Infrastructure Initiative (CII),
aims to identify and fund critical
open source projects in need of
assistance.

advanced way of storing data on
servers.

After a number of years of
development, the Bcache File
System (Bcachefs) "is more or less
"Despite its prevalence, trying
feature complete -- nothing critical
to quickly determine the best
should be missing," wrote project
maintained and most secure open head Kent Overstreet, in an e-mail
source to use is a complex problem to the Linux Kernel Mailing List late
for both seasoned CIOs and nimble Thursday.
developers. The self-assessment,
and the badges that will follow, are
Linux currently has plenty of
designed to be a simple, fairly
working file systems, though no
basic way for projects to showcase one file system seems to be besttheir commitment to security and
suited for all uses.
quality," The Linux Foundation said
in its statement.
The main goal of Bcachefs is to
match the speed of traditional
Source:
Linux file systems with the
http://www.firstpost.com/business advanced scalability and reliability
/linux-foundation-announcesof newer file systems, Overstreet
open-source-best-practices-badge- wrote.
programme-2400298.html
Submitted by: Arnfried Walbrecht
Although not a sexy technology,
file systems provide the interface
to the operating system for storing
FORMER G OOGLE ENGINEER files on a disk.

REVS UP A NEW LINUX
FILESYSTEM

A

n ex-Google engineer is
developing a new file system
for Linux, with the hopes that it
can offer a speedier and more

Overstreet is working on the
file system on his own time,
without outside funding. He is
seeking other administrators and
developers to test the system and
even contribute to its
development.
full circle magazine #1 00

Nonetheless, the release of
Bcachefs seems to have met with
cautious optimism by the Linux
professionals on the Hacker News
online forum, though one
contributor did say of Overstreet
that "I hope the guy has a large
stash in his bank. File systems take
notoriously long to stabilize."
Source:
http://www.pcworld.com/article/2
974489/ex-google-revs-up-a-newlinux-filesystem.html
Submitted by: Arnfried Walbrecht

THE N EW U BUNTU SUPPORTED VIDEO D RIVER
PPA I S WELL RECEIVED BY
COMMUNITY

O

ne of the issues with Ubuntu
is that it has some pretty outof-date repositories, and they
haven't done anything to fix this
until now, although they are
working on a new type of packages
(Snappy) that should end this
problem. Until then, Ubuntu users
need to rely on third-party
repositories to get all the latest
apps and drivers. There were

9

already a few repos that had the
latest drivers, but it's always good
when you find drivers that are at
least partially supported by the
distro.
Just setting up a PPA with
tested drivers was enough to make
the community respond. Many
users are now happy to see that
they find a reliable and always upto-date driver resource, but it's
also helpful for companies.
Source:
http://news.softpedia.com/news/t
he-new-ubuntu-supported-videodriver-ppa-is-well-received-bycommunity-489839.shtml
Submitted by: Arnfried Walbrecht

U BUNTU 1 6.04
STUPENDOUSLY H OT
CONCEPT I S ABOUT TO
B ECOME REAL

L

inux systems don't get a lot of
concept work. When designers
or developers want something,
they just do it. Linux operating
systems are very flexible, and you
can do pretty much what you want
with them. It's not like Windows or
contents ^
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Mac OS which doesn't really let
users mess with the themes. And
we're not even mentioning overall
desktop design. The bottom line is
that there aren't any Linux
concepts because ideas usually
turn into reality.

LINUX M ACHINES PRODUCE
EASY TO G UESS RANDOM
N UMBERS

I

n Linux and other UNIX-like
operating systems, these
random numbers are produced
from a set of sources. These
This is also the reason why the
sources can be the user's mouse
Ubuntu 1 6.04 Stupendously Hot
Charmander concept made such a movements, keyboard input, or
various hardware-generated
big impact. A lot of people like it,
activity like disk IO events, signal
but there were a few who didn't
really enjoy the flatness or the fact interrupts and network packet
that the regular Ubuntu stuff, like inter-arrival times.
icons, for example, weren't
This data is fed to the kernel,
included. In any case, the overall
feeling was that the concept has a which allows applications to pull
lot to promise and it looks like it's from it whenever they need it,
either via the /dev/random or the
coming to life.
/dev/urandom files.
Source:
The difference between these
http://news.softpedia.com/news/u
two files is that /dev/random
buntu-1 6-04-stupendously-hot"provides random data that is
charmander-concept-is-about-tonearly 1 00% entropy" but will also
become-real-489835.shtml
Submitted by: Arnfried Walbrecht "will block until the OS generates
more entropy," while
/dev/urandom "will hand out data
from its PRNG (Pseudo-Random
Numbers Generator) regardless of
the amount of entropy in the
entropy pool."
This means random numbers
with a lesser entropy value will be
full circle magazine #1 00

provided to various services
looking for random data, which
trying to avoid blockage situations
will use /dev/urandom instead of
the safer /dev/random file.
Source:
http://news.softpedia.com/news/li
nux-servers-produce-easy-toguess-randomized-numbers489830.shtml
Submitted by: Arnfried Walbrecht
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W a rt y W a rt h o g 4 . 1 0

Written by Alan Ward

his one-hundredth number of
our favorite magazine (yea!)
may be a good time to look back
and see what the Ubuntu
distribution was like in its original
form, and how it compares to the
modern versions. The best point to
start with is probably the original
version that went public, Ubuntu
Warty Warthog, a.k.a. 4.1 0, since it
was released in October 2004. Has
the distribution changed much?
What was included, and which
hardware could it run on? Could it
still run on a modern computer?
These are some of the questions
we would like to address in the
following pages.

This is a bit of a surprise, since
not many suppliers even of
commercial applications would
make an eleven-year-old piece of
software still available on their
servers. My hat's off to Canonical
for this one.
We are faced with a choice of
three different architectures: Intel
32-bit (i386), Intel/AMD 64-bit
(amd64), and PowerPC. If I
remember correctly, there were
not that many 64-bit computers in
common use as desktops - and
even less in laptops - back in 2004;
the 64-bit processors existed, but
were mostly found in Xeon servers

and high-end gaming rigs. As for
the PowerPC version, interestingly
enough some of the first tests
were done on Apple's G3
Macbooks, with commentators
saying the keyboard worked "out
of the box". Suffice it to say we get
a fair choice of hardware
architectures supported, actually
much the same that are supported
even today.
However, it should be noted
that most of these CDs are
installation CD, not Live CDs to
boot a working environment from.
The only choice for a Live CD is the
32-bit Intel architecture, and this

Live CD does not contain the
installation program. So back in
Warty's day, we needed to use
what is now called the "alternative
CD" to make a permanent install to
our hard drive. Perhaps space was
a limitation here; the i386 Live CD
is already very close to the 650
MByte size constraint on early CDROMs, so looking at the sizes of
the other images available, we can
conjecture that providing a Live CD
for other architectures would have
resulted in images above that size.
Anyway, I chose to download
the i386 images both for the Live
CD and for the installation disk.

G ET IT!
The first nice bit of news that I
came across when researching
Warty is that it is still available, and
directly from the original source.
Just head over to the "oldreleases" server at Ubuntu, and
you can pick up the CD images:
http://oldreleases.ubuntu.com/releases/4.1 0
full circle magazine #1 00
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RUNNING IN A VIRTUAL
MACHINE

The first step was to test the
images downloaded within a
virtual environment. In this case, I
used Virtualbox 4.3 under Linux
Mint 1 7.1 on my work machine. The
Live CD booted straight up at the
first try, with a boot-loader screen
that is - in my honest opinion rather more informative than
current offerings. Though I could
understand that perhaps the
excessive information may be a tad
off-putting for the casual user.

Soon, there I was staring at the
brown desktop from many days
back.
More on that later; for the time
being, let's just say that the Live
CD works in a virtual machine with
little changes from a modern
GNOME 2 desktop – except for the
(perhaps untidy) ramdisk icon.

In Warty, the installer was simply
the ncurses-based Debian installer,
with little adaptation to Ubuntu.
The program started by giving us a
choice of language, though
options are limited to the 40-or-so
choices given by Debian. Ubuntu's
later versions have an even more
comprehensive offering.

With this installer, the process
is spread over two phases. Disks
The second test was using the
installation disk to try to install the are partitioned in the first, and
system on the hard drive. This one general system configuration is
also booted up rather quickly, and done. The machine is then
the installation program took over. rebooted. Once running again,
user creation is performed during

full circle magazine #1 00
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the second phase – i.e. after
rebooting. This is one area where
more modern versions of Ubuntu
have accustomed us to a more
streamlined process – while
Debian has perhaps stagnated a
little, with fewer cosmetic changes
since 2004. Even though this textbased installer is a breeze to
navigate for experienced users,
perhaps some of the messages are
not clear for the novice, for
instance when setting up disk
partitions.
Speaking of disk partitioning,
the first time I booted from the
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installation disk, I was unable to
create any partitions. The installer
suggested doing manual
partitioning – which I chose - which
led me to automatic partitioning –
which abandoned and brought me
back to manual – etc.
That was when I remembered
that SATA connections between
the hard drives and motherboards
were not in widespread use back in
2004, since the technology had just
appeared in 2003. I checked the
settings on the virtual machine,
and - sure enough - I had left the
default configuration on and the
virtual hard drive was controlled
through SATA emulation.
Once this was changed and the
virtual hard drive was connected
through a more traditional IDE,
installation proceeded smoothly.
Once the machine had rebooted, I
created the primary user, and the
desktop came up as usual. The bit
to take back home is that Warty
simply does not support SATA
drives – which will have its
importance in the next section.
Meanwhile, I wanted to see if
the package repositories for Warty
were still online. As I had
suspected, there they were on the

Old-releases server. All versions
that have since been deprecated
are catered for, from Warty up to
Saucy (Saucy Salamander a.k.a.
1 3.1 0).
http://oldreleases.ubuntu.com/ubuntu
Although the "aptitude update"
and "aptitude upgrade" commands
worked flawlessly, there was no
software that needed upgrading. It
would seem Warty did not see any
updates – or, if they did, the
updates did not make it into the
archive copy of the repositories.
This contrasts a bit with current
versions, that often have updated
software packages available very
soon after release to the public.

RUNNING ON BARE METAL
Once I was satisfied Warty still
worked on a virtual machine, I
started looking for physical
hardware I could run it on. As
stated above, any computers with
the hard drive connected through a
SATA bus couldn't have Warty
installed permanently on them,
and those ever-so-common SATA
optical drives could not even boot
off the Live CD.
full circle magazine #1 00
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As I soon discovered, neither
could I boot off a USB stick. An
image created with the Unetbootin
utility program did manage to load
both kernel and initrd image, but
the kernel was then incapable of
mounting the CD-ROM filesystem
image on the USB stick. So options
were quite reduced; in essence, I
needed a computer with a hard
drive and a CD, both connected
using IDE. In the end, I resurrected
a Benq Joybook R31 E built in year
2005 off the junk pile. This is a
laptop that has been configured
with an Intel Centrino M processor,
640 MBytes of RAM, and a 60
GByte IDE hard drive. It may be
interesting to note it is also quite
capable of running Xubuntu 1 4.1 0
if needed.

version 1 .1
• a web browser, Firefox version
0.9.3

used: just 91 .7 MBytes. This is
certainly a welcome contrast with
modern desktop managers. You
will not need a Gigabyte of RAM
just to test Warty.

As for the installer CD, the
installation process also worked
correctly – until it was time to
install the GRUB boot loader. It
I still had some actual blank CDs then failed miserably, and the
left from way back when, and at
accompanying message was
least one computer with a CD/DVD unclear as to the cause:
burner. Once the CD images had
been burned to physical media,
I then re-tried installing, this
testing could commence.
time with a different disk
partitioning scheme. I avoided the
The Live CD started up
very first tracks, under the
correctly, the live system was
assumption that they may have
responsive, and programs worked gotten a hammering earlier on in
as they should. There is nothing
their lives. This seemed to help a
special to report on here, except
tad, as GRUB was - supposedly perhaps for the amount of RAM
installed with no error messages
full circle magazine #1 00

on screen. But the computer never
got to reboot, just going back into
BIOS time and again.
So there ended my efforts of
installing Warty on a physical
machine. It certainly seems more
finicky than more recent versions
of Ubuntu. As stated above,
Xubuntu 1 4.1 0 has had zero
problems with installing and
running on this particular piece of
equipment.

U SING THE DESKTOP

Gimp works well in both the
virtual environment and booting
off the Live CD. It is certainly
usable to work on images as long
as the physical hardware is up to
the task (memory may be a
concern). Although there have
been some changes in comparison
with today's version 2.8, they tend
to consist mostly of enhancements
and features getting added – and
of some changes in the placement
of tools within the user
environment that I am perhaps less
fond of. Perhaps the biggest gripe I
have against today's version of
GIMP 2.8 is that Warty's version 2.0
did not overly insist on using
GIMP's very own file format, but
was perfectly happy with JPEG or
PNG or whatever. A step
backwards, in my personal opinion.

OpenOffice: also usable. Both
OpenOffice and GIMP are rather
ENVIRONMENT
fast, even in a virtual environment.
The toolbars and so on are mostly
With Warty Warthog comes a
in the same places, and everything
standard complement of "major"
works in the way a modern user
software:
• an image editor, Gimp version 2.0 would expect. This just goes to say
• a productivity suite, OpenOffice that the teams at OpenOffice and
later LibreOffice have not gone on
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changing things just for the sake of
change. Instead, they have
concentrated on making the
internals of the software suite
even better, for example adding
Word docx file support and making
presentations more rich.

The fact that some certification
authorities in widespread use
nowadays did not even exist back
in 2004 does not help. For
example, FCM's page comes up,
but the inclusion of a live link to
Twitter causes grief. Back in 2004,
Symantec had not yet jumped on
the Class 3 web server certificate
(EV or Extended Validation
certificate) bandwagon, so the
corresponding Certification
Authority public certificate was,
naturally enough, not included in
the browsers' list of trusted
signing certificates.

With Firefox and web browsing
in general I have not that much
luck. No Flash is available, for
starters, and not even CSS
stylesheets are supported.
Google's products do work (mail,
Drive, Calendar...), in a
compatibility mode of sorts. No so
for Youtube.

full circle magazine #1 00
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IPv6 addresses were not yet
supported by programs accessing
the Internet such as wget or
Firefox, though the operating
system itself (kernel and utility
programs) was well up to it.

A solution that came to mind
was upgrading Firefox with a more
modern version. However, Warty
still depends on earlier versions of
the main GNU standard C++ library
(version 5), while Firefox depends
on the later version 6. It has been
available in GCC (GNU C Compiler)
version 3.4.0 since April 2004, but
was not used to build Warty. So no
luck with web browsing in the
modern world, which is perhaps
the most important defect that
precludes us from using Warty in
an actual work environment today.
As for additional hardware,
there is, naturally, much less
support in Warty for USBconnected peripherals such as
cameras and printers than in
recent releases. This is perhaps
understandable, since the
GNU/Linux operating system was,
at that time, much less used in a
desktop user-oriented
environment than it is now. The
increase in Linux's adoption has
made drivers for domestic and

small-work environment
peripherals much more ubiquitous
than before – and this is thanks,
among other factors, to Ubuntu
itself and its positive effect on
non-geeks' adoption of the system.

acceleration ever working with
these drivers.

The availability of a WiFi
connection is also much of a hitand-miss proposition. If you are
lucky enough to have a WiFi card
USB sticks are supported, more that is supported by Warty, then it
or less. That is to say, they are
may have an older chipset that will
detected IF formatted with a VFAT not connect to modern access
(Windows 32-bit) filesystem, and IF points that support only 802.1 1 g
the flash drive is formatted
or 802.1 1 n, and may also present
directly as a file system, without
difficulties with WPA encryption
using partitions. Support is more
that is practically mandatory in
flaky than today; not every
modern networking.
insertion is correctly detected and
mounted. Due to hardware
CONCLUSIONS
constraints, I have not been able to
run USB-3 with Warty. It should
This trip back in time made me
work in principle, though perhaps realize three things. The first is
only in USB-2 mode.
that - despite the incident with
Unity - there is actually quite a lot
As for screen drivers, Warty still of coherence between Ubuntu
relies on the very old X
versions all along the now elevenconfiguration files – that used to
year-long timeline of the
be edited manually. In Warty, some distribution. The main objectives X server detection is performed
such as ease of use for most users automatically, but users are at
have not really changed. A large
times requested to choose the
offering catering for the noncorrect screen resolution. No 1 6:9 English-speaking users has been
proportioned modes are offered.
there since day 1 , and has only
Modern machines will want to use been improved over time.
the Vesa screen server, which will
make a graphical screen possible
The second point is that some
but not in an optimal fashion. Do
things have changed on the
not depend on hardware
full circle magazine #1 00
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hardware side. And, although
GNU/Linux distributions such as
Ubuntu have at times lent a hand
towards hardware support, at the
end of the day both the
distributions and the user are
tributaries to one main project: the
Linux kernel itself. To this I would
add the various device drivers
available as source code, and the
utilities needed to use them, and
for specific hardware-related tasks
(such as ntfs-3g to use Windows'
NTFS filesystem). Without these,
the Ubuntu distribution could not
have advanced with the times as it
has until today.
Finally, I also came to realize
our dependency on the Internet.
This may seem a platitude, but
consider: a US $1 50 Chromebook
can be considered a viable option
to work with (via Google Drive or
Microsoft Office 365) or for
entertainment. But a $1 000+
computer without a viable Web
browser capable of handling
JavaScript, Flash and CSS will not.
We depend on access to Web
services to the point that having a
modern browser is something of a
game maker or breaker.
In retrospect, most of the ways
in which Warty could be a found
contents ^
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lacking for the modern world had
been addressed and solved, quite
quickly, by Canonical and the
GNU/Linux ecosystem as a whole.
To take an example, Karmic Koala
(9.1 0) had the USB stick problem
entirely solved. A Karmic desktop
can be installed directly from USB,
and once installed, can recognize
and work with USBs in different
formats. Speaking of formats, the
upgraded ext4 filesystem was

available in 2009. WiFi support had
been much improved in the five
years since Warty, and the C library
also went up to version 6.
This means that even though
Karmic still used the version 3
series of the Firefox browser, a
more modern browser can easily
be downloaded from the Mozilla
web page and used as a direct
replacement. Note the Firefox

version number and the live WiFi
signal indicator in the following
screen capture. Also note that
Youtube works through HTML 5,
without installing supplementary
Flash software.

driver if you are not too worried
about security or being on the
bleeding edge of technology.
Warty could not.

It shows us how much Ubuntu
had evolved by 2009, in aspects
that directly impact the user
experience. Karmic could
eventually still be used as a daily

Alan teaches computer science at

Escola Andorrana de Batxillerat
(high-school). He has previously
given GNU/Linux courses at the
University of Andorra and taught
GNU/Linux systems administration at
the Open University of Catalunya
(UOC).
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Canonical Ltd., the Ubucon Germany 201 5 team, and the UbuContest 201 5 team, are happy to announce the first UbuContest!

Contestants from all over the world will have until September 1 8, 201 5 to build and publish their apps and scopes using the Ubuntu SDK and Ubuntu
platform, starting today.
We are proud to present five dedicated categories:
• Best Team Entry: A team of up to three developers may register up to two apps/scopes they are developing. The jury will assign points in
categories including "Creativity", "Functionality", "Design", "Technical Level" and "Convergence". The top three entries with the most points win.
• Best Individual Entry: A lone developer may register up to two apps/scopes he or she is developing. The rest of the rules are identical to the "Best
Team Entry" category.
• Outstanding Technical Contribution: Members of the general public may nominate candidates who, in their opinion, have done something
"exceptional" with an Ubuntu-based device, Unity8, Mir, etc. on a technical level. Each jury member has one vote, and the nominated candidate with
the most jury votes wins.
• Outstanding Non-Technical Contribution: Members of the general public may nominate candidates who, in their opinion, have done something
exceptional, but non-technical, to bring the Ubuntu platform forward. So, for example, you can nominate a friend who has reported and commented
on all those phone-related bugs on Launchpad. Or nominate a member of your local community who did translations for Core Apps. Or nominate
someone who has contributed documentation, written awesome blog articles, etc. The rest of the rules are identical to the "Outstanding Technical
Contribution" category.
• Convergence Hero: The "Best Team Entry" or "Best Individual Entry" contribution with the highest number of "Convergence" points wins. The
winner in this category will probably surprise us in ways we have yet to imagine.
Our community jury panel members Laura Cowen, Carla Sella, Simos Xenitellis, Sujeevan Vijayakumaran and Michael Zanetti will select the winners in
each category. Successful winners will be awarded items from a huge pile of prizes, including travel subsidies for the first-placed winners to attend
Ubucon Germany 201 5 in Berlin, four Ubuntu Phones sponsored by bq and Meizu, t-shirts, and bundles of items from the official Ubuntu Shop.

We wish all the contestants good luck!
Go to ubucontest.eu for more information, including how to register and nominate folks. You can also follow us on Twitter @ubucontest, or contact
us via e-mail at contest@ubucon.de.
full circle magazine #1 00
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CO M M AN D & CO N Q U ER

A Lo o k B a c k

Written by Lucas Westermann

I was first introduced to Linux in
A small addition to last month’s
the form of Ubuntu Warty Warthog
article: Philippe (from the french
(4.1 0) in 2004 by a tech-savvy
translation team) was kind enough friend of mine, who was running it
to point out a website he likes,
on his laptop. After my interest in
called Top Coder
it, he set me up with an account,
(http://www.topcoder.com). There and from then on I was constantly
are previous challenges listed, and borrowing his laptop… From there
it seems to offer a variety of other I moved on to live CDs on my own
challenges with prizes. From what PC at home. It took me until 5.04
I’ve seen, they also seem to have a (Hoary Hedgehog) to finally take
convention once a year. For anyone the plunge, as the PC at home was
looking for something a little more running a wireless card that was
competitive, this might be for you! unsupported until then. What
And now back to your regularly
followed was a fairly frustrating
scheduled programming…
experience of semi-working
wireless. I went distro hunting for
the first time, and tried everything
ack in December of 2008 I
from Enlightenment to Fedora to
offered myself up as a stand- Debian. Eventually, I looped
in for Robert Clipsham (the original around to Ubuntu again. By now, it
author and creator of Command & was 2006 or 2007, and I started
Conquer), and produced my first
being active on the Ubuntu
article that appeared back in issue Forums, using what I had learned
FCM#21 . As you may have
to help out. Based on my account’s
guessed, this became a permanent profile, I had posted 1 500+ times
column for me. This month, I’d like between 2007 and 201 2. Since
to take a look back at what’s
then, I’ve switched to Arch Linux,
changed for Linux and for C&C in
and was active in that forum for a
particular, over the last 79 months time. For the last two or so years,
(about 6 and a half years!). But
I’ve focused mainly on C&C, though
first, a bit of backstory!
that may change in the near future.
full circle magazine #1 00
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Between issues 0 and 21 , I was an
avid reader of FCM, and learned
quite a few things there too. So
when I was given the chance to
help out in 2008, I accepted.

M Y TIME WITH FCM
As many of you may remember,
Command & Conquer was very
strongly focused on the commandline interface for the first 40 or so
articles I wrote. From there, I
moved on to configuration files,
GUI applications, and eventually to
programming aspects. This was for
two main reasons - first of all, that
Linux was enabling users to do
more and more using GUI
applications or settings, and
second of all, that a lot of the
articles I originally wrote, were still
viable today. This means that I had
to find new topics to write about,
and found new issues that needed
solutions. For a year or so, I was
also trying to transpose solutions
from Arch Linux to Ubuntu
systems, since that was my distro
of choice, and most issues present
in one, were present in another.
However, based off the difference
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in package managers, and desktop
environments, it was sometimes
challenging to get the solutions to
work in Ubuntu.
It was around this time that I
started to get more emails from
readers with suggestions,
comments, or requests for articles.
Often, they focused around
programming (typically Bash), or
issues with command-line tools. As
anyone who has reached out to me
may know, if the issue seems
widespread enough, or the
solution is worth noting, it will
typically appear in C&C a month or
two later.
As for how changes in Linux and
Ubuntu have impacted Command &
Conquer, it has done so in two
ways. First, the decreased reliance
upon the CLI for day-to-day tasks
has forced me to change the focus
of some articles (ushered in largely
during the transition to Unity), and
secondly by the expansion of the
Linux kernel. Some of the tips and
tricks I wrote about in the early
days for drivers, or graphical
issues, are much, much rarer. This
contents ^
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is due to new drivers being
developed, more being integrated
into the Ubuntu kernel, or simply
updates to the existing drivers or
software (such as the Xserver no
longer requiring an xorg.conf file).
That being said, other aspects have
stayed very much the same. My
articles on Vim, for example, work
just as well today as they did when
I wrote them (issues 54 & 55).
Going back even further, the
articles on Bash functions, aliases,
and history work the same way
(Issues 21 , 24, 25, 27, 35, 36, and a
few more!).
During my time with Linux, I’ve
seen many things about the kernel
and software improve, and
hardware support improve in leaps
and bounds. I recently installed
Ubuntu 1 5.04 on an old HP dv6000
laptop with a Broadcom wireless
chip that never seemed to work
properly with Ubuntu pre 1 2.04.
Between 1 2.04 and 1 4.04, there
were some conflicts between wl
and b43 drivers. This time around
though, all I needed was an
ethernet connection for about 1 5
minutes. After that, everything
was working fine. This was a
massive improvement over 4.1 0,
where my old USB wireless dongle
wasn’t even recognized. Not to

mention the existence of Ubuntu
Any responses can be emailed
Touch, new Ubuntu phones, and
to me at
Android. If this is how much Linux lswest34+fcm@gmail.com.
can change and improve over the
course of roughly 1 0 years through
our community, then I’m excited to
see what the next 1 0 bring!

H OW HAS FCM CHANGED?
Full Circle Magazine itself has
changed a fair bit since then too the design of the PDF, the usage of
Google Drive for articles, as well as
existing in certain online stores as
digital downloads! One of the
most recent changes is also one I
was heavily involved in - the
redesign and adjustment of the
website.

FEEDBACK & COMMENTS!
As always, I would love to hear
from my readers! How long have
you been reading my articles?
Which topics did you enjoy the
most? Any old articles you wish I
would update? Something
completely new? Any forecasts for
the future? Or even just
reminiscing about the old FCM
format.
full circle magazine #1 00

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.
The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org
contents ^

F

H OW-TO

Prog ra m i n P yth on Pt. 5 9

Written by Greg. D. Walters

irst, let me say Happy 1 00 to
Ronnie and the crew. It’s a
privilege to be part of this
milestone.
This time I thought that I’d
share some information on my new
obsession. I’ve started repairing
and building stringed musical
instruments like guitars and
violins. Believe it or not, there is a
lot of math involved in musical
instruments. Today, we will look at
some of the math involved with
the length of strings and where
the frets should be placed on the
fretboard.
Take a look at the picture of the
guitar. I annotated various items in
the image. The important things to
look at are the Nut near the top of
the fingerboard, the Frets, the
Bridge near the bottom, and the
white “line” within the bridge
called the Saddle. The purpose of
the frets is to create a perfect spot
to change the length of the string
Now, the physics of vibrating
to create a note that is in tune. The
strings
tells us that if you half the
positions of these frets are not
vibrating string length of a
arbitrary, but mathematically
theoretically perfect string, you
determined.
full circle magazine #1 00

will double the frequency of the
vibrations. In the case of a guitar,
this string length is between the
nut and the saddle. This distance is
referred to the Scale Length of the
guitar. The half-point that allows
for the doubled frequency is fret #
1 2. If correctly done, just by lightly
placing your finger on the string at
this location, you get a pleasing
tone. There are a few other
positions that this will happen, but
the 1 2th fret should be the perfect
location for this doubling, making
the note go up one octave.

So with the ability of a guitar
maker to come up with their own
scale length, the spacing of the
frets will have to be recalculated.
This is something that luthiers
(guitar makers) have been dealing
with for hundreds of years.

In the past, there was a
technique called the rule of 1 8
which involves successively
dividing the scale length minus the
offset to the previous fret by 1 8.
While this kind of worked, the
tones were off, the higher up the
fingerboard the player went. These
Different scale lengths will
days, we use a different constant.
create different feel and tones. For This constant is 1 7.81 7. By using
example, guitars like the Fender
this “new” constant, the 1 2th fret
Stratocasters® have a scale length or octave is at the exact position to
of 25½”, which produces a rich and be half the scale length of the
strong bell-like tone. On the other string.
hand, Gibson guitars often use a
scale length of 24¾”. This creates a
Now, these calculations are
lower string tension which makes
easy enough to do by paper and
an easier playing feel and a warmer pencil or even a simple calculator,
tone. Other guitar manufacturers
it’s just as easy to create a Python
decided that a scale length of 25” program to do the calculations for
makes a clearer tone than either of us in just a second. Once you have
the other two “standard” scale
the positions, you simply saw a slot
lengths.
for the fret at the correct positions
and then hammer in the frets.
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then take that value, divide it by
our constant (1 7.81 7), add back in
the cumulative distance and then
return that value to our calling
We want to create a program
routine. Remember, we could
that will prompt for the scale
simply have returned the
length of the guitar (or bass), do
the calculations and then print out calculated value without assigning
the distances. The calculations and it to a variable name. However, if
we ever want to inspect the
all returned lengths are all in
calculated values, it’s easier to do
inches, so all our friends that use
metric measurements, please add if we assign the value before we
the proper conversion calculations. return it.
After almost 5 years, you should be
Now we will make our worker
able to do this with ease.
routine. We’ve done this kind of
thing many times in the past. We
We don’t need to import any
libraries for this so we will start off will pass it the scale length and it
will loop for up to 24 frets
by defining a couple of variables.
(range(1 ,25)). Even if your project
has less than 24 frets, you will have
ScaleLength = 0
the correct positions of all the
CumulativeLength = 0
frets you do have. I chose 24
because that’s the maximum of
Next we will create a routine
frets for most guitars. When we
(top right) that will be called
get into the loop, we check the
repeatedly as we “travel down” the fret number (x) and if it is 1 , we
fingerboard. We will pass two
pass the cumulative length as 0,
values into this routine. One is the
scale length and the other is the
def DoWork(ScaleLength):
cumulative distance from the nut
CumulativeLength = 0
for x in range(1,25):
to the previous fret.
So, let’s take a look at the
program.

In this routine, we take the
scale length, subtract the
cumulative distance and assign
that value to BridgeToFret. We

def CalcSpacing(Length,NTF):
BridgeToFret = Length-NTF
NutToFret = (BridgeToFret/17.817) + NTF
return NutToFret

since this is the first calculation.
with the conversion in the DoWork
Otherwise, we pass the last
routine.
cumulative length in and it
ScaleLength =
becomes the result from the
raw_input(“Please enter Scale
calculation routine. Finally, we
Length of guitar -> “)
print each fret number followed by
DoWork(float(ScaleLength))
a formatted version of the
cumulative length.
You might wonder what good
this
program will do if you aren’t
Finally, we have the code that
going to build a guitar from
does the prompting for the scale
length. I’m sure you will remember scratch. It can be valuable when
you're looking at buying a used
the format for the raw_input
guitar or trying to tweak a guitar
routine, since we have used it so
many times before. Something you with a floating bridge. Also, if you
are a guitar player, this might have
might not remember: that
raw_input always returns a string, been something you didn’t know
about guitars.
so when we pass it off to the
DoWork routine, we have to pass it
Of course, the code is available
as a floating point number so the
from pastebin at
routine will work correctly. Of
course, we could simply pass it as a http://pastebin.com/A2RNECt5.
string, but we would have to deal

FretNumber = x
if FretNumber == 1:
CumulativeLength = CalcSpacing(ScaleLength,0)
else:
CumulativeLength = CalcSpacing(ScaleLength,CumulativeLength)
print(“Fret=%d,NutToFret=%.3f” % (FretNumber,CumulativeLength))
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Written by Elmer Perry

n November of 201 1 , Ronnie put
out a call for someone willing to
write a series of articles on
OpenOffice.org. OpenOffice.org
was, at the time, the default office
suite for Ubuntu. I had been using
Ubuntu for only about a year, but I
had used OpenOffice.org for years,
as far back as when it was
StarOffice. I put my name in the
hat and was assigned the job of
penning the series.

Li breO ffi ce Pt.5 2 - M y J ou rn ey (So Fa r)
around February 201 1 . I wrote the
first couple of articles, using the
OpenOffice.org name, but couldn't
help feeling I wasn't writing
anything for the future. I began a
conversation with Ronnie about
changing it from OpenOffice.org
to LibreOffice, using the Canonical
switch as my reasoning. Ronnie
agreed, and I edited the existing
articles to LibreOffice.

might say it works this way, but did
it actually work that way in the
current version? Sometimes, no.
Soon the Document Foundation
created their own documents for
LibreOffice, and while they are
never completely up-to-date, they
have stayed close enough that this
writer can read, test, and learn
about the different features of the
program.

help file is the best source for
learning the structure of
LibreOffice Basic. See the chapters
devoted to macros in each of the
guides for module specific help.

My second biggest challenge
was Base. As with macros, I had
little official documentation to
work with. To top off the difficulty,
relational databases are a complex
and complicated subject. I was
determined to meet it head on and
I may have used OpenOffice.org
The biggest challenge for me
then never write about it ever
for years, and StarOffice before
was macro scripts. At the time I
At the time, the future of
again. Over time, documentation
that,
but
I
soon
discovered
I
knew
was
writing
about
them,
there
was
OpenOffice.org was in question.
little official documentation on the came out, and I began to relax a
Sun Microsystems, the technology very little about the suite. I was
little. In addition to the articles I
familiar with the pieces of the
subject. I googled, read, and
company that had developed
followed links. I have studied many wrote for Full Circle, I wrote a
OpenOffice.org, had been bought suite, but my experience was
series of posts on my blog, What
limited
to
Writer
and
Calc.
I
programming languages in my
by Oracle Corporation in January
days, COBOL, Pascal, C, Visual
of 201 0. Development of the office decided to work my way through
Basic, Python, C++, Java, but the
suite had stopped. In September of the basics of each of the suite
modules starting with Writer.
lack of easy-to-read
201 0, a group of OpenOffice.org
Documentation
became
the
key
to
documentation for the interface to
developers defected from Oracle
my success. I started with the old
LibreOffice made learning to
and started the Document
OpenOffice.org documents, but as program macros challenging. The
Foundation. They forked
the Document Foundation started Document Foundation offers no
OpenOffice.org, and LibreOffice
making changes and improvements official manual for macros.
was born. The cherry on top,
to the programs, existing
However, each of the manuals for
Canonical planned to make
documents quickly became
the different modules includes a
LibreOffice their default office
outdated. Experimentation
chapter on creating macros. It is
suite in Ubuntu 1 1 .04.
became my second key. I learned to better than what I had when I was
test everything. The document
trying to write about macros. The
The first article was slated for
full circle magazine #1 00
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The Tech Am I Doing?, about using
the SQL language with LibreOffice
(https://eeperry.wordpress.com/ca
tegory/libreoffice/libreofficebase/). In the end, I hope I
presented you with enough
information to proceed on your
own.

memory lane, let's take a glance at
some of the new features and
changes that have come about
since LibreOffice was born.

quicker.

Speaking of readily handy, the
style selection drop-down on the
One of my favorite new tools is formatting toolbar has a new
the sidebar, which I wrote about in feature. Now, there is a drop-down
part 34 (Full Circle Magazine issue arrow on the currently highlighted
In the latest version (4.4), the
81 ). At the time, the sidebar was
style. If you click on the arrow, a
developers worked on
still an experimental feature, but it menu gives you the options to
restructuring the toolbars in all the didn't stay that way for long. I
update or edit the style.
suite modules. They removed some usually keep the sidebar open but Convenient when you need to
The thing that changed the way of the icons that users rarely click collapsed. If I need to change one
make a quick change to a style.
I do things was Impress. I use it at on and added icons that are used
of the styles, two clicks and I'm
work all the time, even though I
more frequently. They also
there. I like having the four most
have Powerpoint loaded on my
compacted the formatting toolbar used docked dialogs readily handy.
work computer. Impress doesn't
by condensing like functions into
make creating a presentation any
one drop-down icon. For example
easier than Powerpoint. The two
the line spacing is now a dropare about the same on that
down. As an added bonus, the
subject. Where Impress has
Insert Field is now a drop-down on
changed the way I do things is with the standard toolbar in Writer,
the Impress Remote (FCM#79).
which is easier than Insert > Fields
Impress Remote frees me from the > [field to insert]. Icons like the
presentation computer and allows bullets and numbering are now
me to roam and interact, with all
drop-down dialogs rather than pop
my controls and notes on my
up dialog windows, which makes
tablet.
using the basics of these tools
The joy of writing about a
program like LibreOffice is
watching the program blossom
before you. With each new version
they add something new to the
program. Sometimes, the changes
add a feature to the program;
other times, they makes an
existing feature work better. So,
before you think this is all about

The Start Center, LibreOffice
with no documents open, now
shows recently open documents by
default. Doesn't seem like much
full circle magazine #1 00
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until you work on the same
document every day for weeks at a
time, or need that budget
spreadsheet you opened just last
week. Click on the Templates
button and it switches to the
templates loaded on your system.
This makes starting a new
document based on a template
much easier.

Let me end by thanking Ronnie
Tucker for the chance to write for
Full Circle each month. He spends
hours laying out and compiling
each issue. He has repeated this
task 1 00 times, and I think that is
something to celebrate. Hopefully,
he can go another 1 00 before his
editorial egg cracks. Writing HowTo articles has polished my writing
and editing skills, as well as giving
The Document Foundation is
me an excuse to write something
doing a better job of keeping
at the end of each month. A big
manuals up-to-date. All the current thanks to the proofreaders who
guides and handbooks are up to
have saved me from embarrassing
version 4.0, with most at 4.2 or
myself more than once or caused
higher. They are my guide when
me to write a better article.
coming up with new articles for
Mostly, I thank you the reader.
you to read.
Without you, what's the point? You
are the reason there are 1 00 issues
My journey so far with
out there. I salute you.
LibreOffice and writing for Full
Circle Magazine has been a
rewarding one. I was asked to give NOTE: While I was editing this,
a presentation to a group about
LibreOffice 5.0 was released.
LibreOffice because of my articles Haven't had much of a chance to
in Full Circle. The guy introduced
look at it, but I'm sure they have
me as an international writer, and I added some more cool stuff. The
blush now just thinking about it. I
current Ubuntu version is still 4.4.
asked him why and he said,
“Because Full Circle is all over the
world.” I couldn't argue. So, thank
you, Full Circle fans, for making me
an international writer.
full circle magazine #1 00

EXTRA! EXTRA!
READ ALL ABOUT IT!
Our glorious news reporters
are now posting regular news
updates to the main Full Circle
site.
Click the NEWS link, in the site
menu at the top of the page,
and you'll see the news
headlines.

Elmer Perry's history of working,

and programming, computers
involves an Apple ][E, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com
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Alternatively, look on the right
side of any page on the site,
and you'll see the five latest
news posts.
Feel free to discuss the news
items. It's maybe something
that can spill back from the site
into the magazine. Enjoy!
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Written by John

he goal of this series, mainly
targeted to beginners, is to
guide you step-by-step in building
a website, with the entire Linux
infrastructure – from scratch.
Basically, deploy a Linux
distribution (Ubuntu) in the cloud,
secure the OS, install the Apache
web server and secure Apache.

Websi te Wi th I n fra stru ctu re From Scra tch
around security, OS setup and
Apache – in other words, I
gathered invaluable Linux
experience.
Enough talking – let's start!

Here, at a high level, is what we
will achieve:
• First, deploy a Linux VM (Virtual
You may wonder why should we Machine) in the cloud
go through all the trouble when it • Then, we'll secure this Linux VM
• We'll then install and secure
is very easy and possible to get a
Apache (web server)
cheap and full featured hosting
• Finally, I'll show how to register a
solution such as Wordpress?
domain and link this domain to the
Apache hosted on the Linux VM
I strongly believe there is no
“One size fits all solution” –
building from scratch will totally
D EPLOY LINUX IN THE
fulfill your needs, while a ready-toCLOUD
use solution probably won't. On
the other hand, a “ready-to-use
There are many available
solution”, especially open-source,
may provide right away (complex) solutions to deploy a VM in the
cloud. Just as an example, Amazon
functionality out of the box,
therefore saving on development Web Services is probably known
Worldwide.
time, and usually for free.

this provider because it is cheap,
(charged by the hour of usage,
equivalent of $5 / month for the
smallest configuration with limited
network usage), very easy to
deploy a Linux VM, and somehow
local (several data centers
available – I chose New York).
Let's spin a new VM, and we'll
choose Ubuntu 1 4.04:
• Go to
https://www.digitalocean.com and
log in.
• Choose “Create a new droplet”
(“droplet” is just a VM).

Key in a VM name and choose
the VM size. The smallest size runs
really well. Yes, it doesn't have a
lot of memory – but remember,
we'll be running Linux, so it's more
than enough to run a couple of
websites.
Then choose the Linux flavor –
we'll go for Ubuntu 1 4.04 64-bit and finally use the “Create
Droplet” button at the bottom of
the page.

In my document, I will use
But my main reason for building
Digital
Ocean. I am not trying to
from scratch is learning! When I
make any commercial argument for
built my wife's website from
Digital Ocean. I personally chose
scratch, I learned a lot – mainly
full circle magazine #1 00

26

contents ^

HOWTO - WEBSITE FROM SCRATCH

in as root this 1 st time. Open a

A few seconds later, the VM will
be created and root password with
IP address will be sent to you by
email. We'll need this to connect to
the VM. Note that I will not hide
the IP address – after all it's
temporary, and since I am
supposed to secure this VM, I
should not be worried about being
hacked.

IMPORTANT

Please note that we'll continue
setting up the server using only
the command-line.
• First, the bandwidth is limited
(only 1 Tb is included in our
monthly allowance) and graphical
interface uses a lot of that.
• Second, command-line is faster.

As convention, all commands
Digital Ocean charges by the hour starting with # should run as root
while all starting with $ will start
even if the VM is powered off.
as regular user.
Please go and read the Digital
Ocean billing documentation for
all the details.
B ASIC SECURITY

this rapidly.
Let me make a parallel with
Real Estate - when purchasing a
house, the motto is “location,
location, location”. Likewise, to
secure a Linux server with SSH, the
motto should be “no root access”,
“RSA key”, “no password”.

STEP 0 – CREATE A NEW
USER

The first time, login to your
brand new Linux VM as root and
create a new user called tux. Then
Now that the VM is up &
If you'd like to stop any charges, running, it is available via SSH from we'll assign the password linux to
take a snapshot (so the VM can be anywhere – no security is provided our user (obviously, choose a
better password).
restored later) and then destroy
by default except the root
the VM.
password – we need to address
Login to the VM – we must log
full circle magazine #1 00
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terminal:
ssh root@104.236.124.121

Then add the new user:
useradd -m -s /bin/bash tux
passwd tux

Follow the prompt and key in
linux
The -m flag for useradd is to
contents ^
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create the home folder, and -s
means we want bash as shell.

restart the ssh daemon:

Now we must ensure that we
can log in with the new user
created. Open a new terminal
session and let's try it out:

Now the user root cannot
connect anymore to iceberg.

ssh tux@104.236.124.121

and key in your password you
should now be connected. Please
make sure this step works before
moving forward.

1 - “NO ROOT ACCESS”

service ssh restart

Try it out – ssh
root@1 04.236.1 24.1 21 - error
message should be “Permission
Denied”.
Level 1 of security completed!

2 – RSA KEY

An RSA key is a pretty secure
Never allow root access to SSH way to login to an SSH server.
if for whatever reason an attacker Generating an RSA key will create
can get root access to your system, 2 components – a private key and a
you are doomed.
public key. In plain English, a
private key is a small file. A public
vi /etc/ssh/sshd_config
key is also a small file. In order to
access the system with the RSA
And add these 2 lines in the
keys (so we'll do what is called
beginning of the file:
“RSA authentication”), SSH will
ensure that both files go together
AllowUsers
tux
– if they do, you'll be able to log in.
DenyUsers

root

Let me make a parallel with a
I am using vi as text editor but
dollar bill – let's imagine we
you could use another editor (I
randomly tear the bill in 2 pieces.
hear nano is probably better suited Only these 2 pieces will go
for beginners).
together. Same for RSA keys.
In order to take effect, we must
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The public key will be stored on
the SSH server (iceberg in our
example), while tux will hold the
private key. When tux tries to
connect to iceberg, tux must show
the private key matching with the
public key. And we'll make the size
of the key so large that the
probability somebody can
reproduce the match is virtually
not possible.
In summary, without the right
private key, there will be no access
to the server.

IMPORTANT – we'll generate

the keys for tux and not root
(remember – no root access!!!).

Some explanation here – the
password is used to protect the
private key itself. In the unlikely
scenario somebody steals the
private key, that attacker could
then be able to connect to your
server. But if he doesn't know the
private key password, he will not
be able to use the key.
I know that a few of you will not
agree, but think about it – what is
really the chance somebody will
steal your key? Virtually none,
right? This is my point – it may
therefore not need a password for
our purposes.

But let's make it the way we
should – let choose a password:
Generate the pair public/private 1 2345 (again – if you plan to go it
key. We'll hit it hard and ask for a
right - do not use a weak password,
1 0Kb key (I believe default is 4Kb). this is just a tutorial).
This process can take some time –
up to 1 min at most (large key).
We should now have 2 files in
the folder /home/tux/.ssh
ssh-keygen -t rsa -b 10240
• id_rsa_iceberg is the private key
• id_rsa_iceberg.pub is the public
You can accept the default
key
selection or change the name.
Let's change the name on purpose
Now make a copy of the public
to id_rsa_iceberg (but keep the
key as follows – the name is
same folder).
important since ssh will be looking
specifically for authorized_keys
You can choose a password or
(you can change this default
leave it blank.
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feature by tweaking
/etc/ssh/sshd_config):

cp id_rsa_iceberg.pub
authorized_keys

SPECIAL PRIVATE KEY
PASSWORD SECURITY

Now, before we continue, let's
talk a little bit about the private
key password security.
As a general rule, modern
encryption systems are pretty
robust. However corners are
sometimes cut and the entire
system will be easier to defeat.

strength of a well thought system.
Same with SSH - private keys
can be encrypted with a password
(remember – 1 2345 in our
example), however the encryption
used is not as strong as you may
think. Thanks to Open Source,
somebody noticed this weakness
and it is easily possible to seriously
beef up the private key encryption.
If you have any interest in doing
this – just for fun actually - I
recommend reading this excellent
blog:
http://martin.kleppmann.com/201
3/05/24/improving-security-of-sshprivate-keys.html

To summarize:
• make a copy of the private key.
If you are familiar with the
Enigma encryption system used by • create 2 files - file1 .txt with the
Germans during World War 2 – that original password and file2.txt
with a new password. Both files
was a really robust encryption
can have the same password
system. For whatever (good?)
reason, the creators decided that a (1 2345 for us) but you must have
both files created.
character could not be encrypted
as itself. Well, this feature inserted • change the encryption.
a weakness because it reduced the
As tux (su – tux if you are root):
number of combinations the
cypher could produce. It's
obviously not the only reason why cd /home/tux/.ssh
the code was broken – my point is mv id_rsa_iceberg
that a small decision (by sloppiness id_rsa_iceberg.bak
or not) lowered the encryption
cat >> file1.txt
full circle magazine #1 00

Back to your desktop:

Key in 1 2345 and hit control+d
cat >> file2.txt

Key in 1 2345 and hit control+d
openssl pkcs8 -topk8 -v2 des3
-in
/home/tux/.ssh/id_rsa_iceberg
.bak -out
/home/tux/.ssh/id_rsa_iceberg
-passin file:file1.txt
-passout file:file2.txt

[NOTE: the above is all one line]
Now the private key will be
protected with the password
included in file2.txt, and properly
encrypted!
In order to connect to iceberg,
we need to copy the private key
id_rsa_iceberg to our computer.
There are a few ways of doing this
(scp for example – or secure copy),
however what about a simple copy
/ paste?
Let's do this:
cat id_rsa_iceberg

cd

(this will go back to your home
folder).
cd .ssh
vi id_rsa_iceberg

Now paste, save and close.
• Change the file persmission:
chmod 400 id_rsa_iceberg

(this is read-only and expected by
ssh).
We should now try to connect
to iceberg using our ssh key.
From your desktop:
ssh -i ~/.ssh/id_rsa_iceberg
tux@104.236.124.121

You should be prompted for the
password of the private key (that is
1 2345) and then should be
connected to iceberg!

• select everything starting with ---Final security setup – we'll now
-BEGIN RSA PRIVATE KEY----- up to forbid any password connection to
-----END RSA PRIVATE KEY----- and
iceberg.
copy into the clipboard.

29

contents ^

HOWTO - WEBSITE FROM SCRATCH
Back to the file
/etc/ssh/sshd_config and make
some changes:
vi /etc/ssh/sshd_config

• Change PermitRootLogin yes to
PermitRootLogin no
• Change
#PasswordAuthentication yes to
PasswordAuthentication no
• Change LoginGraceTime from
1 20 to 20 (this will allow 20s to
login – it's more than enough).
Save & exit and restart the ssh
service (service ssh restart).

Try ssh tux@1 04.236.1 24.1 21

You should get Permission
denied (publickey). It means that
password authentication is not
allowed.
Now we are fully secure!
To summarize:
• root cannot connect.
• only RSA keys are allowed for
authentication.
Next time we will secure the
server using firewall rules (the
server is wide open, however safe
enough for right now).

$1 0 CREDIT FOR D IGITAL O CEAN
Brian (he of the EPUBs) notes: It is worth noting that a $1 0 credit

for Digital Ocean is available through several sites, including Linux
Luddiites (http://linuxluddites.com/) and Techsnap
(http://www.jupiterbroadcasting.com/86667/export-gradevulnerabilities-techsnap-228/) for example, that lets you have up to
two months free on Digital Ocean.

DISCLAIMER: We have absolutely no affiliation with any of the
above mentioned sites, or offers.
We will then install apache (web
server) and secure apache.

LAST IMPORTANT NOTE
If you are using Digital Ocean,
just shutting down the VM will not
stop the billing cycle! Take a
snapshot of the VM, and when this
is completed, destroy the VM.
With the snapshot, the VM can
be re-created to the same state as
when the snapshot was taken.
If you are using any other Cloud
provider, make sure to check their
documentation so you do not pay
while the VM is not up & running.
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John has been a Linux user since

around 1 995 and is a great advocate
of Open Source Software, He geeks
around with a few Linux machines
(Ubuntu & Centos for servers, Mint
and Opensuse for desktops) in the
Boston suburbs where he lives.
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Prog ra m m i n g I n CO BO L

Written by Alan Ward

buntu users are a modern
people. We use tablets and
smartphones that didn't exist ten
years back. We wait impatiently for
each succeeding version of Ubuntu
to be more revolutionary than the
last version, a mere six months
back. Is this not progress? Is this
not what the fast-paced twentyfirst century is all about?

do very nicely, thank you) than a
computer and compiler
combination of the same vintage.

Just before year 2000 and the
infamous "y2k bug" that was
supposed to bite us all in the nose
(but never quite did – because we
were prepared for it!) it came to
the attention of many IT
department heads that a sizable
portion of computer programs in
Writing about a programming
use had been originally written in
language such as COBOL may
come out as a bit odd. After all, the COBOL. This was true mainly in the
finance industry. Having been
Common Business-Oriented
passed from one generation of
Language was born in the year
1 959, sometime during those Dark hardware to another, and
recompiled several times in the
Ages when programming did not
process, the programs handled
mean running a JavaScript in a
Web browser, and computing was most core processes and were well
placed to last longer than the
not all about connecting your
human programmers that had
touch-screen phone to the latest
created them in the first place –
high-speed mobile network. In
and who were at that time heading
those days, even seeing a
towards retirement, if not already
computer blink its lights at you
there. A scarcity of programmers
must have been quite an
of the younger generations able to
experience. To measure the
distance covered by informatics in comprehend, let alone maintain,
the intervening 56 years, let us just code written in COBOL, seemed to
be on the cards. Fifteen years on,
say I would much prefer to drive
this still seems to be a bit of a
every day an automobile built in
1 959 (a Land Rover Series II would concern even in year 201 5, at least
full circle magazine #1 00

according to some. However, a
large part of the programs must
have needed to be re-written at
some point if only to adapt to the
needs of e-banking and e-business,
and writing newer programs from
scratch in COBOL is less often seen
these days.
However, the COBOL language
still seems to have been
maintained, with even an objectoriented version being announced
in 2002, and a more advanced
standard published in 201 4. IBM
seems to be a major player in the
field, although it also gives active
support to other offerings (such as
Java) for programming
mainframes. On the GNU/Linux
side, OpenCOBOL
(http://www.opencobol.org/)
appeared to give us the possibility
of compiling working programs on
the most recent Ubuntu systems,
which has then been re-branded
(superseded) by GNU Cobol since
version 1 .1 .
It was mainly from a standpoint
of historical interest that I installed
this compiler, and managed to get

31

an Euclidian Algorithm program up
and running quite easily, with
procedure calls and even some
invocation of routines written in
the C language by the side.

I NSTALLATION
Installation is the usual
procedure on *buntu systems,
since OpenCOBOL is available
directly from the repositories.
Simply use your favorite software
package manager to install
package open-cobol:
aptitude install open-cobol

When this is installed, we can
directly fire up the COBOL
compiler in a terminal and
investigate which version we are
using:
cobc --version
cobc (OpenCOBOL) 1.1.0
Copyright (C) 2001-2009
Keisuke Nishida / Roger While
Built
Nov 02 2013 00:16:01
Packaged Feb 06 2009 10:30:55
CET
contents ^
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As can be seen from the dates
quoted, development of this
compiler is not going along at the
supersonic speeds seen in some
open-source projects. However,
this suits quite well the COBOL
mindset that goes more for
"steady does it" and "piano, piano
si va lontano" than seeking out
instant results.

IDENTIFICATION DIVISION.
PROGRAM-ID. HELLO-WORLD.
PROCEDURE DIVISION.

and does just that quite well.
Once saved, let us compile our
first program. We will need to use
option "-x" to request the compiler
to perform linkage as well as
compilation proper, and produce
an executable file:

FREE-FORM AND
PROCEDURES

The programing world has gone
forward a tad since the original
specification for COBOL was
STOP RUN.
published. Among other things,
writing programs in ALL CAPITAL
Note that this syntax - originally
LETTERS is no longer considered
thought out for punched cards - is cobc hello.cob -x
the only true way of getting things
all about spacing. The first six
Here we have our source code, done, and modern script-kiddies
characters on each line (columns 1
The compiler documentation
to 6) are reserved to identify each and the executable program, which would have difficulties abiding
gives us some insight into which
with the very strict column syntax
can then be executed:
COBOL dialects are supported. The program line with a number –
of earlier versions. This is why later
though nowadays numbers are no ls
ground-breaking 2002 version is
COBOL dialects have progressively
longer mandatory. Column 7 is an
there, though the 201 4 update is
reduced the constraints on formal
indicator area that can be used to hello hello.cob
not (yet) there:
program presentation, giving us
mark a line as a commentary by
./hello
free-form syntax. Some of the
inserting an asterisk "*" character
-std=<dialect>
Compile for
parts, such as the identification
a specific dialect :
Hello, world
in this space. Finally, only a
division, no longer need to be
maximum of 72 characters may be
It is noteworthy that, since I was specified. The same HelloWorld
used in each line, thus leaving just
cobol2002
Cobol 2002
program may be written in free
cobol85
Cobol 85
doing this on a 64-bit version of
72 - 7 = 65 characters to write
ibm
IBM Compatible
form in the following manner:
Linux Mint, what the compiler
actual code in.
mvs
MVS Compatible
produced is in fact a 64-bit
bs2000
BS2000 Compatible
mf
Micro Focus
executable file! I wonder what the program-id. HelloWorld.
Fire
up
your
favorite
text
Compatible
procedure division.
editing program, and type or paste original creators of the language
default
When not
would have thought of that:
specified
in this text. Save the file as
display "Hello, world".
"hello.cob" or "hello.cbl" – COBOL
stop run.
source code file extensions vary a ldd hello
COMPILING "H ELLO,
bit. Unfortunately, there are not
[...]
end program HelloWorld.
WORLD !"
many text editors in Ubuntu that
/lib64/ld-linux-x86can handle COBOL syntax
From the compiler's point of
64.so.2
(0x00007f277d149000)
A very basic program in
highlighting. However, the jedit
view, all we need to do is specify
traditional, old-style, fixed-format, program is available, easily
that we are going to use free-form,
COBOL runs like this:
installable from the repositories,
full circle magazine #1 00
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and the very same executable file
may be produced:
cobc hello.cob -x -free

Let us now complicate things.
We are now going to split the
program up into two parts: a main
procedure that will be invoked on
program execution, and a subprogram (procedure) that actually
does the dirty work when required
by the main procedure. To go a
step further, we will declare a
variable and initialize it with the
text to be displayed. The main
program goes as follows:
program-id. HelloWorld.

appeared before the procedure
division. This contains a workingstorage section, which is where
local variables are declared using
the PIC syntax. Variables may be
immediately initialized using the
value keyword.
Now, for the procedure
TestSub. This must be written in a
new program-id section, that may
be inserted within the same file as
the main program. For example:
program-id. TestSub.
data division.
linkage section.
01 Grt PIC X(15).

data division.
working-storage
section.

procedure division using Grt.

01 Greeting PIC X(15)
value "Hello, world!".

display "This is
TestSub".
display "Grt = " Grt.

procedure division.
call "TestSub" using
Greeting.

exit program.

end program TestSub.

stop run.
end program HelloWorld.

A new data division has

In this case, procedure TestSub
will be invoked by the main
program using one parameter, the
text to be displayed. We have also
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inserted a data division within the
sub-program, declaring this
parameter within the linkage
section.
For clarity, the parameter name
is "Grt" within the sub-program,
and "Greeting" in the main. Just a
word of warning: parameters are
called by reference, so if changes
were eventually to be made to
"Grt" within the sub-program,
these changes would then be
maintained in Greeting when
returning to the main procedure.
Programmers should exercise
caution, especially if accustomed
to C's way of passing parameters
(call by value). However, it should
also be said that this feature
facilitates returning values from a
sub-program to the routine that
invokes it.

LET' S CALCULATE A GCD
To illustrate parameter passing
when using a procedure, let us use
Euclid's Algorithm to compute the
Greatest Common Divisor of two
integer numbers. The main
program will use three variables: A
and B to store the two integers,
and G for the result. The main
program in itself is rather
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straightforward, the only
noteworthy bit being the way in
which parameter G is used to
retrieve the result from the
procedure back to the main
program:
program-id. GCD.
data division.
working-storage
section.
245.
135.

01 A PIC 9(15) value
01 B PIC 9(15) value
01 G PIC 9(15).

procedure division.
call
"EuclidianAlgorithm" using A,
B, G.
display "GCD of " A "
and " B " is " G.
stop run.
end program GCD.

Inside the EuclidianAlgorithm
procedure, we will begin by making
a copy of the two numbers A and
B, into local storage. In this way we
make sure no changes are made to
their original values back in the
contents ^
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main program. We will need both a
linkage and a working-storage
section in the data division, to
keep track of incoming parameters
and store local variables
respectively. Finally, the COBOL
way of constructing a "repeat
until" structure may seem a bit
weird to programmers using other
languages, but it does work.
program-id.
EuclidianAlgorithm.
data division.
working-storage

section.

01 A PIC 9(15).
01 B PIC 9(15).
01 Q PIC 9(15).
01 R PIC 9(15).
linkage section.
01 IN_A PIC 9(15).
01 IN_B PIC 9(15).
01 IN_G PIC 9(15).

procedure division using
IN_A, IN_B, IN_G.
Main.
move IN_A to A.
move IN_B to B.

perform Loop with
test after until R = 0.
move A to IN_G.

Loop.
divide A by B giving
Q remainder R.
move B to A.
move R to B.
end program
EuclidianAlgorithm.

Once the file is compiled, we
can execute the binary program:
cobc gcd.cob -x -free
./gcd
GCD of 000000000000245 and
000000000000135 is
000000000000005

CALLING C CODE FROM
COBOL
When generating the result
above, I was not entirely satisfied
with the presentation on screen.
All those leading zeros seem rather
gauche, to say the least. I would
have much preferred a C-style
printf function to format output,
which unfortunately does not
full circle magazine #1 00

seem to be readily available in
COBOL.

characters, a simple for loop is
used to traverse the array,
combined with the flag
In the interest of tinkering a bit, leading_zeros to indicate if we are
instead of writing an equivalent
still passing through leading zeros
procedure in pure COBOL, let us
(TRUE) or have come into the main
do so in C and invoke it from the
body of the number (FALSE).
COBOL main program. The C
wrapper was built around two
• Print is defined as an external
functions:
function, and so is accessible from
outside the C object file. It simply
• prettyNumber takes one of the takes the three parameters A, B
numbers sent from the COBOL
and G from the COBOL side, and
side of things, parses and prints it writes them out using
on-screen. As the numbers are
prettyNumber.
each formatted as an array of 1 5
#define TRUE (1 == 1)
#define FALSE !TRUE
void prettyNumber (char *p) {
int i, leading_zeros = TRUE;
for (i = 0; i < 15; i++)
if ((p[i] != '0') || !leading_zeros) {
leading_zeros = FALSE;
printf ("%c", p[i]);
}
if (leading_zeros)
printf("0");
}
extern int Print (char *a, char *b, char *g) {
printf ("GCD of ");
prettyNumber(a);
printf (" and ");
prettyNumber(b);
printf (" is ");
prettyNumber(g);
printf("\n");
return(0);
}
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Inside the existing COBOL code,
just one line needs to be changed
in the main program. We replace
display "GCD of " A " and " B
" is " G.

with
call "Print" using A, B, G.

No further modifications need
to be made to the code. However,
compilation will be a tad more
tricky, since we need to compile
the C library first, and then give it
to the COBOL compiler to link with
the COBOL code and produce an
executable file. So:
cc print.c -o print.o -c
cobc gcd-c.cob print.o -x
-free

The "-c" flag tells the C compiler
to halt once the object code is
produced, before linking. The
object file may then simply be
added to the COBOL compiler's
input file list. Execution is then
performed in the usual way,
producing much nicer visual
results:
./gcd-c
GCD of 245 and 135 is 5

CONCLUSIONS
As stated at the beginning, the
aims of this short piece were
mostly to go back in time and see
how the efforts of a dedicated
group of programmers have made
a rather ancient (in computer
terms) programming language
come back to life on a modern
GNU/Linux distribution. Neither
the hardware (laptop versus 1 950's
mainframe) nor the operating
system (UNIX-like versus
proprietary OS) have much to do
with what the original COBOL
designers were contending with –
but this stuff works, and can give
us a taste of how things were in
the "good old days" of
computation.
Although the language itself
has seen some evolution since
conception, general syntax and
conception are visible to those of
another age. This is not to say that
modern trends such as objectoriented design or web service
implementation could not be
handled through COBOL. On the
contrary, if sufficient interest were
to be found to implement the
necessary intermediate libraries, I
see no reason why COBOL - and,
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specifically, Open/GNU COBOL could not hold its own with more
modern offerings. However, the
necessary code would necessarily
be seen as an additional layer on
top on what is in essence a
language from the 1 950's – and so,
such attachments may at times
seem rather alien to the language's
original philosophy.
On the other hand, handling
communication with databases has
always been one of the strengths
of the COBOL environment; it was
mostly built into the concept
starting from day one. So, if or
when the interested parties can
finish linking up COBOL with
existing database systems such as
PostgreSQL or MariaBD (some
work has already been done with
Oracle) - or, even better, a generic
SQL extension mechanism - this
project could very well find its
place in the modern world, at least
where database back-end
programming is concerned.
Alan teaches computer science at

Escola Andorrana de Batxillerat
(high-school). He has previously
given GNU/Linux courses at the
University of Andorra and taught
GNU/Linux systems administration at
the Open University of Catalunya
(UOC).
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I n k s ca p e - P a r t 4 0

Written by Mark Crutch

o celebrate the incredible
achievement of 1 00 editions of
Full Circle Magazine, I'm going to
take a break from the usual
tutorial format, and instead list
1 00 useful tips for working with
Inkscape. Some of these have
previously been mentioned in this
series, others have yet to be
covered – whilst there are a few
that would probably never have
seen the light of day if it wasn't for
this celebratory change of style.

install from the Inkscape
Developer's PPA:
https://launchpad.net/~inkscape.d
ev/+archive/ubuntu/stable
3. If you need to use Inkscape on
a Mac, make sure you check out
the official FAQ first as the need
for XQuartz on OSX throws up a
few issues.

4. If you usually use a laptop you
might be tempted to try using the
trackpad with Inkscape. Whilst you
might get away with it for small
I NSTALLING I NKSCAPE
creations or edits, for any serious
with Inkscape you really need
1 . The easiest way to getInkscape work
a mouse with at least two buttons
onto a Linux machine is simply to
and a clickable scroll wheel.
install it from your distro's
repositories. This may still get you 5. Equally you might think that a
version 0.48.x, but for most
graphics tablet would be a good
people, that's probably good
purchase, but you really should try
enough to work with until your
before you buy. Whilst a tablet can
next major distribution upgrade.
be a real boon for some graphics
such as GIMP, Krita or
2. The version after 0.48.x is 0.91 programs,
MyPaint,
the
vector nature of
– there was a jump in version
makes a tablet far less
number to give a better indication Inkscape
useful than you might expect. For
of how well developed the
calligraphic styles it may
program is. If you want to get 0.91 some
work
well,
but if you just want to
onto an older Debian or Ubuntu
draw something freehand it's
based distro, your best bet is to
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probably easier to use a pencil and
paper, then scan your work and
trace over it manually.
6. Another one for laptop users:
Inkscape's easier to use with a fullsized keyboard. Some of the
keyboard shortcuts use the
numeric keypad, making them
rather inconvenient on a cut-down
keyboard.
7. That said, version 0.91 does
allow you to configure the
keyboard shortcuts much more
easily than earlier releases, so,
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with a bit of work, you might be
able to get away with a smaller
keyboard. Head to Edit >
Preferences > Interface >
Keyboard Shortcuts, then click on
the shortcut you want to change
and press the new key combination
you want to use.

THE B ASICS
8. Keep an eye on the status bar!
This is perhaps the most important
tip for using Inkscape, as it not
only tells you what you've
currently got selected, but also
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offers details about the various
keyboard modifiers you can use
with each tool.

the results in.

1 2 Can't see an object when you
draw it? Start by checking the
9. Use the context menus on the following:
status bar widgets for fast access
• That your fill and/or stroke both
to some commonly used options
have a color, and aren't
and defaults.
transparent.
• That your stroke has some
1 0. The spinboxes on the tool
thickness to it.
control bar also have useful
• That your layer is opaque.
context menus. Unfortunately the
View with filters off (see the
spinboxes inside dialogs tend to be “Filters” section), in case you've
less useful.
blurred it away to nothingness.
• Is it a circle or arc? Make sure
1 1 . In 0.91 you can do simple
the arc handles are far enough
arithmetic inside spinboxes, saving apart.
you from having to perform the
• Check the object dimensions –
calculations elsewhere and copy
perhaps it's just very, very small.
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This can happen if you accidentally
release the mouse button whilst
dragging.
• Did you draw it inside an already
clipped group?

almost everything still applies to
the more recent versions.

1 6. If you're using Linux and
finding that the whole window
moves when you try to ALT-drag an
1 3. If you've lost your object
object, try holding the Windows
entirely, use View > Display Mode > key down as well.
Outline to see everything, even
transparent objects, as simple
1 7. Don't work at full-screen size.
outlines.
Reduce the size of the window to
speed up redraws, especially when
1 4. Use the area outside the page using filters. Undock dialogs to
boundary. Objects placed here
make this more practical.
won't appear on screen if your SVG
is loaded into a web browser, and
1 8 Selecting an object also
it's easy to omit them when
switches the active layer – use this
exporting to a PNG, so this is a
as a quick way to draw something
good place to keep temporary
on the same layer as an existing
notes, copies of objects that you
object.
might need again, or just to use as
a scratch-pad. I find it to be a great 1 9. Use the CTRL key to “control”
place to hide the Easter Eggs in my your movements:
comics!
• When drawing, to keep to
integer ratios. This is the easiest
way to draw circles and squares.
KEYBOARD SHORTCUTS
• When moving objects or nodes,
to only move horizontally or
1 5. The keyboard shortcut
preferences of 0.91 offer a useful vertically.
way to view the existing shortcuts. • When rotating or skewing, to
only move by fixed amounts, as set
For a more comprehensive
overview, or for 0.48 users, use the in the preferences.
• When scaling, to scale
reference document here:
https://inkscape.org/en/doc/keys.h proportionally.
• CTRL + drag up/down using the
tml – it's from version 0.46, but
star/polygon tool to get properly
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aligned shapes.
• Use CTRL+Mouse Wheel to
quickly zoom in and out, regardless
of which tool is currently selected.

around, press the spacebar to
stamp a copy of it. Unfortunately
0.91 's pan setting also interferes
with this. Again, make sure the
mouse is stationary first.

bring up a dialog that lets you
make fine adjustments.
30. Delete guides using this
dialog, or by simply moving the
mouse over the guide until it
changes color, then pressing the
delete key. There's also an Edit >
Delete all Guides menu on 0.91 .

to match an odd angle in your
design.

34. Edit > Guides Around Page
does the same for the page
20. If you really want fine control
outline, putting the guide origins
of the zoom level, use the input
25. Use the cursor keys to move
at the four corners. This is handy if
field at the far right of the status
selected objects around. Hold ALT
you want to create a background
bar.
to move by smaller amounts. Most
rectangle that exactly matches the
usefully, hold SHIFT to move in
page size: just enable snapping to
21 . Press and hold Q to quickly
steps that are independent of your 31 0 With 0.91 you can change the guides and off you go.
color of a guide, and even give it a
zoom any selected objects to fill
zoom level. This means you can
label.
the window. With the object
move an object “out of the way”,
G RIDS & SNAPPING
zoomed, focus a different window then zoom in to tweak it, before
or dialog and release the Q key to moving it back by the same
35. You can create multiple grids
“fix” the zoom at that level. Once
amount, knowing it will end up in
via File > Document Properties >
back in the main window, make the its original position.
Grids. They can be either
edits you need to, then just tap the
rectangular or axonometric
Q key to zoom back out again.
26. Use the “<” and “>” keys to
(angled, allowing for isometric and
scale objects, or “[“ and “]” to
oblique grids). If you need polar or
22. Use a middle-click (on the
rotate them. Hold ALT to scale or
logarithmic grids, however, you'll
mouse wheel) to pan. Combined
rotate by a smaller amount.
have to fake it using the options in
with the zooming tips above, this
the Extensions menu.
will help you navigate around your G UIDES
canvas in record time!
36. You can show or hide the
27. Create guides by dragging
currently active grid(s) by pressing
23. Press the spacebar to quickly from the rulers. Drag from the
the “#” key. When the grid is
32
You
can
quickly
show
and
hide
toggle modes from your current
ends of the rulers, for a guide
hidden it isn't used for snapping.
all guides using the “|” key.
tool to the selection tool and back. angled at 45°.
Be careful on 0.91 , though, where
37. If you do want to turn off
33.
You
can
also
create
guides
the default “spacebar activates
28. Move a guide by dragging it
snapping entirely, you can toggle it
from
objects
by
selecting
the
pan” setting interferes with this
with the mouse. Rotate it by
with the “%” key.
object then using the Object >
unless your mouse is absolutely
holding SHIFT while dragging.
Objects to Guides menu entry. This 38. Don't enable too many
stationary.
doesn't delete the original object
29. Double-click on a guide to
snapping options at once: it makes
and is especially useful if you need
24. Whilst dragging an object
full circle magazine #1 00
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it tricky to draw as the image
becomes more complex and full of
potential snap points.
39. Use File > Document
Properties > Snap to adjust how
fiercely snapping is applied. With
0.91 there are also a few extra
checkboxes to allow for snapping
to clipping and masking paths,
without you having to release
them first.

PATHS

construct complex shapes out of
simpler ones.

47. You can rotate node
selections using the “[“ and “]”
keys. Hover over a node – even one
that's not selected – to use it as
the center of rotation. If you want
to rotate about the center of the
selected nodes, make sure your
mouse pointer is not hovering over
any other node.

43. Can't bend a path? One or
both of the handles missing?
Holding SHIFT will let you drag the
handle out of the node. If you still
can't bend it, check that you don't
have the Spiro live path effect
present (Path > Path Effect Editor),
as this significantly affects the way 48. The “<” and “>” keys also work
that paths can be manipulated.
on node selections.
44. You can select multiple nodes
by dragging a selection rectangle
over them, by SHIFT-clicking on
individual nodes – or a combination
of both. You can also select nodes
from more than one path at a time,
which can sometimes be
invaluable.

the size of a path without affecting
its angles.
51 . With multiple nodes selected,
hold ALT when dragging one of
them and the others will move by a
proportional amount, based on
their proximity to the node you're
moving. This can best be seen by
putting lots of nodes on a path,
selecting all of them, then ALTdragging a node near the center.

49. For a different take on
40. Get familiar with paths.
rotating and scaling node
They're the basic unit of
selections, enable the “Show
construction in Inkscape – just
transformation handles for
about any other object can be
selected nodes” button on the tool
converted to a path via the Path >
control bar. This will give you
Object to Path or Path > Stroke to
handles like those of the selection
Path menu options. Remember
tool, but applying to the selected
that this is a one-way conversion,
nodes rather than whole objects.
45.
Click
a
path
segment
to
select
so keep a copy if you'll need to edit
Just like the selection handles,
the
nodes
at
either
end.
SHIFT-click
the original.
clicking an already selected node
path segments to add pairs of
will toggle between the scale
nodes
to
your
selection.
41 . When drawing paths with the
mode and rotate & skew.
Bézier tool, use single clicks to
46. Select the nodes at the end of 50. Hold CTRL-ALT when moving a
roughly outline the shape you
a path segment then press the
want with individual nodes, then
node to move it along the path
INSERT
key,
or
SHIFT-I,
to
create
a
adjust the curves afterwards. It's a
itself. Unfortunately it works with
new
node
in
the
middle.
The
lot easier than trying to drag each
only straight path segments, but
original
nodes
and
the
new
ones
all
CLIPPING AND M ASKING
point to bend the path as you go
does work with multiple nodes
remain selected, so you can press
along.
selected – they'll all move in the
INSERT multiple times to quickly
52. Use clipping to constrain
same direction as the one you're
create a large number of new
42. Use Boolean operations to
dragging. This is great for changing an object or group to the shape of
nodes.
a clipping path, with a hard edge.
full circle magazine #1 00
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This can be used to simulate an
object disappearing below
another.

clip, making it easier to make fine
adjustments.

54. Unfortunately the SVG
53. When clipping, always convert standard has no option for an
primitive clipping shapes, such as
“inverse” clipping path. Instead you
rectangles or circles, into paths
have to do the job by hand: create
first. That way you can use node
the path you want, then use the
editing to modify the shape of the Boolean “Difference” operation to
path without having to release the remove it from a rectangle that

covers the whole object. That gives
you a rectangle with your path cut
out of it, which you can then use to
clip your original object.

do this, then you can enter the
group and move it around after
clipping in order to adjust the
position.

55. Use masking, rather than
clipping, where you want a soft
edge or to affect the opacity of the
masked object. Unfortunately you
have to release the mask to make
adjustments.

WORKING WITH B ITMAPS

56. Masks are based on grayscale
values from 0 (black) to 255
(white). Use gradients from white
to transparent instead, to get a
better idea of the effect you'll
have. The transparent parts of the
mask will become transparent in
the final image, the white parts will
be opaque. This makes it slightly
counter-intuitive, because the bits
you can see through the mask will
disappear, and the bits you have
covered up will be visible, but it's
still easier than working with a
black and white mask that
completely obscures the drawing
below.
57. You can use clipping and
masking on bitmap images to
create interesting shaped pictures,
or to crop them to a specific size.
full circle magazine #1 00

58. Group each image before you
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59. Always link your images,
rather than embedding them. If
you want to embed to redistribute
the file, use Extensions > Images >
Embed Images... to convert them
before saving the file with another
name.
60. Right-click on an image and
select Image Properties from the
context menu. Edit the URL to a
relative path if you want to
redistribute your work, or even just
move it around on your hard drive.
In other words, if you want to use
“picture.png” in your drawing, put
it into the same directory as the
Inkscape file, then drag it into your
editing window. Edit the URL to
just read “picture.png” instead of
the full path, and it will continue to
work provided it's kept in the same
directory as the SVG file.
61 . Try to use high-resolution
bitmaps scaled down, rather than
small ones scaled up, if you can. It
gives Inkscape more data to work
contents ^
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with if you want to export your
final design.
62. When exporting PNG files,
always use File > Export Bitmap
(File > Export PNG Image in 0.91 ),
not Save As... Cairo PNG. The latter
loses transparency and sometimes
introduces other issues into the
exported file.

CLONES
63. If you have lots of identical
objects in your image or design,
using clones can significantly
reduce your file size. It also means
that you can modify all of them at
once, simply by changing the
original.

unlinks the clones, rather than
deleting them.

TEXT

71 . When creating text, make
66. If you're having trouble
sure you click once on the canvas,
selecting the original object, select then type. Don't click-and-drag a
a clone if it and press SHIFT-D.
box. The latter creates “flowed
text” which has compatibility
67. Transform your clones then
issues if you're using your image
clip or mask them to provide
outside of Inkscape.
simple “zoom” or “pan” effects.
72. If you do create flowed text,
68. Group objects before cloning use Text > Unflow before
if you want to clip the original.
distributing your image.
Apply the clip to the group and you
can still enter the group to clone
73. Select characters, or put the
the full-sized, unclipped version
text cursor between them and use
within it. Then just cut and paste
ALT plus the usual keys to move
that clone outside the group to
(arrow keys) and rotate (“[“, “]”)
wherever you want it.
parts of the text.

69. You can move clones between
64. Keep an eye out for situations layers. Cut them from one layer
where you can break your objects and paste into another, or just
select them and use SHIFT-PAGE
down into smaller sub-units, then
UP/DOWN.
only clone certain parts. When
drawing comics, I've found this to
70. If you want to copy clones to
be a quick way to produce
another drawing, group them
characters in similar poses where
together with the original first,
only the head or mouth changes.
otherwise you'll just end up
65. If you've created lots of tiled pasting an “orphan clone”.
clones, you can easily unlink them Alternatively you can use Edit >
Clone > Unlink Clone to turn them
by just deleting the original. This
into real copies first.
requires your preferences to be
set so that deleting the original
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74. To ensure that your image
appears exactly as you expect it to
on other people's machines,
regardless of the fonts they have,
convert text to paths using Path >
Object to Path. This will result in a
group of paths, one for each
individual glyph.

Use Path > Reverse to switch the
text between the “inside” and
“outside” of the path.
77. Don't use Inkscape's SVG Font
Editor. Unfortunately the SVG Font
format never became mainstream,
and even more peculiarly it's not
supported by Inkscape. Yes, the
Inkscape developers wrote an
editor for a font format that you
can't actually use in Inkscape!

FILTERS
78. Filters are part of the SVG
standard, and can be used to
introduce textures and effects that
just aren't possible with pure
vectors. Creating your own filters
is confusing but the program does
come with a good selection of
predefined filters that are worth
exploring.

79. Each filter consists of a chain
of effects, each with its own
parameters. If you add a filter to an
object, then add another, the
75. If you want a single
individual chains of both effects
compound path, select the text
will be combined to create a longer
and use Path > Union (CTRL-+).
chain. You can't easily remove one
of the filters after that's
76. To put text onto a path, select happened, so when auditioning
both, then use Text > Put on Path. filters, remember to apply one,
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then undo before applying the
next one.

then group the result... and so on.

up by hiding that layer temporarily. 83. With 0.91 came the ability for
predefined filters to prompt for
81 . Filters slow rendering down – 82. If you want to regain some
parameters, making it possible for
80. If you do want to use multiple sometimes quite significantly. Use speed, but still see a filtered object the filter creator to expose the
filters, but still keep the chains
the different options in View >
for reference, use Edit > Make a
main settings to the user. As a
separate, group your objects
Display Modes to regain some
Bitmap Copy to create a bitmap
result, some 0.48 filters look like
between each filter. In other
speed if you don't need to see the “snapshot” of your object. Then
they've disappeared, but have
words, group the objects and apply filtered objects all the time. If you you can use the “No Filters” display actually just been grouped
filter one, then group the result
can put the filtered objects onto
mode and use the bitmap as a
together into a single filter with
and apply filter two to that group, another layer, you can speed things temporary reference point.
parameters.
84. Many filters have a Live
Preview checkbox. You should
always use this to see what the
result of the filter will look like
before you commit. The “live”
nature means that it can slow
things down, especially when you
want to tweak lots of parameters,
so in that case you can uncheck it,
change the values, then check it
again when you're done to see
what effect your changes will have.

S AVING YOUR WORK
85. Use File > Vacuum Defs (0.48)
or File > Clean Up Document (0.91 )
before saving, to remove behindthe-scenes fragments of SVG that
are no longer used in your
document. You should definitely
do this before sending the file on
to anyone else.
full circle magazine #1 00
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86. Are you distributing your file
to other people? Use File >
Document Metadata (0.48) or File
> Document Properties >
Metadata (0.91 ) to set metadata
such as the drawing's title or a list
of contributors' names.

90. When saving to other vector
formats, such as PDF, make sure
you convert your text to outlines
first. Do this manually, rather than
just using the checkbox in the
export dialog, as the latter doesn't
always produce the right results
with some fonts.

than reducing bandwidth.
93. Are you creating SVGs for
Wikipedia or other mediawiki
based sites? Use Wikimedia's SVG
Check tool to test for common
problems first. This can also be
useful for general checking of
SVGs prior to putting them online.
https://commons.wikimedia.org/wi
ki/Commons:SVG_Check

If you need to animate an SVG file
right now, Javascript is the best
cross-platform way to do it.

FURTHER I NFORMATION

96. Obviously one of the best
ways to learn about Inkscape is to
87. Save as Plain SVG if you want
read all the tutorials in Full Circle
to put a file online without all the U SING SVG S O NLINE
Magazine. Another option is the
Inkscape metadata. Save an
official Inkscape manual, written
Inkscape copy as well, though, in
91 . If you want to keep the file
by Tavmjong Bah, Inkscape
case you have to edit it later.
94.
If
you're
a
web
developer,
sizes down on your web host, you
developer and member of the W3C
take
a
look
at
the
structure
of
a
might choose to serve compressed
SVG working group. Unfortunately
88. If file size is a concern, save as (svgz) files. Unfortunately the
simple SVG file. It's an XML format, it hasn't been updated for 0.91 yet,
Optimised SVG. It loses some
default configuration for most web which opens it to manipulation in
but almost all the content is still
precision, but probably nothing
the
browser
using
the
usual
servers doesn't deal with them
relevant. You can read it online at
you'll notice unless you've drawn a correctly. Try it out, and badger
Javascript DOM calls. This lets you http://tavmjong.free.fr/INKSCAPE/
really tiny image. In exchange it
insert, remove, move or modify
your ISP if it doesn't work. If they
but it's also available in dead-tree
can reduce the file size
parts of your SVG image
won't fix it globally then, for
format if you prefer.
considerably. If you need to do this Apache at least, you can get it to
dynamically. If you haven't done
for lots of images, use the “Scour” work by putting these two lines
much work with XML before, you
97. There are some great
utility from
might
need
to
read
up
on
XML
into a .htaccess file on your host:
community resources for Inkscape,
http://codedread.com/scour/
namespaces – and use the
but I'm going to call out three in
namespace-aware versions of the
AddType image/svg+xml svg
particular:
89. To save storage space on your svgz
DOM calls – in order to get things
• http://www.inkscapeforum.com
server or desktop, use the
working correctly.
AddEncoding gzip svgz
– a friendly and helpful forum, with
compressed (svgz) save options.
some extremely experienced
The files will be identical to the
95.
SVG
supports
a
standard
92. If you've got plenty of space
Inkscape users.
originals, but gzipped. The
called
SMIL
for
animation.
on your host, however, it's
• http://inkscapecommunity.com
downside of this is that not all file probably not worth trying to serve Unfortunately this is being phased – frequented by many of the same
managers will show previews for
out in some browsers, and was
svgz files. Most web servers will
people as above, but better
svgz files, and Firefox won't load
never
supported
in
Internet
gzip files on-the-fly, so this format
organised if you're looking for
them directly from disk (it will load is good only for keeping storage
Explorer. There's work on a more
tutorials, guides or reference
them from a web server, though).
space and server load down, rather general web animation framework material.
to replace it, but it's not ready yet.
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• http://www.inkscapeforum.it – an
Italian forum, but with a small
international section. There are
other localised Inkscape
communities around the globe
though, so if English isn't your first
language, do search to see if

there's already something in your
native tongue. If not, why not start
a site yourself?
98. A bit of a blatant plug, but at
my own site, www.peppertop.com,
you can find over 200 comic strips,

all of them at least partly created
with Inkscape. You can even
download the source to most of
them, so you can see how some of
these tips and tricks have been
used in practice. Every Greys strip
has at least one Easter Egg hidden

in it somewhere, usually to be
found by opening the Inkscape file
and investigating. How many can
you find?
99. Do you know your way round
C++ or Python? Why not consider
becoming an Inkscape developer in
your spare time. See
https://inkscape.org/en/develop/
for more details.
1 00. Not a developer, but still
want to help? There are other ways
to contribute, see
https://inkscape.org/en/contribute
for details. Don't forget that you
can also make a financial donation.

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/
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SU RVEY RESU LTS You r M ost Loved /H a ted Relea ses

Compiled by Ronnie Tucker

Several issues ago we asked you
to vote for your most loved/hated
releases.

KUBUNTU

MOST LOVED

was a distant 1 9 votes, and 1 5.04
limped in with only 1 0 votes.

MOST HATED

XUBUNTU

UBUNTU

UBUNTU
Your most loved Kubuntu was
also 1 4.04 (34 votes, 37%) but this
time 1 5.04 was close by with 27
votes (29%). The other releases of
Kubuntu were all single figures.
Your most loved Ubuntu release
was 1 4.04 which garnered 76 votes
(34%). At a distant 44 votes was
1 0.04 LTS with 1 2.04 not far behind
with 36 votes. Perhaps surprisingly,
1 5.04 only got 24 votes.

LUBUNTU

Again, 1 4.04 wins the day with
48 votes (55%). The 1 2.04 release
full circle magazine #1 00

And, again, 1 4.04 wins. Like
Lubuntu it’s a hefty margin. 1 4.04
got 55 votes (55%), but this time
1 5.04 came second (21 votes) with
1 2.04 coming third (1 2 votes).
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Without a doubt, your most
hated Ubuntu was 1 1 .04 with 37
votes (22%). Surprisingly a lot of
releases around 1 1 .xx and 1 2.xx
were in double figures and
averaging 8%. 1 4.04 (voted the
most loved) was second with 1 8
votes. Both 1 2.1 0 and 1 1 .1 0 got 1 3
votes, and 1 0.1 0 got 1 2 votes.

contents ^

SURVEY RESULTS

LUBUNTU

This one was an open and shut
case. 1 1 .1 0 (the first release of
Lubuntu) got 1 9 votes (35%) with
1 2.04 (the first Lubuntu LTS) with
1 0 votes (1 9%). The others were all
single figures. I guess that’s a good
thing!

KUBUNTU

This one is very wide spread.
The most hated was a draw
between 1 1 .04 and 1 2.04 both
with 9 votes (1 2%). Every other
release was also in single figures,
but equal second came 9.1 0 and
1 4.04 both with 6 votes (8%). Equal
third was 1 0.1 0 and 1 2.1 0 (5 votes
each).

XUBUNTU
This is another one that was all
over the place. The ‘winner’ was a
tie with 6.06, 9.1 0, and 1 2.04 all
with 7 votes (1 1 %). It was a draw
for second place between 1 1 .04
and 1 3.04. Both had 6 votes, 1 0%.
T
hird place went to 1 4.04
w
ith 5 votes.
Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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Ye O l d e C l o u d C o m p u t i n g

Written by S. J. Webb

e briefly covered the
Chrome OS and Google’s
Cloud Productivity Programs in
past issues. Let’s take a look at the
history of the Cloud. By
understanding the past, we can see
the potential impact the Cloud will
have on our economy and society.
There are many websites and
forums dedicated to the Cloud
concept; however these places are
dedicated for professional IT

specialists. I did find one website,
thoughtsoncloud.com, with a tech
writer Maximillano Neto. He wrote
an article that brings the Cloud
history to an end-user.

terminals at a company.
The terminals allowed many
employees to access the central
computer. It was more economical
for a computer to run this
hardware setup. This was the
common hardware infrastructure
until the early 1 970’s.

According to Neto, the roots of
Cloud computing started in the
1 950’s. At that time the computers
were large and expensive.
Employees did not have computers
Remember that ARPANET was
at their desk. Instead there was
launched in 1 969 with 4 connected
one central computer with dumb
geographically dispersed
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computers. This network grew, and
is considered to be the foundation
to the Internet that we have today.
In the 1 970’s, virtual machines
(VMs) were developed. Per Neto,
the VMs allowed numerous OSs’ to
exist in one hardware setup. The
VMs were the catalyst for
development for the
communication and technology
revolution.
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During the 1 980’s, the desktop
computers came to the consumers.
There were numerous computer
companies with their proprietary
software. Eventually Microsoft
with its Windows OS came to
dominate the market. Apple
survived during this period too. At
this time, computers would then
be used at home and commercially.
By the end of the decade, nearly
every house and every office had a
desktop computer.
At the end of the 1 970’s, the
client server was developed as a
standard operation. It enabled
full circle magazine #1 00

individuals to access data and
applications over a local area
network per Neto. Additionally,
ARPANET grew from the
military/industrial complex to the
scientific community worldwide,
and finally to the masses. By the
end of the late 1 980’s, the seeds of
the Internet were planted. Email,
VoIP, and other means of
communication were established
to help further our digital
evolution into the 1 990’s.
Computer Labs became dominant
in education.
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During the mid 1 990’s, the
Cloud was being utilized as a
descriptive adjective to describe
computer networks for classrooms
and presentations. It symbolized
the Internet of Things that is now
so commonplace. By the end of the
decade, the Cloud took a new
definition. Neto cites that grid
computing and utility computing
are the factors for starting the
Cloud computing movement. In
1 999, Salesforce.com is credited
with being the first to offer
Software as a Service, where
contents ^

HOWTO - CHROME CULT
clients are accessing its website
for various business applications.

instead of DVDs. Computers might
become minimalist following the
Chromebook formula. Increased
At the end of the 201 0’s, Netflix hacking attacks will be targeted
starts streaming and Google
against the Cloud data
launched Google Apps. These
infrastructure, and, in response,
companies shifted our reliance on increased antivirus development.
physical items to a Cloud service.
The Cloud is here, it is the start of
We no longer relied on DVDs and
new era in computer science.
Microsoft Word installed on the
local drive as noted by Neto. This
If you want further info on the
changed consumers’ habits. The
Cloud visit:
open source Cloud movement is
started with the success of
http://www.thoughtsoncloud.com
OpenStack and EUCALYPTUS.
- Thoughts On Cloud
Apple and Microsoft begin to offer
Cloud services in 201 1 . Google
http://cloudipedia.com/files/2009/
launches Google Drive in 201 2.
1 1 /cloud_computing_made_easy.p
Neto sees Cloud adoption rates
df - Cloud Computing Made Easy
accelerating, but it is being painted
as being another dimension of the
internet. Maamar Ferkoun at
thoughtsoncloud.com cites the
most common uses for the Cloud
today:
• Infrastructure as a service (IaaS)
and platform as a service (PaaS)
• Private Cloud and hybrid Cloud
• Test and Development
• Big Data Analytics
SJ Webb is a Linux Hobbyist and
• File Storage
Research Coordinator. He enjoys
• Data Backup
fishing, hot rodding, and spending
Nevertheless the Cloud is here.
It will impact our society at varying
levels. Digital ownership of movies

time with his kids and wife. He
thanks Mike Ferarri for his
mentorship.
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Wri te For Fu ll Ci rcle M a g a zi n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/7
5d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.
full circle magazine #1 00

When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
51
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H ow I Lea rn ed To Love U bu n tu

Written by Charles McColm

y first exposure to Linux
began with Slackware 97. At
the time I was still an ardent BBS
user and the amount of bulletin
board-related software in
Slackware, all for free, piqued my
interest. In those days Linux was
hard, not because of the difficulty
of the OS itself, but in part
because loading it on to my IBM
Thinkpad 701 C (butterfly) required
a lot of floppy disks. I would get
about 1 0 disks in only to have to
start again because of a bad
floppy.
As the years progressed I tried
several distributions: Mandrake,
Red Hat, SuSE, Debian, even Corel
Linux. All of the distributions were
good in some respects, but what I
found over the years was that
some distributions were better
than others on certain hardware. In
other words, some were easier to
get working with a certain set of
proprietary hardware than others.
So as I shifted to different
hardware, I also shifted to trying
different distributions to see
which one was the simplest to get
going with my hardware.

In late 2001 I joined a friend
working on his own distribution for
a small computer refurbishing
project. The distribution, WCLP
(Working Centre Linux Project) was
Debian-based. At the time I was
more of a fan of Red Hat Linux, it
looked more polished and I was
used to installing all my
proprietary hardware under Red
Hat. Our distribution was designed
to look a bit like Windows 98
desktop and run on a 486 with
1 6MB of RAM. I think we
succeeded quite well, but as the
years progressed other projects
started up with the same goals in
mind. Updating our distribution
became difficult. Initially our

distribution was released as a
client-server model, you set up the
server to image the clients. CDs
were pretty common, but it took
us some time to release a CD
image. Then major kernel changes
challenged everything, updating
the distribution was a lot of work,
most of it being done by the
project’s founder, Paul Nijjar.
In late 2005 I joined The
Working Centre as a paid staff
member. My exposure to Debian
GNU/Linux as a part of WCLP led
me to like apt as a package
manager, so when Ubuntu Warty
Warthog came along I was itching
to try it out. Warty Warthog
exceeded my expectations—it

worked beautifully and wasn’t too
difficult to install.
Warty Warthog worked so well
that I started looking at it as a
replacement for our WCLP Linux
distribution across all the
hardware we refurbished. Ten
years on we’re still using the
Ubuntu-base in the form of
Xubuntu on our Linux refurbished
computers. Our project is also a
Microsoft Registered Refurbisher,
and we’ve done a lot to automate
installation of both Windows and
Linux. We use a PXE boot server to
deploy all our tools and software.
The PXE server sits on, you
guessed it, an Ubuntu server
installation.
Our project is a community
tools project, we’re smaller than
projects like Computers For
Schools or RCT, but as the name
suggests we try to focus on
community. It’s a delight for us to
try to help people with
Linux/Ubuntu-related problems
because those problems tend to
be a lot more interesting than
removing malware. Paul, the WCLP
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project leader, also joined the staff
of The Working Centre and has
been instrumental implementing
technologies like our PXE server.
Recently Paul set up a system for
remote help that lets users click a
“Get Remote Help” button on their
Xubuntu computers. The button
launches a script which connects to
a server. Our technicians run
another script which generates a
password. We give the person
needing help the password. Once
they connect to the server it
prompts them for a password.
When they enter it a password is
generated on their end which they
in turn give to our technicians, thus
we have trust on both ends. Then a
remote tunnel is established and
our technicians can control the
desktop on the other end. At any
time either party can end the
connection. It’s a neat open source
alternative to proprietary software
like Teamviewer.
It’s being able to solve
problems with Linux without
having to spend a lot of money on
some proprietary solution; that
endears me to Ubuntu. We’ve been
able to build a large amount of our
infrastructure on open source.
When we book a repair, and when
our technicians work on a repair,

they use Xubuntu workstations to
connect to a server running
Ubuntu Server and PCRT, a paid,
but open source (PHP/MySQL)
repair tracking database.
Regardless of their Linux
experience all our volunteers are
familiar with Firefox so using the
repair tracking database is simply a
matter of a little guidance. PCRT
has made our repair technicians’
lives a lot simpler…but there was a
time when we had to look twice at
Ubuntu.
When Canonical made the
decision to switch to Unity our
project was faced with a big
problem—Unity didn’t work on a
lot of our hardware. Although I’d
used KDE before on other
distributions it too was a bit heavy
for some of the hardware we were
trying to get working at the time.
Our own distribution had used

IceWM. IceWM is very light, but it
lacked the nice drag and drop of
GNOME. We considered switching
to Linux Mint because Mint was
doing some exciting things at the
time Unity came out, but
ultimately we decided on Xubuntu.
Offering Xubuntu also lets us
offer people alternatives when
they come in with software that
isn’t legitimate. And because we’re
willing to offer support it usually
works out well, most people are
willing to adapt to avoid paying
$1 20 CDN (the approximate cost
of Windows 8.1 here). Of course
not everything is rosey. We do get
support calls when people cannot
run software they expect to run.
There’s been the rare case where
we haven’t been able to get
something to run (a very old
program WINE wouldn’t run), but
we also get the delighted calls

from people when things go right
(Minecraft on Linux).
I learned to love Ubuntu
because it enabled me to enable
others, whether it’s volunteers,
people coming to us looking for
computer help, or even Windows
users looking for inexpensive
software (FLOSS) they could use as
an alternate to expensive
commercial solutions. It’s a love
that seems to have caught on over
the years, many of the volunteers
we’ve had who were “strictly
Windows” use both Xubuntu and
Windows. It’s a love that seems to
have caught the eye of some of
our newest volunteers who are
intrigued by our remote help
solution. And it’s a love that’s
caught on with many of the people
who come to us for help because
we no longer have to ask them to
install something to help them.

Charles is the author of Instant

XBMC, and the project manager of a
not-for-profit computer reuse
project. When not building PCs,
removing malware, and encouraging
people to use GNU/Linux, Charles
has a blog at charlesmccolm.com.
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Written by Alan Ward

n a previous article, “Review Plasma 5” that appeared in
FullCircle #97 from May 201 5, I
mentioned briefly the efforts of
the Trinity Desktop Environment
project
(https://www.trinitydesktop.org)
to keep alive and further develop
the KDE version 3 desktop
manager. This is a piece of
software with much lower
hardware requirements than the
more recent versions 4 or 5 -- even
though, it must be said, Plasma 5
has lowered the bar considerably -but that has a sufficiently friendly
appearance and enough bells and
whistles to be a useful alternative
to other, more modern, offerings.

Ba ck I n Ti m e Wi th Tri n i ty An d Q 4O S

my experience so far has not been
bad at all.

the world for the last decade?
None other than Microsoft
Windows 2000 and XP. There is still
What is interesting about the
a large volume of XP computers
Q4OS, and sets it a bit apart from
out there, which users (and their
the many other Debian derivatives, employers) seem in general happy
is not only the use of Trinity as a
to continue using, and unhappy to
desktop manager, but also their
be forced away from due to
clear orientation towards a
obsolescence.
business environment. This has
long been the province of RedHat
The last time I actually owned
and their mostly server-oriented
and used a Windows desktop, it
derivatives. In this case, however,
was an XP. This does not actually
the accent seems to be placed
say as much about my personal
more on the desktop. And which
choices, as about the fact that
desktop operating system has
GNU/Linux and Ubuntu stepped up
been long used in business all over at the right time to interest

This at least seems to be the
opinion of the Q4OS distribution
(http://q4os.org), that bases its
latest version 2.0 offering on
Debian Stretch (the yet-to-bereleased Debian 9) for the basic
system, and Trinity as the desktop
manager. This is still in testing at
the time of writing, so very much
needs to be considered as beta
software. Some things can go
wrong, though it must be said that

desktop users - about the same
time there was a general
impression that Windows Vista had
rather let down users’
expectations. So it seemed a
logical evolution to switch my main
computing environment over to
the Ubuntu family. Since then,
Windows Vista, Seven, 8, 8.1 , and
now 1 0, have come (and gone, for
most) without making much of a
blip on my radar screen, so I can
confidently state that XP was the
last Windows desktop
environment I really learned to
use.
So, what has this to do with
Q4OS? Once we have downloaded
the 32- or 64-bit ISO file from the
SourceForge address
(http://sourceforge.net/projects/q
4os/files/testing/), copied it to a
USB or burned a DVD in the
traditional Ubuntu way, and
booted into the Live environment,
we see this:
Reminds one of something,
right? A bit of a mix between KDE
3, Windows 2000 and Windows XP.
Let us install it to a hard drive
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(“Install Q4OS”) - with what is
basically the new version of the
standard Debian installer. It is not
much different from the Ubuntu
installer, but with some tweaks I
appreciate. Debian recognizes my
time zone and localization
correctly, something which has
been broken in Ubuntu since 1 2.1 0,
more or less. The graphics are also
much nicer, though that may be an
element of subjectivity speaking.
Once installed, the desktop
environment came back up with a
starter dialog I found helpful. Here

we can already choose to have our
system auto-login a user, install
user applications, and otherwise
tweak our new system. Naturally,
this is quite different from most
*Ubuntu distributions, where the
user needs to be somewhat more
proactive and actually look for
configurations by him/herself.
If you lose track of this screen,
it can be launched once more from
the console using the command
welcome-screen.exu
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The Start menu has the icons
organized in a similar way to
Windows, and the notification area
of the status bar likewise.
Connecting to WiFi is a clear and
easy process.

the more curvy XP version. With
this, and an XP background from
the Internet, the looks of the
desktop are quite similar.

There are several ways of
installing applications. Some of
The Control panel is where you them seem to have been
would expect it - think in terms of repackaged slightly by the Q4OS
Windows XP - and the layout of
project, with a new dedicated
most options will also remind us of installer for each application. The
times gone by. One of the options, installer has been pre-installed in
in Settings > Appearance & Themes the system, and when activated,
> Look Switcher, gives us access to prompts the user to download and
an equivalent of the “Classic look” install the actual software. The
similar to Windows 2000 instead of installer has been reworked
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visually to resemble old-style
Windows installers, but the actual
work is being done by the apt
system behind the scenes. Synaptic
is one of these applications, so we
can also have graphical access to
the complete Debian repository.
As installed, the system
occupies about 2.3 GBytes of hard
drive space, which is small by
modern standards since Ubuntu or
Linux Mint are between 4 and 5

GBytes - and Microsoft Windows
8.1 is at 20+ GBytes. The drawback
is that not very many user
applications are installed by
default: a web browser, a PDF
viewer, two file managers and not
much else.

graphical software manager.
Needless to say, the Console is
available with the usual range of
apt commands: apt-get, dpkg,
aptitude, etc.

To stay within the Windowsthemed environment, I went to
To install further applications,
download the Kingsoft WPS Office
the welcome screen can be used to (http://wps-community.org/). The
install major applications such as
64-bit DEB file wpsLibreOffice, VLC, Teamviewer or
office_9.1 .0.4961 ~a1 8p1 _amd64.d
X2go, or to install the Synaptic
eb was downloaded into folder

~/Documents/Pictures - and yes,
user folders are organized in a
slightly different way than what
Ubuntu has accustomed us to. I
then had to go back to the console
to install it by issuing
sudo dpkg -i wpsoffice_9.1.0.4961~a18p1_amd64
.deb

The new programs (word
processor, spreadsheet and
presentation editor) appear in the
Programs menu, and can be linked
to the desktop using a right
mouse-click. That’s it - all set up to
do some work.
My original intention was to
review Q4OS as a desktop option
for those who like KDE, but who
either need to use less than stellar
hardware, or just prefer function
over form. Trinity performs well
from both points of view: fast and
snappy. The Windows look-alike
twist was unexpected, but one I
feel could be of interest for certain
users. This version 2.0 of Q4OS is in
theory still firmly in the testing
branch. But after doing some
testing, and typing this article with
Chrome and Google drive on the
testbed itself, I am quite happy
with how it stands up to actual use.
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U B U N TU P H O N E S

Written by Ronnie Tucker

his list is only a highlight of the B UGFIXES
few changes available in this
update. Please check the detailed
As we know, each release
changes for all the changes
includes a huge number of bugs included in this OTA.
some for previous issues and some
for new regressions introduced inbetween. To see the overall list of
I MPORTANT FEATURES
what issues got fixed, please check
the detailed changes below. The
• New loading splash screen
interesting ones are as follows:
during boot (shown right).
• Trust store integration for
• Removal of non-existing APs
camera-app and pulseaudio from the AP list
authorization now required to
• Fix for Facebook integration
allow any application access to
• Fixes for wrong contacts shown
camera and audio recording
as message sender
• Fix media-hub HTTPS stream
• WiFi hotspot support
support
• media-hub webbrowserapp/webapp integration - enabling • Fix emulator images not
building and not booting
audio playback for webapps
• Multiple critical fixes in all core
• New alarm sounds
components such as UITK, Unity8,
• Slight updates in the overall
telephony and networking
design
• Webbrowser Find in page
...and much much more.
functionality added
• Oxide 1 .8.4
• Changes to the 'high volume'
D ETAILED CHANGES
warning UI and behaviour for
compatibility with EU regulations
Commitlog:
• Improved expanded indicator
http://people.canonical.com/~lzem
visibility
czak/landing-team/ota/ota6.commitlog
full circle magazine #1 00
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H ow Th i n g s H a ve Ch a n g ed

Written by Ronnie Tucker

W

ay back in FCM#1 2 (the first
anniversary issue), I
discussed the site statistics for
that first year. I thought I’d look
back from then until now. It’s been
just over seven years since that
first report, so a lot has changed
since then. Let’s take a trip back in
time…
What I’m doing here is
comparing August 2007–March
2008 with August 201 4–March
201 5.

B ROWSER
As of now, the most popular
browser (to visit the site) is Firefox
with over 60,000 sessions. Over
35,000 of those are new visitors.
Chrome comes in second with
48,000 sessions and 30,000 new
users. Surprisingly, Safari is next
with 7,500 and 4,400 new users.
Good old Internet Explorer has
5,1 00 and 3,600 new users.
Android browser is next with 2,800
and 1 ,600 respectively. Opera has
only 2,700 and 1 ,400 new users.

LANGUAGE

At first glance the 2007 and
201 4 graphs may look similar, but
they’re actually very different.
Currently the most popular
Back then, again, US English was
language is, as I’m sure you’ve
guessed, English. With over 60,000 top of the list with over 1 30,000
sessions and 94,000 new users.
US and 1 2,000 UK visitors with
Second, though, was French with
40,000 and 7,000 new users
1 3,000 and 1 0,000. Third was
respectively. Third is French with
Chinese with 1 1 ,000 and 8,000, and
5,000 sessions and 3,000 new
in fourth place we have a mention
users. Next comes Italian and
of English. No UK or US on this
Back in 2007 it was a different
German with around 4,000
story. Firefox was still in first place, sessions each and 3,000 new users. mention, so we have to assume it’s
Other English, but it has 1 1 ,000
but with almost 200,000 sessions
Italian creeps in again on the list
and 1 38,000 new users. Second
with a further 3,000 sessions. Not sessions and almost 7,000 new
was Internet Explorer with 33,000 sure how it’s getting counted twice users. Next, was Italian with 1 1 ,000
and 25,000. Then came Opera with there. Dutch is next with 2,500 and and 7,700. Following Italian was
German with 1 0,000 and 7,000 new
1 4,000 and 8,1 00. Fourth was
1 ,500, followed by Spanish with
Konqueror with 5,400 and 3.200.
2,000 and 1 ,000. Another mention users. Seventh was UK English with
Next came Mozilla with 5,400 and of English with 2,000, and another 8,700 and 5,800 new users.
Spanish, Hungarian and Brazilian
3,800, then Safari with 2,600 and
mention of Spanish with 1 ,900.
2,000.
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Portuguese has sessions of 8,300,
5,500 and 4,600 respectively.

O PERATING SYSTEM

I’m surprised by the low amount
of iOS sessions. It’s almost a third
of Android. Even adding Macintosh
and iOS it’s still only two thirds of
the Android visits.

One thing to remember here is
that this is the OS that you were
using when you visited the site.
Not the one you like the most. So if
you were at work, using Windows,
OK. This is where things start
and cheekily downloaded FCM,
getting weird. If you thought
then that’s a markup for Windows. seeing UNIX mentioned in 201 4
LOCATION
was weird. Wait until you see what
At
the
moment,
the
most
was happening in 2007.
As ever, top of the list in
sessions
come
from
Linux
Although you may think
2007–2008 was the US with 48,000
(surprise!) with 56,000 and 31 ,000
language and location would be
First on the list was Windows
sessions and 34,000 new users.
being new users. Second place
the same. They’re not. You might
(surprise!) with 1 26,000 sessions
Second was Italy with 1 6,000 and
goes
to
Windows
(version
have an Italian who’s living in the
with 93,000 new users. Linux came
1 1 ,000. Next came France (1 6,000
unknown)
with
45,000
and
29,000
UK whose location is marked as
second with a close 1 23,000 and
and 1 2,000), China (1 5,900 and
new
users.
Next
comes
Android
UK, but they’re downloading the
81 ,000 new users. Third was
1 1 ,700), Germany (1 4,000 and
(1 6,000 and 9,700), iOS (6,500 and Macintosh with 7,000 and 5,300.
Italian translation.
1 0,000), UK (1 2,000 and 8,400),
Fourth was ‘not set’ with only 800
Spain (1 0,000 and 6,600), Hungary 4,000), Macintosh (6,000 and
3,900),
Chrome
OS
(493
and
300),
Currently the US and the UK are (8,000 and 5,900), and both Canada
and 640. Next came an odd bunch;
Windows
Phone
(300
and
240),
top of the chart with 25,000 and
FreeBSD (1 00 and 90), SunOS (80
and Brazil had around 7,000
‘not set’ (300 and 250), Blackberry and 60), iPod (30 and 25),
1 2,000 sessions (1 6,000 and 7,000 sessions and 5,200 new users.
(1 90 and 1 40), and lastly UNIX with SymbianOS (26 and 24), iPhone (20
new users). Next comes Italy (9,400
only 40 sessions and 35 new users. and 1 5), and in at last place was
and 5,700), Germany (6,500 and
4,200), France (5,200 and 3,1 00),
the PS3 with 1 5 sessions and a
Canada (4,700 and 2,700—possibly
mere 9 new users!
the source of the ‘other’ English
hits), Netherlands (4,000 and
2,300), India (3,400 and 2,600),
Australia (3,200 and
1 ,700—probably another ‘other’
English), and last, but not least,
Spain with 3,000 and 1 ,900.
Bear in mind that back in that
first year/two, we had a lot of
active translation teams. Now we
have only a handful.
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FCM on Reddit. I might make an
That just goes to show how
operating systems have changed in exception for FCM#1 00 though.
LXLE.com is next with 750, Ubuntu
just seven years.
Forums with 700, and last is Daily
Ubuntu with 600.

THAT WAS THEN

So, there you have it. It does
seem like readership has dropped
somewhat since 2007. I’ve no idea
REFERRALS
why, but it might be down to the
Back in 2007 it looked
magazine being something of a
This is a bit of an oddball one,
completely different. The most
novelty back then. It might be that
but I thought I’d throw it in
referrals came from StumbleUpon a lot of folks have moved on to
anyway. Sites come and go, as do
with almost 1 4,000. Second was
things, thereby losing
spam/junk links, so this one is to be the Ubuntu Fridge site with 1 1 ,000. other
interest in Linux and, thus, the
taken with a hefty pinch of salt.
Third was the Ubuntu Hungary site magazine.
with a touch over 6,000. Google
Currently, we get the most
came in at fourth with over 6,000. I
It’s up to you, the readers, to
referrals from feedly.com (2,400)
assume from folks searching for
help spread the word and bring
followed by Twitter (t.co) with
‘ubuntu magazine’, or something
FCM to more new users.
almost 2,000. Google+ serves up
similar. Next came Ubuntu Users
1 ,300, hotukdeals (?!) seems to
with 6,000, Planet Ubuntu France
throw over 1 ,000 our way, with
(5,400), Linux Toy (5,200), Full
Planet Ubuntu being somewhat
Circle Magazine (how?!) with 5,000,
similar. People jumping straight to DistroWatch sent us 3,400, and
the download link account for
Opennet.ru with 3,000.
about 900 visits, with Reddit
passing us 880. Surprising
considering I never post links to

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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Li n u x I n I n d u s t r y

Written by Ronnie Tucker

F

or the big one-hundred, I
thought I’d do something a bit
different. I emailed over a dozen
large scale Linux users –
companies, businesses, and
educational establishments. I was
interested in knowing what distro
(or distros) they were using, what
kind of hardware it was running on,
how they were using it, and were
they using open source or
proprietary software.

information I received.

From over a dozen, only a few
replied. Here’s my report from the

AWS runs on the Amazon Linux
AMI which is an Amazon supported

AMAZON

Linux image for use on Amazon
Elastic Compute Cloud (Amazon
EC2). The image is maintained by
AWS and is free to EC2 users.

Amazon’s most well-known use
The Amazon Linux AMI uses
of Linux is its Amazon Web
YUM for packages and
Services (AWS http://aws.amazon.com). Basically, repositories, and (from what I can
it’s where you can build a scalable tell) is a lightweight distro.
site using Amazon’s infrastructure.
It’s used by everyone from Reddit
to Netflix, Dow Jones to Vodafone.
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The source code for the distro
can be viewed using the
get_reference_source command
line tool which is provided.
For those of you looking to
install Amazon Linux AMI on your
laptop, it’s available for use only
inside of Amazon EC2.
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EPFL
The EPFL (École Polytechnique
Fédérale de Lausanne) uses Linux
in everything from large networks
to even drones. Their Laboratory
of Intelligent Systems (LIS)
specialises in bio-inspired AI,
autonomous robots, and the like.
From messing around with
cheap, simple, quadcopters, I can
tell you that flying them in close
quarters is just asking for trouble.
This is something the EPFL’s LIS is
looking into. Their GimBall drone
has a protective cage which keeps

it safe even in collisions.

ARIES
Aries is one of four IBM AMD
Opteron clusters used by the EPFL.
You think your desktop PC is pretty
beefy? Take a look at what’s inside
Aries:

using a fibre-based adhesive.

• a front end consisting of two
dodeca-cores processors AMD
Opteron 61 76 (Magny-Cours) 2.3
GHz, i.e. 24 cores, with 24GB of
memory;

Another EPFL cluster machine,
this time Sandy Bridge based, and
has:

But it doesn’t end there for the
EPFL. Oh, no. We’ve looked at the
small things running Linux, now it’s • 2 racks including 44 pizza nodes; • Peak performance: 1 1 9 TFLOPs
time to wheel out the big guns.
each node contains four
• Total RAM: 1 4TB
processors dodeca-cores AMD
Opteron 61 76 (Magny-Cours) 2.3
• Storage: 200TB
GHz (i.e. 48 cores per node), each
with 1 92 GB of memory i.e. 4 GB
The cluster is composed of:
RAM per core; peak performance:
1 9.43 TFlops;
• a frontend,
• nodes are interconnected by an • a master node in charge of
InfiniBand fast network QDR at 40 administration and backup,
• 424 compute nodes, each with:
Gb/s, (fully non-blocking);
• 2 Sandy Bridge
processors running at 2.2 GHz,
• a GPFS dedicated storage of
with 8 cores each,
effective 87 TB – 1 4 TB for home
• 32 GB of RAM,
and 73 TB for scratch.

The AirBurr drone is even more
impressive in that it can right itself,
if landed/fallen upside down, and
can even stick itself to surfaces

B ELLATRIX
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• for a total of 6784 cores
• Infiniband QDR 2:1 connectivity
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• GPFS filesystem.

• 1 6 GPU accelerated nodes, each
with 4 K40 NVIDIA cards
• 8 large memory nodes, each
with 256 GB of RAM
• 2 NUMA nodes, each with 4
processors and 51 2 GB of RAM
• Infiniband QDR 2:1 connectivity,
• GPFS filesystem.

CASTOR
Castor is a Dalco Intel Ivy Bridge
cluster specifically tailored for
sequential calculations which is
comprised of:
• a front-end;

All of the above clusters run
RHEL (Red Hat Enterprise Linux)

• an administration and backup
node;
• 50 standard nodes with 64 GB
of RAM each;
• 2 large memory nodes with 256
GB of RAM each;
• an NFS storage server of 22 TB
(4 TB for home, 1 8 TB for scratch);
• the nodes are interconnected
by a 1 0 GbE network.
Each node has 2 Ivy Bridge
processors with 8 cores each,
running at 2.6GHz (model name:
Intel Xeon E5-2650 v2).

D ANEB
Last, but not least, is Daneb.
This is an Intel Xeon based cluster

which has:

If you think they’re impressive,
you ain’t seen nothing yet!

will bring tears to your eyes:
• IBM Blue Gene/Q Massively
Parallel Supercomputer
• 1 rack, wired as a 4x4x4x8x2 5D
torus
• 1 024 sixteen-core nodes,
PowerA2, 1 .6 GHz
• Energy efficient, water cooled
• 209 Tflops peak, 1 72 Tflops
LINPACK
• 1 6 TB of memory (1 6 GB per
compute node, 1 GB per core)

Storage

• Peak performance: 293 TFLOPs
(21 1 in CPUs, 92 in GPUs)
• Total RAM: 37TB
• Storage: 350TB

• 2.1 PB of disk space
• GPFS Native Raid (GNRx) disk
management solution
• GPFS parallel file system

The cluster is composed of:

If you really want to geek out
on this beast, I’ll let you download
and flip through the Getting
Started guide:
http://bluegene.epfl.ch/pdf/Gettin
gStarted.pdf

• two front ends,
• two master nodes in charge of
administration and backup,
• 376 compute nodes, each with:
• 2 Ivy Bridge processors
running at 2.6 GHz, with 8 cores
each,
• 64 GB of DDR3 RAM,
• 1 44 compute nodes, each with: B LUEG ENE/Q
• 2 Haswell processors running
at 2.5 GHz, with 1 2 cores each
This behemoth is the Lemanicus
• 64 GB of DDR4 RAM
BG/Q supercomputer. The specs
full circle magazine #1 00
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I’ll let Vicky from the EPFL tell
you more about them:
“As standardHPCplatforms, our
clusters run a mix ofOpen-Source
andproprietary software. There are
some specific drivers for the
InfiniBandnetwork andthe GPUs
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(for the nodes with GPUs), and
proprietary compilers and
parallelization libraries (Intel). Of
course, we also provide GNU
compilers andOpen Source
parallelization libraries, so the users
who want to, can use free software
on our machines. Actually you can
go fully Open Source on the
supercomputers. But, as I say, those
are beowulfclusters following the
beowulfphilosophy: commodity
hardware, free andopen source
software.”

What’s a Beowolf cluster?
Basically:
• a distributed memory machine.
• a cluster built from inexpensive
personal computer hardware.
• a group of identical,
commercially available computers
(compute nodes).
• running Free and Open Source
Software (FOSS).
• nodes are networked into a
small TCP/IP LAN, and have
libraries and programs installed
which allow processing to be
shared among them.
• behaves more like a single
machine rather than many
workstations.
• compute nodes are accessed
only via the master nodes.
• appears to the network as a

unique entity.
• Beowulf nodes can be thought
of as a CPU + memory package
which can be plugged into the
cluster.
• to have a faster cluster, just add
nodes.
Some users access the cvlab
cluster with just a shell.
Computations are done using
Python and C++ to give maximum
speed. Some, though, use Matlab.
The cluster in question is made
up of:
• 6 x IBM x3650 M3
• 4 x Dell PowerEdge R720
• 3 x IBM x3650 M4
• 2 x Supermicro X8DTU
• 1 x Supermicro X7DWU

CERN
The European Organization for
Nuclear Research, or CERN, is
probably most famous for the
Large Hadron Collider (LHC). Every
second, 600 million particles
collide within the LHC. Every year
physicists sift through 30
petabytes (more on them later) of
data.

Enterprise Linux 5 and 6
respectively), along with some Red
Hat Enterprise Linux. New
installations are now starting to
use CERN CentOS 7 (CC7).

A wide range of applications
are used, including standard
infrastructure components such as
web services or development build
services, but the bulk of the
resources are used to support
physics analysis and simulation by
CERN uses several Linux
the 1 1 ,000 physicists who use the
distributions on approximately
25,000 servers and desktops at the facilities at CERN.
laboratory’s sites in Geneva and
Open source software is used
Budapest. The majority are running
extensively at CERN – from the
Scientific Linux CERN 5 and 6 (ie:
infrastructure such as Linux and
Scientific Linux from Red Hat

Most of the Computing Science
courses in first or second year are
encouraged to use Linux. Quite a
few IT rooms dual-boot Linux with
Windows. Some can even be
accessed using SSH.
Many thanks to Vicky and Axel
for the info.
I’m sure, after all that, your
head is spinning. Speaking of
spinning…
full circle magazine #1 00
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OpenStack, through to the
applications written by the
physicists themselves to analyse
the 27 PB/year (PB = petabyte =
1 ,000 terabytes, or 1 ,000,000
gigabytes) which is produced by
the Large Hadron Collider.

There are around 1 1 ,000 ‘white
box’ servers in the CERN computer
centres with between 8 and 32
cores and an average of 2 GB/core.
They are generally connected
using 1 GB/s Ethernet. These
servers are part of the Worldwide
LHC grid which runs over 2 million
jobs per day.

Press Office from CERN for that
info.
To learn more about the LHC,
there’s an excellent PDF brochure
from:
http://cds.cern.ch/record/1 1 65534
/files/CERN-Brochure-2009-003Eng.pdf
To learn more about CC7,
SLC5/6, and more, see:
http://linuxsoft.cern.ch/

SUPERCOMPUTERS

Needless to say, almost all of
the world's top supercomputers
Many thanks to Tim Bell and the run Linux in some form. The
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TOP500 is a table showing the top
500 most powerful
supercomputers. Starting in 1 993
the list is published twice per year.

Having looked through the top
ten, they all run Linux of some
sort.

The top five as of November
201 4 are:
Number one on the list is
Tianhe-2 from China. It runs Kylin
Linux, which is a version of Ubuntu.
In second place is Titan, which runs
the Cray Linux Environment.
Sequoia, in third, runs Linux. Just
‘Linux’ according to the TOP500
listing. Same with K in fourth place
and Mira in fifth.
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Written by AuntieE and the Team

H

ello, readers of Full Circle
Magazine from all around the
world! Well over a dozen issues
ago, Ronnie launched a new
column in which space was given to
various translation teams. If
memory serves, the first one to be
presented was that of Italy, and
the second, that of Hungary. Every
time we, the French team, put a
new issue in French on the site of
what we call the “v.o.” or “version
originale” (the magazine in
English), we would find that the
Italians had gotten there ahead of
us. I believe, however, that, since
issue 86, ours has been the only
translation available. I'm referring
to the issues that we ourselves
have published. As I write, Issue 89
will be coming out in French within
hours and Issue 90 won't be far
behind. But, again as I write,
Ronnie has just sent out a link to
texts from upcoming Issue 94 ... To
put it bluntly, we are roughly four
and a half months behind the “vo”.
Why this huge delay? On the
one hand, at least in France, there
has been a notable decline of
people interested in getting

involved with our team; and on the
other, some readers have become
far more demanding. For example,
we get importunate emails asking
when their articles in French (we
accept them for our edition) will be
published, or why they haven't
already appeared in print. But far
fewer saying “I'm ready to help!
What can I do?” We have concluded
that the Full Circle is no longer a
community affair, but simply
another item of consumption for
consumer-readers. Still, I'll go
ahead and say this, hoping that
someone out there is actually
reading: “We can use all the help
we can get!”

Th e Fren ch Tra n sla ti on Tea m
French. (Our readers are totally
spoiled!) He is translating most of
the articles on compiling the
kernel, as well, not to mention
some very difficult Linux Lab
columns. We would be lost without
him.

the answering.
Although there are currently
1 01 members listed on the Wiki,
there are only three who are truly
serious about helping, month after
month. In alphabetical order, they
are d52fr, a relative newcomer,
Ekel, the author of several articles
for the French magazine, and
frangi, a long-time pillar of our
group. Although fairly new, d52fr
has quickly become a mainstay of
the team and he is doing the layout
of issue 89 as an apprentice
“scriber”. He also does many
translations and much proofreading. Ekel is a stalwart at proofreading and frangi translates. He
was even the sole translator of one
of the recent issues! What's more,
he regularly chooses to do the
News: pages and pages of difficult
text! Finally, like FredPhil91 , he is a
true geek and helps us out in that
department as well.

Then there are two ordinary –
as opposed to super –
administrators: Bab, formerly in
the printing trade, is the manager
of our layout and has all the
secrets of Scribus at his fingertips.
Bab also does a lot of the proofreading. He claims he knows no
English, but has managed to do a
few short creditable translations
on his own or with the help (the
hindrance?) of Google. Like Bab, I –
WHO WE ARE
AuntieE – am retired. I was an
The super administrator of our associate professor at the
Sorbonne and taught French-tosite, I suppose you could call him
our CEO, is FredPhil91 . He is one of English translation. I now do, and
correct – old habits die hard –
our “resident geeks.” It is he who
English-to-French texts. In a way, I
takes care of all the work
necessary to keep the site, which is think, I am also the PR person, or at
Obviously, we are all very
kindly hosted by ubuntu-fr, up and least a one-person welcome
wagon, of the team. If you write to interested in Ubuntu and Open
running. And that is not an easy
Source...
webmaster@fullcirclemag.fr with
task. In addition, Phil regularly
translates the Python articles and questions, comments or whathave-you, it's quite likely that I'll do
rewrites and tests the code in
full circle magazine #1 00
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H OW WE WORK
Once all the articles have been business to talk about our garden
crops, the weather, or anything
incorporated into the PDF, the
One of our most basic rules is
scriber puts the first version (V1 )
that each member does only as
on the Finalization page. And at
much as he or she can and wishes
least two of us, preferably three,
to do. Family-life, work (of course), read an article and put their
and even leisure activities, come
comments on the order of “p. 26,
before the Full Circle. “Real life”
col. 1 , line 1 3, the subjunctive is
matters.
necessary after “Bien que”, or
“there are too many blank spaces
Other than that, when we finish in paragraph 3”. Ah, yes, unlike
one issue of Full Circle, we start on Ronnie and Co., we have decided
the next. First we work from the
to justify our text, which means
dokuwiki Recapitulation page,
additional headaches for our
created by any one of us, using the scriber. When all of the articles
texts from the Sources of the
have been read at least once, a
English version. Those who want to second version is brought out (V2)
translate an article move its link
containing all of the corrections,
below the heading “In translation,” some of which may cause further
and, when they have finished, they problems in the layout. So V2
move the article into “Completed
through Vx must be verified. Once
translations for proof-reading.”
at least two people have reread
Theoretically, each translated
the texts for grammar and
article is read by two more-or-less spelling, as well as for layout, and
bilingual people to make sure that once the suggested corrections
the translations are faithful to the have been made and verified, the
ideas of the original, and that the
final version, along with the
French grammar and spelling are
sources, is put on the Finalization
correct. Each person who rereads
page.
an article puts his name down as a
proof-reader of that article and,
During the whole time, when
once two people have done so, the any of the team has doubts or
“scriber” rereads it a third time to questions, we keep in touch on our
validate it and incorporates it into forum (driven by phpBB® Forum
a first version of the PDF.
Software). We also go beyond
full circle magazine #1 00

that crosses our minds. It's on the
forum that I put a first draft of the
blog post that will announce the
appearance of a new issue in
French, for “comments, criticism
and correction!”

of it, and because, as I said at the
very beginning of this
presentation, we need any help we
can get, you'll find out how, here
(in French):
http://www.fullcirclemag.fr/dokuw
iki/doku.php.

The entire team joins me in
We use DotClear for the blog at thanking Ronnie and his team for
http://fullcirclemag.fr. Every new
their great work. Without them,
post also goes to planet-libre and
we couldn't exist!
planet-ubuntu-fr. We obviously try
to make the blog attractive and
THE FRENCH EDITION FROM
get good publicity for each issue. It
seems to be working: Issue 88 was S TART TO F INISH
downloaded 1 602 times, Issue 87,
First, we create a dokuwiki page
1 71 5 times, and Issue 86, a
where all the English texts are
whopping 7330 times(?!). Each
issue can be read online on our site available, one by one, for
(for example, issue 89 can be read translation. For example, in Issue
89, there was an article by Ronnie
at :
http://www.fullcirclemag.fr/vision on X-Plane in the Ubuntu Games
neuse/visionner.php?numero=num column:
ero88fr), and the number of cyber
The translator has divided the
readers per issue averages at
around 400. (For info, stats can be article into three parts to make it
easier to see and to translate. The
found here for downloads:
http://www.fullcirclemag.fr/index. English is in bold type and the
French is simply normal print.
php?media, and here for on-line
reading:
When the translation is
http://www.fullcirclemag.fr/vision
finished, it must be read by at least
neuse/stats).
two people, preferably bilingual,
If anyone would like to become to check not only the translation
part of our project, just for the fun itself, but also the French syntax,
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spelling and grammar. Once this
has been done, the article is
validated for incorporation into
the PDF.
Jeux Ubuntu 2 was translated
by d52fr, reread by Bab and by me
(AE), then validated by d52fr, the
“scriber” of this issue.
Version after version, each
article of the PDF is read (or
verified). All problems are noted

on the Finalization page itself.
When everything has been
corrected successfully, a big red X
becomes a nice green check-mark
and we consider that the article is
ready for publication.
Here, we can see that Jeux
Ubuntu 2 was translated by d52fr
and reread by Bab and me (AE).
The "scriber" (d52fr) validated it
for the PDF.
full circle magazine #1 00

And above is our finished
product, which we try to make as
professional as possible.
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Written by Various

I

by Phil Hill

kicked off using Linux as my
desktop in 2005. I had been
puddling about for much of the
previous couple of years trying to
get off the ground with Linux with
RedHat and Mandrake releases.
Then, in 2004, along came Warty
Warthog, and things changed. It
was no longer a fight to install – it
was just a case of inserting the CD
and answering the questions and
there we had it – Ubuntu.

Ubuntu, my move to Linux from
Windows was a real eye opener. It
was my first taste of Linux where I
hadn't run into brick walls over and
over. I initially had a few issues
with Graphics Drivers due to the
nVidia card I was using, but
otherwise it was pretty plain
sailing.

In the years since then, I have
always made a point of trying out
different Live DVD/CD's to see
what is the latest feature on offer
with the various distros. I have a
What amazed me was the
preference for KDE-based distros,
brilliance of the forums that
mainly due to my insistence on
sprang up following the release of tweaking things to see what they
Ubuntu. It helped immensely to, all can do. KDE gives me that ability,
of a sudden, have a lot of people
whereas the other desktops don't
who all had pretty much the same do so to the same degree. With
aim – to kick the Microsoft habit.
this in mind, I have found in the
Sure the other distributions
past couple of years that the ROSA
(distros) had forums and blogs as
and Deepin distros have been
well, but Ubuntu had ignited
coming up with new features for
something a bit extra, and is still
KDE, which, till then, just hadn't
doing so to this day. I have found if materialised. It is great to see
you have a question, ask it! This
some new utilities finally
same kind of support has seen the appearing for KDE which give it a
rise of Raspberry Pi in recent times really nice look and feel. I run the
and as we can see – it works.
Unity Desktop on my notebook, a
With the introduction of
Toshiba P870, 1 7 inch, 1 6 GB RAM
full circle magazine #1 00

job, with all bells and whistles.
Everything, with the exception of
the TV Tuner, works great. The
Toshiba P870 has a Yuan MC782ML
/ PD782S TV Tuner which doesn't
have a Linux driver, and neither
Toshiba nor Yuan have expressed
any interest in fixing that issue.
Unity works well on Ubuntu
though, and the more I use Unity
the more I like it. The one issue: it’s
not as tweakable as KDE, so I will
stick with KDE for my main desktop
PC for the time being.

have not always been easy to
install. For example, my current
printers are a Samsung Laser ML21 65W and an Epson Workforce
7520 All-In-One to do my colour
work and scanning. Samsungs, I
have found, are a good printer, but
the installation of them tends to
be a bit complicated on some
distros whereas Ubuntu seems to
just pick it up and away I go – that
is what I prefer, as I am sure any
user would.

I don't run anything wild, so I
feel my OS of choice should be
My reason for making Ubuntu
my default OS is that I know it will able to provide me with a working
desktop without a lot of issues –
work. It is the one distribution I
have used which operates with all this is what Ubuntu does for me.
My current hardware comprises
my hardware without an issue,
which is more than can be said for the following:
• Asus P2T Deluxe motherboard
most of the other distributions. I
• Intel Core i7 920 at 2.67GHz
am sure I could get most of them
• Kingston RAM 6 GB
to work if I was willing to put in
• AMD Radeon R9 270X Sapphire
hours of fiddling, but, to me, that
seems a waste of time when I know graphics Card
I can get it running immediately by • Dell 27-inch LED monitor
• 4 x Western Digital hard drives (1
simply installing Ubuntu. Users
generally want a PC to use, not to x 1 TB Black, 1 x 2TB Blue, 2 x 1 TB
Green)
have to fix faults all the time.
• Onboard audio
I have had a propensity to buy
printers that, although compatible, • Wacom Graphire 2.0 graphics
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tablet
• Logitech M21 5 wireless mouse
• Logitech K330 wireless keyboard
• Netgear D6300 WiFi DSL
modem/router
• Epson Workforce-7520 Colour
Multifunction Centre (run as
wireless)
• Samsung ML-21 65W laser printer
(run as wireless)
• Lite-On DVD burner
• Matsushita DVD reader

to take out my Ubuntu and get into at work, but have not had the
translating, I joined the testing
this world of Linux and Open
opportunity to hack on them as
team and started contributing to
Source.
they were production servers and I tests.
could only look after them without
fiddling on them.
I first started testing ISO's,
carrying out tests on my laptop,
by Carla Sella
I have tried out quite a number and doing some Kernel smoke
of Linux distributions, and at the
tests; then I was so lucky to have
y name is Carla Sella
end, after trying Ubuntu, I got
the opportunity to get a Panda
(Letozaf_ on IRC) and I am
stuck with it, and could not leave it Board and contribute to Ubuntu
part of the Ubuntu Community and anymore.
Arm testing. I have been to the last
have also the honor to be an
Ubuntu Developer Summit that
Ubuntu Insider.
I also got involved in the
was held in Copenhagen and I had
I still fire up Windows each
Ubuntu Community and discovered the opportunity to get even more
week in my virtual copy of XP
I have always been a Linux
FCM and from there on I have
involved in contributing to Ubuntu
running in Virtualbox in Ubuntu,
enthusiast and have been using
learned a lot using Ubuntu,
testing.
and it all works fine. It annoys me
Linux as the main operating
contributing to Ubuntu, and
that we still have to do this for
system for my desktop PC and
reading FCM and the online
I started contributing to
some of the main Genealogy
notebook since I do not remember documentation.
Autopilot automated tests for the
packages, but, alas, that is the
– as so many years have passed by
Ubuntu Phone Core Apps and
current state of play. In the
already.
What made me stay with
became a Ubuntu Insider, I have
meantime, I utilise Gramps, which
Ubuntu is that it is really a userhad the opportunity to be at the
is an excellent program which does
What I do remember is that I
friendly Linux distribution. Almost Ubuntu Insiders event held in
run in Linux, but it does not, of
started off with Mandrake (that
everything works out of the box
London in February 201 5 for the
course, provide the proprietary
then became Mandriva), must have without much effort by the user,
launch of the first Ubuntu Phone.
connections to the various
been Mandrake 7.1 as I still have
but, as I am a hacker (with “hacker”
software titles that hold a lot of
the original CD's of the favorite
I mean that I like to find out how
What is so great about the
the historic data. Even with this, it Linux magazine I used to read back things work and like to use the
Ubuntu Community is that you can
is not a great hardship, and I do
then.
command-line to do things instead really have fun and learn a lot
not have to dual-boot Windows –
of the user interface), Ubuntu
about Linux while contributing to
which is fine as far as I am
I have learned a lot about the
satisfies both needs, my user and
Ubuntu; the Community members
concerned. All I can say is thank
Linux operating system reading
my “hacker” ones.
are so nice and help you out so
you Microsoft for pushing me to
Linux magazines and practicing a
that you can learn to do awesome
the edge once too often with
lot at home during the evenings
I have started contributing to
things and I am really proud to be
Windows ME and Vista – it was the and weekends. I have also had
Ubuntu doing some translations,
part of it.
straw that caused this little camel Xenix, SCO Unix and Linux servers but, as I got quite bored
full circle magazine #1 00
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It's incredible how you can
contribute to Ubuntu, and have fun
at the same time (with fun, I mean
hack on things and get to learn a
lot about Linux).

I

by Ziwei Zhou

've been using a Linux desktop
for 7 years. My first Linux
desktop was RedFlag Linux, which
is based on Debian and the KDE
DE. It was pre-installed on my
friend's computer, he asked me to
install Windows on it. My first
thought on KDE is "Wow, this is
much more beautiful than my
Windows". Afterwards, I borrowed
the live disc, and tried it at home.
Live disc is a very advanced
technology for me, the idea that I
can take an operating system
anywhere and run it on any
computer thrilled me. I use only
Firefox to surf the web, and use
Amarok to play some music CDs at
home. I didn't install it on my main
computer, since OpenOffice
sucked back then (it was very
common to have it crash while I
was in the middle of my work).
One year later, I got a very old
laptop computer, Pentium 3 CPU,

256MB RAM and a 20GB HDD.
Windows wouldn't run very well on
that computer, just too slow. Linux
immediately pops up in my head; I
searched the Internet for Linux.
Ubuntu was very popular among
the community. I got to know that
Xubuntu is specially designed for a
small footprint. I downloaded a
copy and used my main computer
to burn a CD (I had only a 1 28M
flash drive, CD was a better
choice). Like many others in the
Linux community, it saved my old
laptop; it's extremely fast. I was
amazed. I didn't even need to
install any drivers, everything just
worked out of the box, even my HP
printer.
It's pretty ironic – later I
installed Ubuntu on my new laptop
which has an ATI display card and a
new Wi-Fi module, drivers were a
serious pain in my ass, drivers drive
me crazy. And for this reason, I
only occasionally check Ubuntu
news to see if a solution is
available. My main workstation at
home was still running Windows.
Finally, Ubuntu 1 2.04 solved every
hardware problem I had on my
laptop. I immediately installed it as
my main operating system. I'm very
comfortable working with Ubuntu
1 2.04; I use it to process my lab
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data with Scilab and write reports
with Lyx (a latex GUI frontend). It
never fails me, there are a lot of
great open source tools for
scientific processing, the GUI is
ugly but it works like a charm.
Unity is great, especially for a
1 3-inch laptop, it saves precious
screen space and it's beautiful,
although it’s not as stable as
Gnome and KDE. For this reason I
stayed with Unity for another 2
years, from 1 2.04 to 1 4.04, after I
got a new Thinkpad, again many
problems occurred, unadjustable
brightness, system kept waking
and suspending when the battery
level is low. It's all small problems,
therefore I stuck with 1 4.04 for
another year until 1 5.04. I
upgraded immediately after the
release – it was a disaster, Unity
crashed a lot, and my laptop
wouldn't suspend after I closed the
lid, I tried many ways but didn't get
it to work, and finally I changed my
DE to Gnome 3.x, which is rock
solid. l like the way it manages
windows and workspaces, much
better than Unity, but I don't like
its visual design – the font in the
system tray is gray against black
which is sometimes annoying when
there is sunlight in my room –
making the battery and network
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information and clock hard to
recognize. I changed my theme to
make it better, but it’s still a little
annoying. And the fat window title
bars make my screen look much
smaller. Now I switched to KDE
plasma 5, it’s too buggy, but
convenient indeed: KDE Connect,
for example, works perfectly with
my Android phone: sharing
clipboard, files, messages and
notifications. I can now mute my
phone while working on the
computer, without bothering to
reach for it, very convenient.
Activities, Dashboard, small
widgets, all very convenient, it’s
very hard to leave it. Now KDE
Plasma is getting much more
stable as development continues,
it’s a little old style, but I love it.
By the way, I don't hate
Windows, but switching back to it
now is painful, everything is
unadjustable, it can easily become
slow if software is not properly
selected.
I love to use the Linux desktop
because of its possibilities: the
possibility to learn how my
computer works, the possibility to
have full control over my
computer.
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Many people thought the Linux following popped into my mailbox:
desktop can never (at least not
Patrick J. Volkerding
easily) overtake Windows or OSX. I From:
(bf703@cleveland.Freenet.Edu)
think it’s not its purpose to
Subject: ANNOUNCE:
Slackware Linux 1.00
overtake or substitute, it’s like a
Newsgroups: comp.os.linux
large experiment. Open source
Date: 1993-07-16 17:21:20
software makes it a lot easier to
PST
innovate, many people and
Slackware Linux
communities are trying to redesign The
distribution (v. 1.00) is now
and experiment with the desktop: available for anonymous FTP.
Unity, Gnome, KDE, and Deepin OS This is a complete
system designed
in China, some features have been installation
for systems with a 3.5" boot
floppy. It has been tested
adopted by Windows, like virtual
with a 386/IDE
desktops on Windows 1 0 and OSX. extensively
system.” [snip]
That should be the purpose:
innovate, not substitute.
I remember seeing this and
struggling to contain my
Though I like Linux a lot, I won't excitement as I laboriously FTP’d
recommend it to others, especially down the 1 3 disk images needed
those who use their computer as
to run the base (non-graphical)
productivity tool or recreation. It's system over a 9600 bps X.25 link.
only for those who are interested
The horrible speed of this line was
in computers and software, who
exacerbated by the fact that the
want to learn about it.
UART on the Siemens gateway box
we were using was a piece of junk
so we were lucky to see more than
2400 most of the time.
by Jack Knight
We had some new prototype
worked for Siemens R&D (later 386 and 486 desktop boxes just
becoming Siemens Nixdorf),
arrived from Germany, and I
from 1 989 to 1 995 as a Sysadmin
desperately wanted to see if I
and Systems Specialist. I’d been
could use one as a better gateway
following the buzz about Linux
box. At the time we had NS32000
since that famous post from Linus, processor based hardware running
and one day, lo and behold, the
full circle magazine #1 00
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Sinix 5.2. It was a weird kind of
hybrid OS which could emulate the
behaviour of SVR3 and BSD Unix
(with varying degrees of success).

servers, mail gateways and CERN
httpd servers among other odd
things. The pace of change was
simply astonishing.

I spent some time running
through the install disks (though
mercifully less than the horrors to
come with SCO Xenix - 52 disks,
and it randomly failed on the 51 st),
and unbelievably, up it came. I had
a nice new shiny Linux OS, and it
smelt like a proper Unix, not the
odd stuff we were used to. I was
absolutely awestruck.

By this time, many of our
competitors like IBM, ICL, etc, had
their own websites and I invited
someone from marketing down to
look at what we were doing and to
ask for ideas about content for a
website of our own. I patiently
walked through the various
offerings from the other
companies, and after 1 0 minutes
was cut short with “Hmm yes, very
interesting, I’ll be in touch.”. I
never heard from them again.
Shortly afterwards I left to turn
Freelance, and remained so for 1 7
years.

It turned out to be relatively
easy to get the thing running a
dialup link with a recently arrived
trailblazer modem (1 4.4Kb, bliss!!!)
- anyone remember those? (Gord
says, “I had one!”). All of a sudden I
wasn’t getting almost daily
complaints from our upstream
usenet news provider that the
spool disks were full, as we weren’t
pulling news fast enough.
Some months later, we
managed to (oh joy of joys) get a
fixed line hooked up to UKC and
now had a whopping 64Kb. Given
what we were used to, this was
bliss, and we now had several 486
Linux desktops in the DCs running
as Socks Proxying firewalls, DNS
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Another of my enduring
memories is this. We used an
internal usenet newsgroup to
publish minutes of our internal
meetings. Unfortunately, a quality
manager managed to post the
minutes to a uk wide group (I
forget which one now), and I
received a great email from the
upstream news admin (a certain
Andrew McPherson IIRC) saying
something like this:
“Ifyou really must publish details
contents ^
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booksellers, the Sinclair came with
all of 1 KB (yes, 1 KB) of RAM. A 1 6K
memory expansion pack, and a
thermal printer using rolls of 4inch wide aluminized paper cost
me more. You plugged in a
separate power supply and hooked
by Paul Romano
it up to your TV as a display in
he first time I saw a computer black & white only, no colour. The
operating system as such was a
was in the early 1 970s when I
form of ROM-contained BASIC and
was sent to visit Burroughs, a
everything you did on the Sinclair
mainframe manufacturer at
Southend-on-Sea. I can't remember was done in BASIC. Graphics were
only character-based. There were
anything about the mainframe
except the white coats, over-shoes no hard or floppy drives. Programs
and data were loaded from and
and hair-nets we had to wear to
stored on audio compact-cassette
enter the climate-controlled
facility. Around 1 980 in the office, I tapes. You could also buy prerecorded tapes of games and
started playing around with an
simple applications. The only form
Apple IIe, using a form of BASIC,
of downloading was by recording
but didn't get very far. I was
travelling overseas frequently for onto tape audio tones transmitted
during computer programmes
work, sometimes for extended
broadcast on TV. I still have the
periods, and my access to the
ZX81 today, in full working order.
Apple was very infrequent.
ofyour internal meetings to your
competitors, wouldyou mind
explaining the acronyms?”

T

In 1 981 when it seemed all
programmers were teenagers
working in their bedrooms, I finally
bought my first computer, a
Sinclair ZX-81 . For those who don't
go so far back in time, this was one
of the first successful home
computers, also sold in the US as a
Timex 1 000. Costing £50 via mail
order, or from WH Smith

didn't have a PC. To save time and
effort, I soon started to venture
beyond the mainframe process
My experience with PCs at work sheet application and learned a
was all Microsoft based. It began in few commands to manipulate files
and the database. I didn't realise
1 987 when our office was
until long after that this had been
computerized. I was given the
my first taste of Unix, on the local
additional function of the local
IBM mainframe.
office system administrator.
Starting with a Wang 286, I have
Meanwhile, at home, I had
used MS-DOS 3.2 upwards, and all
upgraded first to a 486 DX2 and
Windows from version 1 to 7,
except Vista. I have never used Win then a Pentium. Operating systems
followed the usual Microsoft path.
8 and have no intention of using
I first started using the Internet
Win 1 0.
with a local system called Beltel,
similar to Prestel in the UK. This let
In 1 990 I emigrated from
me connect to bulletin boards and
England to South Africa. I was
send email (using X25 or X400
advised that computers in South
Africa were expensive, so before I protocol then, I think). My first
left I bought my first proper PC, a dial-up modem connected at all of
Viglen 386. Once again, I paid extra 4800 bps. The World Wide Web
soon followed, and I changed from
for the optional VGA display, 3½”
Beltel to one of the local ISPs that
floppy drive and a 40 MB hard
sprang up. Dial-up connectivity at
drive. All that cost me around
slow modem speeds was not fun
£2,000, about a month's salary. I
I learned how to program in
only had time to switch it on once and very expensive. Surfing was
BASIC by copying printed program before I had to repack it and
done very carefully. Email was
listings each month from a
more my priority, to stay in contact
everything else for the move to
magazine. It was amazing how
with family and friends back in the
South Africa.
much you could do with just 1 6K or
UK.
even 1 K of RAM. A few modern
The computing part of my initial
programmers should learn to be so job was creating and editing
Retiring on a fixed income in
efficient. Later on, I used a lot of
2009, I had to be very careful what
process instruction sheets for
DOS batch files, learned to
vehicle assembly workers. This was I spent my money on. ADSL was
program in C, and am now learning done on a mainframe terminal; I
too expensive, and until recently,
full circle magazine #1 00
75
contents ^
Python mainly from the Full Circle
series.

MY STORY

slow – compared to speeds
available in the UK and other
developed countries. There is no
cable TV or Internet either. It was
201 0 before I finally upgraded to a
broadband connection, using a 3G
cellular USB modem. It was
prepaid with 1 2 monthly data
bundles of only 1 00MB each
month. After that ran out, I had to
buy prepaid data bundles. Using
Opera as a browser with its
compression technology helps a
lot, but Firefox is my preferred
browser.

full-time. An early Live-CD of
Knoppix did come in handy though
to repair Windows boxes several
times. Whilst writing this article, I
went back through all these discs
and found I had copies of both the
original Ubuntu 4.1 0 (Warty
Warthog) and 6.06 (Dapper Drake).
I burned these to CDs and tried
them out. How I wish now that I
had tried them out back in 2005/6.
I would have switched to
Linux/Ubuntu much sooner.

In May 2000, the publishers of
PCPlus bought out a sister
magazine that I'm sure many
Before I left England, I
readers will know, Linux Format. I
subscribed to a magazine called
bought the first 6 issues, tried out
PCPlus. This was quite technical
the distros on the cover discs
and I learned much from it (and
(Storm, SuSE 7 & Corel), but was
from Full Circle, of course). I
believe it was the first magazine to not impressed enough to start
have cover-mounted disks. I have a using them. I tried again in 2008
with CentOS 5.2, but I still wasn't
large collection of these ranging
ready for Linux. At the end of
from 5¼” floppies through 3½”
floppies and CDs to DVDs. PCPlus 201 3, with the impending demise
of XP, I was reading a lot of
is no longer published and sadly
missed. On a return visit to the UK ebooks, mainly from Project
Gutenberg. But every time I saved
in 1 995, I bought copies of all the
them I was being plagued by
then current PC magazines and
multiple spurious advertising links
decided to subscribe to PCPlus
in the text despite having up-toagain. Soon afterwards it started
covering Linux with the first Linux date virus and anti-malware
software. I came across Linux
disc (SuSE 5.2) in October 1 998. I
Format again in the local
tried various distros but I wasn't
booksellers, soon found Ubuntu
comfortable enough to use any
full circle magazine #1 00

1 3.1 0 and was hooked.
I still have a Pentium 4 box with
two 40GB hard drives that multiboots 1 1 different operating
systems. On one drive is Linux Mint
1 6 and SolydX sharing a common
swap partition. On the other hard
drive are Windows versions 1 , 286,
386, 3.0, Windows for Workgroups
3.1 1 , 95, 98SE, 2000 and FreeDOS.
A very academic exercise, but fun
to set-up. I used Ranish Partition
Manager which can create up to 32
primary partitions on a drive,
swapping any combination of 4 in
and out of the partition table in
the MBR sector as required.
The specs of my current box, a
Celeron, are not worth mentioning.
I run Ubuntu 1 4.04 LTS as my prime
system, but this is a remix with
multiple desktop environments
available. On a second drive is
WinXP, and on a third drive I have
my Linux From Scratch project plus
two other distros that I am
evaluating. These vary each month
but are currently Ubuntu 1 5.04 and
Netrunner 1 5. I am happy using the
Unity desktop except for the
window controls being on the
wrong side. I tried using the Tweak
Tool to change them but that
didn't work. However, generally
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speaking, I have always gravitated
back to the distros using KDE.
My finances have improved
recently, so at last I can look
forward to buying a new laptop,
installing some form of Ubuntu on
it, and getting a cellular contract
with a decent amount of data each
month. I also want to set up a
home network, using one machine
as a multimedia server.

I

by Fernando Diaz de la Serna

've been using Ubuntu for the
last eight years. My first
encounter with Ubuntu was
entirely fortuitous and triggered
by mere curiosity. I had vaguely
heard about Linux, but I knew
nothing more about it than the
name. One day, eight years ago, I
read in some newsletter on
computing that there was an
operating system called Ubuntu
and another one called Suse, but it
cautioned that the latter was more
difficult to use. I clicked the link for
Ubuntu and ordered the
installation disk from Canonical.
Little did I know that this simple
act of curiosity to try a new
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MY STORY

operating system was going to
change my life for good.
Previous to that momentous
day when I ordered Ubuntu from
Canonical, I had been using
Windows for the previous fifteen
years. It was like navigating to
survive in a tempestuous sea of
uncertainty and havoc: the
torments of hell in the Divine
Comedy right here on earth.
Crashes, freezes, viruses, conflicts,
reinstalling the entire OS time
after time: it lacked none of these
rough experiences on a regular
basis. I wasted so much time and
money making Windows help me
through my job in my bookstore
where I had fifteen computers. I
will not dwell further on more
details as I fear my discourse might
turn acrid and morbid.
As expected, one day my copy
of Ubuntu arrived in the mail. I set
it apart for some days on some
corner of my desk as if I had
decided to keep this new beast in
quarantine before approaching it
for serious use.

intuitive. It was if I had been struck
by a bolt of enlightenment. I knew
that was what I had always wanted
and needed.
The one disturbance I
encountered was due more to my
utter naivety and ignorance than
to Ubuntu itself. I had taken for
granted that all OS's had to have
scandisk, defrag and an antivirus as
Windows does. So, for a whole
week, I sweated trying to find
those in Ubuntu. It wasn't until I
spoke on the phone with someone
who had some vague knowledge of
Ubuntu that he told me that such
things did not exist in the Linux
ecosystem and that viruses were
indeed very rare.
Weeks and months went by
after my precious discovery,
accompanied by abundant reading
in the Internet and juicy tutorials
which led me to find lots of
tweaks, nooks, and a multitude of
must have programs in Ubuntu. In
short, to delve more deeply into
my new OS in order to get the
most out of it.

After some days of pondering, I
I could not stop talking about
installed it alongside Windows and Ubuntu to everybody I knew even
it all went smoothly. I began to use to the extent of becoming a bore
it and it all seemed so easy and
at times, but I was thrilled with my
full circle magazine #1 00

experience with Ubuntu. I had
found deliverance from Windows,
and, after the following release of
Ubuntu, I used the entire disc for
Ubuntu, never to use Windows
again.

I want to quote Harley Hahn. He
gives a wonderful explanation why
the OS you use determines your
very life and way of thinking and
acting:

I find it inevitable to mention
proprietary software again. One
can define something by
comparing it to something else.
When one uses proprietary
software, one becomes a client,
like many other anonymous
customers of the company that
produces that software. One
becomes the subject of an
impersonal commercial
transaction. On the other hand,
when one uses Ubuntu, one
becomes part of an active
community. One has a strong
sense that one belongs to a group
that gives one some warmth of
humanity. This makes an enormous
difference in how to approach
one’s daily activity when using a
computer. One is free to choose
what to use and how to use it, and
one is not bound to any conditions
and restrictions imposed by any
software company. This is like
being born again, a gasp of fresh
and revitalizing air. No
exaggeration!

He continues to add that in this
sense, Unix and its offspring Linux,
are, without a doubt, the best
computer systems ever invented.
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“Your computer is not a lifeless
piece ofmachinery. It is a dynamic
tool that interacts with your very
thought processes. Whenever you
use a computer, it becomes an
extension ofyour mind. This means
that over an extendedperiodof
time, the computer system you use
changes how you think. Indeed, we
might classify systems as mentally
'good'or 'bad'depending on how
they affect the minds oftheir users.”

During all these years, I have
rescued several people who had
conflicting computers by helping
them install Ubuntu in their
machines. I always told them that
as they were given, they should
also give by helping other people
to install Ubuntu in their ailing
machines. Those simple principles
build a community like Ubuntu.
I must confess that I had a
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tantrum when the Unity desktop
was substituted for Gnome. Many
others did too, because we
humans are creatures who accept
changes very badly. Eventually I
got used to Unity and continue to
use it happily. With the recent
appearance of Ubuntu Mate, I had
the chance of using the Gnome
desktop again in one of my
computers. It was great and
nostalgic to see the good old
desktop revived. It brought back so
many good memories of the time I
first encountered Ubuntu. The
good old desktop we all learned to
love!
I lack words and literary
resources to fully express my joy
and gratitude to all those people
who have made Ubuntu and Open
Source software in general. They
have helped millions of people in a
world that is always expecting a
profit or a return for everything.
Let's celebrate this amazing
exception in this dehumanized
world of ours.
A word of thanks to Ronnie and
to all those who have participated
with articles for giving us Full
Circle Magazine. Congratulations
on the appearance of its
hundredth issue: a worthy and

generous feat indeed!

maintenance a week.

I do not recall how and when,
but one day I must have
downloaded Ubuntu 08.04 and put
by René van der Zaag
it on a CD. I ran it on the desktop
and was excited about it. It looked
n 2004 my wife and I bought a
good; it was fast; it had all the
desktop with Windows XP
software I wanted pre-installed,
installed on it. Almost every
and it was free and open source.
Saturday I spent an hour or so to
Therefore I decided to install it on
clean the system, install updates,
the desktop alongside Windows
scan for viruses and so on, in order XP. The only problem that I had
to keep the desktop fast and
was sound, but I managed to solve
secure. In 2008 I started my own
that problem thanks to the vast
company. I bought a laptop with
community. Ubuntu was faster
Vista installed on it.
than XP and I did not have to
spend hours on Saturday to
The desktop was getting slower maintain the computer.
and slower. The laptop did not
have a proper e-mail program
So after a few months, I took a
(Windows mail), nor Word and
bold decision. I wiped XP and made
Excel. So I found out about
the desktop computer an Ubuntu
Thunderbird and OpenOffice and
computer. The desktop was for
installed them. In fact I discovered common use, so my wife had to
the world of open source software. work with it as well. She is not a
computer enthusiast, but she had
Vista was a disaster. It crashed
no problem working with Ubuntu.
now and then, it needed a lot of
maintenance and became slower
When I was convinced Ubuntu
and slower. It took ages to boot
worked flawlessly, I also installed
and ages to close – because of all
Ubuntu on my laptop for work
the updates that had to be
alongside Vista. It was the best
installed. I hated Vista. Together
business decision I ever made.
with the desktop I spent more than Again I did not have to spend hours
two hours of computer
in maintaining my laptop. It
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became even better with Ubuntu
One. Thanks to Ubuntu One, I did
not have to make a backup any
more. It even saved me one day,
when I accidentally poured coffee
over my laptop. The laptop was
dead, but my data was still alive. It
was a sad day for me when
Canonical decided to drop Ubuntu
One. So now I run my backup
worry-free through SpiderOak.
We now run Ubuntu 1 4.04 on
every computer. Only one
computer has dual-boot with
Windows 7, but we never use it. I
like Ubuntu because it is fast,
secure and reliable. I now spend
my time working and doing nice
things instead of maintaining
computers. For work, the Unity
shell is very productive. My laptop
boots in 1 1 seconds (with SSD) and
closes in just a few seconds
without having to wait for an
update to install. I am very
satisfied with Ubuntu. Therefore
every year I donate a few dollars to
Canonical, because they provide
me with an operating system that I
am willing to pay for.
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By Gary White

OK – no Internet, how about
printing. Oops! more mystical
ith the call for stories for
powers needed. Now, I had only
the 1 00th edition of Full
one computer to use back then;
Circle Magazine, it got me thinking they were very expensive. Shut
about my personal computing
everything down and plug the
experience from so many years
other hard drive back in, enter
past and how I came to Ubuntu.
BIOS and change hard drive
parameters, boot into Windows,
A brief history about myself. My fire up the dial-up connection, and
first “real” computer was a 486
see what programs were available
DX2 with a 200 MHz Cyrix
to use on my new Linux install.
processor, 500 megabyte hard
drive, 2 disk drives (5¼ and 3½), all
What a confusing mess. You use
running under Windows 3.1 1 for
something called Yum, and
Workgroups. No modem, didn't
building packages, and on and on.
need one. Never heard of the
Information was geared for people
Internet.
way smarter than me, and
questions fell on deaf ears.
My first attempts in the land of Needless to say the Linux drive
Linux failed miserably. I spent
was formatted and re-purposed.
hours tieing up the telephone line
downloading Fedora core
Fast-forward in time a little, and
something, I believe on a 56k dial- while at a local computer show, I
up modem, burning it to CDs, then was given a CD with Ubuntu on it.
installing it on a sacrificial hard
This time, some research was in
drive.
order before I went back down
that road. By now I had a spare
Once it was installed, I thought, computer to work with, and even
OK now what do I do with it. High
though I still didn't have high
speed Internet was not available in speed Internet, I did have
our community then. Winmodems instructions to get a US Robotics
were the defacto standard and
modem on a serial port connection
trying to get one of those to work to get online. Before long, I was up
in Linux took mystical powers, of
and running. It was new and
which I did not possess.
full circle magazine #1 00
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different. I liked it! No antivirus
software to buy, the operating
system was free and stocked with
real programs, but, most
importantly, there are people
online who were in the same boat
as myself.
Still, I was left wanting. I just
couldn't do what I could do in
Windows. I was into games and
video cards, printing was still
problematic, and I just didn't want
to take the time to learn a new
operating system in depth. A little
more fast-forward, and I'm now
running Windows XP, and
Microsoft announces Vista. I've
grown tired of the whole circle of
life thing that one must go
through to upgrade Windows. It
wasn't just the cost of the
operating system, but the yearly
subscription for anti-virus and
malware, and Vista was causing all
kinds of trouble with older printers
and scanners. Enough was enough.
I set out to build a new
computer with Ubuntu Linux in
mind. The Ubuntu community had
grown, and I felt confident that I
could make this work. I researched
parts, printers, and programs that I
needed to convert. After building
the new system, I installed
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Windows XP and set up dualbooting with Ubuntu. Good thing,
too, because I broke my Ubuntu
install several times with video
driver problems. Slowly I adjusted
and when my anti-virus
subscription ran out, I reformatted
the drive and went full-on Ubuntu.
Life was good. Then they changed
it. What’s this Unity thing? What
happened to my desktop? Did they
find out I was happy and changed
it just to mess with me? Where are
my menus!
When you grow up in the
Windows environment, life is all
about the mouse. That’s the way
Ubuntu was before Unity. Once
logged in, you could practically
toss the keyboard and do
everything with the mouse short
of typing. (I stayed away from the
command-line back then. I was on
to them. I knew it was put there
for people like me to screw things
up with)
You could still mouse your way
around, but it seemed so difficult. I
stuck with it though. Unity was
fresh and new, and after giving it
time, I wouldn't go back. When
others saw my desktop, questions
were asked. How quickly I could
open programs and switch
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between them. The mouse was
jealous. Friends may have been,
but wouldn't say. All is not perfect.
It never is – regardless of what
operating system you have on your
machine. You pick your battles and
with all the other battles we face
in life, why let your operating
systems cause you more.

for.

that suggested that I just spend a
few minutes on Unity. I tried what
With the help of my youngest
was shown and, in about three or
son, who was 1 5 years old at the
four minutes, I was hooked. I
time, I was able to boot Red Hat or
installed Precise and used it until
another operating system. I tried
Then Ubuntu appeared.
Trusty appeared. I had decided by
to do everything with Red Hat that Somebody gave me a copy. My first then to use the long-termI had done before, but I just did not try-out was disappointing.
supported versions to avoid sixunderstand Linux.
Graphics were the stumbling block. monthly upgrades.
I spent hours fiddling around with
If you are reading this, then you
As time passed, I learned how
settings and Googling for
So now I am still using Trusty.
probably already understand, but to make my own installation disk. I information. It felt like I was stuck Most of the software that I use
if you haven't tried Linux yet, then downloaded Debian and burned it in the doldrums with no hope of
now is from the Ubuntu
you owe it to yourself to do so.
to a CD and tried installation once escape.
repositories with two exceptions.
There are many good people in the again. Although I was learning,
Two of my favourite programs
Linux community who are willing
there were still gaps in my
I grabbed every new version of were written for the other
to help, and online information is
understanding.
Ubuntu and installed it after first
operating system. I now run them
abundant. Linux has matured so
trying it out live. That made me
under WINE. One of them needs
much that the pains I experienced
Then a turning-point came. My more confident. Also, Ubuntu was access to the serial port, and I
are largely a thing of the past with other operating system did a
improving from version to version. learned how to make that work
most of the mainline distributions. “checkdisk” without my
By the time Hardy Heron was
after much Googling and mistakes.
permission, destroying about 4 Gig released, I was quite happy to
I have also learned how to use
of my installation. By using Debian, install a new version with minimal LaTeX, just to name another
I was able to recover the files that fuss. I hung on to Hardy long after enjoyable experience.
were most valuable, so I lost
its support ended. I enjoyed it so
nothing important. I decided that
much that it was a wrench when I
So, anybody reading this, might
by Victor Moisey
the other operating system had to finally replaced it with another
wonder why I changed to Ubuntu
go. I was also uncomfortable with version. I also hung on to Maverick instead of staying with the other
y first encounter with
using “pirated” software.
Meercat for two years after its
operating system. My answer: “It
Ubuntu was in 2004 when
support ended. I could not
was the price that convinced me.”
the first version was released. In
I re-formatted my hard drive,
understand Unity, so I hung on to
1 999, a colleague told me the story installed Debian and that was
Maverick because it was working
of Linux and free software. He also where all my problems really
so well – and changing the desktop
gave me a Red Hat CD with a
started. Linux was still new to me. I just did not work for me.
manual. I just had to try it out. I did was reduced to typing documents
not know what I had let myself in
and surfing the internet. All the
Then, I came across a website
full circle magazine #1 00
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games and my favourite
development tools were gone. I
refused to reconsider. I was in it
now, so it was sink or swim.

MY STORY
by Ali Moradi

W

hen I first started using
Ubuntu, it was kind of
different from the previously used
OS, which for me was Windows. It
was shocking to see the many uses
of Terminal, which to me at first
was just a bunch of texts, because
before that I came from a GUI
world that Windows had created
for me.

then I realized there is a much
better world named “Open
Source”. At first, it shocked me,
because I couldn’t understand why
someone make such good
programs, which are better than
even the paid ones, and share
them freely with the whole world!
And the best part is that other
people can see the code, and
modify and improve the program,
and help the programmer too! And
as the old saying goes: “two heads
are better that one”, from which I
want to draw points of analogy
between that saying and Open
Source, because of the
cooperation.

Then I started to read many
tutorial posts on the internet to
get the hang of Ubuntu, which was
great, and got me up to speed
soon. After that I started to
explore more nice features of
Terminal. It takes one to be cruel
to admit, but Ubuntu’s Terminal is
much better than that of Windows,
named PowerShell, which I wasn’t
by Jan Greef
comfortable with, especially
because of the stupid character
y Ubuntu experience started
“\”, which made me hit the roof
by accident, about 8 years
because it isn’t on the best place
ago, after I had my baptism of fire
of my keyboard to be easily
in computers a few years
accessible.
previously, at the age of 60.
For me, Ubuntu, aside from the
While in search of a wordadvantages, made me see the
world differently, because before processing application, I resisted
the high cost of Microsoft Office. A
that I was just using paid
relative suggested that I should
applications on my Windows, but
investigate OpenOffice. Being
full circle magazine #1 00
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somewhat recklessly impulsive by
nature, I ended up installing
Ubuntu on my desktop. I cannot
recall exactly how it happened,
except to say that I stumbled upon
Ubuntu via Google, saw that it
included OpenOffice and thought
that was what my relative had in
mind.
Initially, I turned to a more
computer-literate friend for help,
but he was even more ignorant
about this new operating system
than me. This resulted in the loss
of my address-book and e-mails,
but I survived. The new operating
system tickled my fancy and quite
soon everything that I needed at
the time was running quite
smoothly.
In due course, I discovered
various Linux communities where I
found help and discovered a new
world containing an endless pool
of friendly Ubuntu enthusiasts, all
only too eager to assist wherever
possible. I also discovered that I
was no longer picking up viruses
that used to mess up my system
and had led to loss of data on a
few occasions.
One of the few drawbacks has
been the fact that my genealogy
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program, Legacy, does not run on
Linux. I did not relish the idea of
learning how to operate a new
system like Gramps, so after some
very frustrating efforts trying to
get things to work via Wine, I
eventually discovered Oracle
Virtualbox where I have been
handling my genealogy almost
seamlessly, using Windows XP.
Over the past three years, I
have introduced a number of
friends ranging in age from 63 to
81 , to Ubuntu. All of them are
happily pottering with their free
operating system, going their
virus-free way.
The last friend that I helped to
migrate to Ubuntu, had an old
laptop and a slightly more recent
pad. Someone suggested that I
should install Mint for him. After
some extensive research, assisted
by a number of very accomplished
Ubuntu geeks, and after letting
him try Mint, Xubuntu and Ubuntu,
we agreed to settle on Ubuntu
1 4.04 LTS 32-bit. He spent a week
with me while we installed the
systems and introduced him to the
basics. He is very happy about the
result and impressed by what
Ubuntu has to offer.
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If I was not already hooked on
Ubuntu for life, my latest
experience clinched the deal. One
of my newly acquired Internet
friends, whom I had never met in
person, told me that a member of
the Ubuntu SA community, whom I
do not know from a bar of soap,
had informed him that my ADSL
router was accessible to anybody
on the Internet. My friend
introduced me to this friendly
benefactor, who spent quite a bit
of time assisting me to download
software upgrades. He then
helped me to install the software
on my router. Thanks to him, my
router is now safe and secure.
I challenge anybody who is
using paid-for operating systems
to relate a similar experience,
where a total stranger informs you
of a vulnerability on your system,
and spends hours of his valuable
time to guide you to a more secure
environment, without even
considering any form of
compensation.
Viva Ubuntu! Viva Linux! A true
community in the finest tradition.

by Bill Berninghausen

Along the way I've discovered
that other distros have their
orking in the Air Force
charms, particularly PCLinuxOS,
supply system in the 80's
and that Ubuntu was veering off
and 90's, I was a participant/victim into bad things, like Unity and
of the development of workplace
Gnome 3. Mate and Cinnamon
PC's. When I started, work was
revive the familiar top/bottom
accomplished with hand-coded
panel, with workspace cells, so I'm
inputs delivered to a keypunch
happy. I've reborn many old boxes,
operator, processed as a deck of
particularly petrified XP survivors,
honest-to-pete punched cards, and and donated them with one or
waiting for a batch printer to
another distro, according to their
deliver output of 1 32-column
hardware capability. I keep in
multipart listings. There had been touch with Windows, eagerly
no real changes since I did my first awaiting Win1 0 next week, but
program in FORTRAN in the 60's.
none of my important family
photo/finance/music business sees
Cobbling together a PC was a
anything but Linux. Predominantly
real chore in the 90's, but Windows one of the *buntus, of course.
98 was included, and we were
Windows is cheaper than a console
introduced to the Blue Screen of
and useful for gaming and other
Death. Something called Linux
kid stuff. Like the big mainframes,
surfaced, but I didn't pay much
when I want important work to be
attention until my machine
done right now, I lean on Linux.
bricked. Lights went on, drives
spun, but the screen said NO OS
PRESENT, or some other useless
error message. But the CD
included in one of the magazines
loaded, and off we went! I think
the first distro I tried was
by Todd Winters
Mandrake, but before long I found
Ubuntu, liked the ethos and the
s a high school computer
implementation, and it's been
teacher, I was introduced to
there ever since, in one form or
Ubuntu by one of my students.
another.
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That was over ten years ago, and
open source software has been a
big part of my life ever since. I wish
I could say that I have left the
Microsoft OS behind, but I still use
it on one of my machines for
iTunes and Picasa. The computer I
am writing this on is running Linux
Lite 2.4 and it is a delightful
operating system.
I have looked forward to every
issue of FCM, and will continue to
do so. It is informative, funny,
instructive, and just very useful.
Many of the articles are not
applicable to me, but I always find
something interesting and
thought-provoking. I appreciate
the work that goes into it and feel
guilty that I have not contributed a
story to it. I particularly enjoy
learning about the history of other
users and how they came to
Ubuntu.
I wish FCM success with the
next 1 00 issues. I will be sure to
read each one.

A
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U

buntu has been serving me
very well for a very long time.
With Microsoft taking over all it
can under its wings, Microsoft has
become a big giant. And, the
bigger the giant, the more power it
will have, resulting in a form of a
dictatorship. That is why I will keep
away from Windows 1 0. How long
will Windows 1 0 be "free" in
reality? Microsoft is not a
charitable institution and, at some
point in the future, users may have
to start paying for the service. The
"Giant" is in control!!!
On the other hand, thanks to
the open-source community,
UBUNTU has always been free and
UBUNTU will always be free.
There is also the "Peace of
Mind" that one does not have to
use a virus checker routinely on a
Linux machine. Viruses are more
common on Windows!

by Peter Schelleman

O

n September 1 2005, I retired
as CIO of Utrecht University,
the Netherlands. Having time to
spare, I decided to delve into the
Linux world, having been a
Microsoft adept for most of my
working years.
The learning curve of Debian
proved rather steep for a novice,
and I soon switched to Ubuntu,
then still in its Gnome years.
However, my trusty Acer laptop
could not produce sound out of
the box. Googling turned up a fix
and this worked well for a couple
of years. After a new kernel
version, no sound and no fix.
Reinstalling Windows XP proved
that the sound card was not faulty.
A switch to Windows 7 produced a
snail-like machine, while Ubuntu
and its derivatives ran beautifully,
without sound, however. I tried
myriad distros, but no luck. Advice
on the web often led to crashes
and corrupted installations. I then
decided to install Ubuntu with the
new Unity dash on an older
desktop. It ran ok, sound and all;
but maintaining two desktop
installations (Ubuntu and Windows
8.1 ) next to a sluggish MS W7
laptop proved too bothersome.
full circle magazine #1 00

Moreover, I disliked Unity, being
too different from the “normal”
(?!) way of things, and switched my
laptop to Linux Mint, which was
then in its ascendancy. Again no
sound, of course. Then I got bitten
by the non-PAE kernel problem in
newer distros. It turned out that
my laptop had one of these
Pentium-M processors which
contain a bug. They do have PAE
facilities, but somehow it is turned
off by default. However, a
workaround existed! Soundly
saved, but still no sound. I
continued testing distros but
things did not improve on the
sound side. Then suddenly, half a
year ago, Ubuntu Utopic Unicorn
brought light, or rather sound to
the laptop! And the Mint version
worked well too.
At last! Then the laptop died. A
new laptop ran into UEFI problems
with Mint 1 7.1 , but I got saved by
Ubuntu in Vivid Velvet (joke, of
course vervet, but I had to look up
vervet – where do they get these
names, one wonders). Mint 1 7.2
seems to have solved the UEFI
problems, but I have not fully
tested it.

to Windows 1 0; my new laptop to a
double installation, both W1 0 and
Ubuntu. I will see how it will run.
Through the years I gained a
better insight in Linux by trial and
error, but most of all by perusing
trade journals (FCM of course) and
websites (Ubuntu, to name one).
I love Ubuntu until it crashes
again, mostly by my own tinkering,
I admit. I love-hate Ubuntu for the
6-month release cycle, because I
cannot stay away from a new
install, even though I know that
not many improvements will be
implemented, while new issues will
crop up.
However, time is on my side and
new distros keep me on my toes.
Therefore a toast to Ubuntu and
FCM; there are worse ways of
spending one’s time.

I

by Geoff Wade

started using my first computer
in the 80's it was a 486 series.
Very good for the day.

Where to go from here? My
For many years, I used MS
main desktop will be switched over Windows until one day I found a
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copy of Mandrake. This gave me
the first introduction to Linux.
With Mandrake not running the
programs I needed, Linux went on
the back burner until the end of
the Windows 95 series.
Around the end of Win 95, I
started using both windows and
Linux (Suse and Fedora), this gave
me the second introduction to
Linux, from which I have never
recovered. I now use solely Linux,
mainly Ubuntu and Mint, but have
a weakness of installing various
distributions on my second
computer to try them out and
check the software. Ubuntu 1 4.04
and Mint 1 7.1 are my permanent
desktop systems at the moment.

I

by Leenie Gilmore

was listening to Kim Komando
one evening. A man called and
said his wife's computer was
running Windows 98 and he
wanted to get online with it. Kim
said to try Xubuntu and do not use
Windows 98. This is where it all
began for me.

There is nothing I need which
Linux can not give me (including
FCM).

I was trying to save old PCs
from the landfill and looking for
alternatives. I found wattOS in
201 0 on Distrowatch.com. LOVE
IT!!! There are always a few hiccups
with Ubuntu of any kind, but once
you learn, it's a breeze. Ubuntu has
improved so much that you don't
have to work so hard to get that
wireless internet connection, or
get that graphics card to work, or
even get printers to work. The
Ubuntu forums are full of answers
to all questions.

I have introduced my wife and
several friends to Linux and they
have no wish to pursue Microsoft.
My son and daughter still use
Microsoft and Apple for what they
need, but could start to lean
towards Linux.

This is from a complete newbie
who knew nothing but Windows. If
I can do it, anyone can. I have
learned enough to help on the
wattOS forum as moderator:
planetwatt.com/newforum/ See
you there!
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by Robert Streeter

started using Ubuntu since the
4.1 0 release when it used the
GNOME2 desktop environment. I
was in college and was tired of all
the everyday MS Windows errors,
and all the software that had to be
paid for to do a simple task and
cost a small fortune.
So I was on my way to an Info
Tech class and noticed a classmate
was using something that looked
different and didn't seem to be
Windows, so I asked him what he
was using. He said it was Linspire.
After an online search I found out
that it was a paid Linux
distribution. I then asked him if he
knew how I would be able to get a
copy of that operating system and
he told me that I might like this
other operating system that he
used at home – it was called
Ubuntu, so I searched for it online
and it said I could try it without
installing it.

effects and customized the UI
theme to my liking.
I gladly upgraded my system
every 6 months to have the latest
and greatest. I was on 1 0.1 0 when
the Unity Desktop Environment
was just a fledgling, and thought it
was going to be a netbook based
version of Ubuntu, but when the
1 1 .04 release was announced and
Unity was to be the defacto
desktop environment, I was
sceptical of that upgrade, I tried it
out for almost a month but did not
like the switch – it was too much
change too soon.
So I stayed with 1 0.1 0. Even
though it was unsupported, I
stayed on it till the 1 2.04 LTS
release. Unity had grown and
evolved into something entirely
better over that year, and so I grew
to like it.

Today I use Xubuntu. I know it is
not Ubuntu itself, but it is a direct
derivative just using the Xfce
So I did, and was very
desktop environment. It suits
impressed. I then took my PC and
every need I have and is light on
installed Ubuntu and really just
resources. I know it lacks a lot of
used it for my everyday basic stuff. Ubuntu's features but it does have
I soon got to dive in a bit deeper
some of its own that I still prefer
with the customization of the
over Ubuntu. I always advocate the
system, I loved using Compiz for its use of Ubuntu or any of the direct
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derivatives. I have converted
several people’s computers at the
end-of-life of Windows XP, and
they love it. I support Linux in
general but Ubuntu was my first
distribution and I will always stay
within the Ubuntu Family.

I

by Brian Bogdan

started in my computing life,
like most others, with Windows.
Started with 3.1 1 , paid again for
Windows 95, then 98, (even
Millenium!!), Windows XP,
Windows Vista (say it isn't so!!) and
finally Windows 7. That was a heck
of a lot of money. I had looked at
Ubuntu with Jaunty. It was
interesting, but I found it hard to
understand and the file system
kept getting corrupt (Hello fsck!!!).
I had loaded Jaunty on dual-boot
with Windows.
I went like that for a while, until
my Windows partition got
corrupted, resulting in needing a
reinstall of the OS. I wiped Ubuntu
off at the same time. A little while
later, I decided to revive my old
Windows ME laptop; 500 MHz

Celeron, 51 2 MB Ram. Since I
couldn't update it, I put Puppy
Linux on it. Lucid I think. In any
case, it purred along quite nicely,
thank you very much! Well, soon
Puppy Linux bit me. I got a new allin-one computer from a friend who
needed a hard disk. I had no copy
of Windows to work with it so I
explored putting Puppy on it as
well.
I wondered why would I do
that? I decided to look at Ubuntu
again. While I was installing Lucid
Lynx on the new computer, I
immediately put my Windows box
up for sale. Since then I have not
used a Windows product outside
of a virtual machine, and have
never looked back. I really love the
performance, stability, and
customization of Ubuntu. Only
thing I needed Windows for was to
sync my Zune (yes, I was the one
who bought that!). Now I have a
Zen and no longer need anything
Microsoft any more.
I am running Ubuntu 1 4.04 on
an HP TouchSmart PC, Intel ®
Core2 Duo Processor T5850
(2.1 6GHz), 4096MB PC2-5300
DDR2 SDRAM, and a 1 .5TB hard
disk. Way more than I need as far
as power goes. I love Ubuntu. I
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don't like Windows. I use Unity and terminal occasionally but still have
am quite happy with that. I have a to look up commands.
saying... Linux is NOT Windows, It
does NOT WANT to be, Don't try to
At this time, I'm using Mint 1 7
MAKE it be!
on my main computer, Ubuntu
1 2.04 on an old computer on my
network for family use, and
Makula, which I just installed to try
out on my original Linux machine –
with the same 2 HDs. It worked
by Trudy Thorgeirson
fine until I updated a few minutes
ago and I'm afraid I'm having
first tried Ubuntu somewhere
problems. I will do a clean install
around 8 or 9 years ago – I think and try again. I use this computer
it was Edgy Eft 6.1 0 – as a duajust for fun – trying something
boot with Windows XP. I had
new, without endangering my main
always understood that Linux OS's computer which I built myself.
were very difficult – and only for
the very experienced – but I didn't
I find the HowTo tutorials, eg
like being controlled by Windows. I Inkscape, in Full Circle excellent.
have had a PC since the 1 980's –
started with DOS and a short
experience with a PDP8 in the
1 970's [I am very senior!] but I was
by no means an expert. I expected
to learn slowly over some months.
by Danny O’Brien
However I was quite comfortable
in a few days. This was fortunate as
o start off I would like to
the HD with Windows (I was using
mention that I was a Windows
separate HD's) died. I replaced the junkie for many many years,
HD but not the Windows OS and
actually since Windows 3.1 up to
haven't used Windows since except and including my last Windows OS,
on my old notebook. I think I have Windows 7. I was sick to death of
used every upgrade since.
the constant
download/install/update/reboot
I am still learning. I use the
cycles, the huge amounts of HDD

I
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requirements for the system, and
the constant fear of virus threats.

initially hooked.

I also noted that the HDD
I would love to shake the
requirements (after 3 years now
hand(s) of every single person who and counting) was amazingly low,
made the Linux/Ubuntu free OS.
actually about 1 /4 to 1 /2 of what
And if I knew how to program, I
Windows OS on the same system
would throw some of my
required. Also the boot-up time
knowledge your way as well. I
was literally within 1 0-1 5 seconds.
believe that things like this
Even after all these years and a
SHOULD be free and open. Well,
few extras, still amazingly fast. I
enough about my rant (lol). I first
need to do a re-installation (just to
started using Ubuntu 1 2.04 back
keep things fresh) only once a year.
when it first came out in 201 2. I
Unlike Windows: after 3 to 4
loved the fact that I could (and did) months (if you’re lucky) the system
create a bootable USB device to
would be amazingly S.....L....O....W.
run tests on my computer to see 1 )
If i liked it, 2) was it compatible
Also, the threat of viruses has
with my hardware, 3) would it be
all but gone from my mind. It took
easy to use.
me the longest time to get out of
the habit of having to scan every
Well all three have hit a
single installation prior to install –
resounding YES. What I found
every single file I downloaded or
amazing was that under the
received.
Windows 7 environment, when I
would plug my cell into it to do a
There are, however, a couple of
simple file transfer via the USB
downsides. One: support for java is
cable, Windows would NOT
usually an issue. But I managed to
recognize my cell. So I had to
get it working after a bit of
resort to third party applications
research and head-scratching :)
to do a cell backup (I DON'T like
Another smaller issue, but not a
installing apps I don't know about). big problem, is the limited printer
When in my testing phase via the
compatibility. After a few days of
boot-USB device, Ubuntu had NO
research and many times banging
trouble recognizing my device. I
my head on the wall (not literally
was more than AMAZED, I was
of course, lol), I had to get a new
full circle magazine #1 00

printer to ensure that it would
work on Linux.
The last thing I would like to
mention: I wish there was a way to
do a system restore (dare I say it,
like Windows, gulp) to a point in
time in case of a faulty install or
perhaps a faulty tweak that I did,
lol. But other than that, keep up
the AMAZING work on all the
projects you undertake, and as
always have a happy and safe
computing experience. Cheers!

by John Kerr

O

nce upon a time, Linux was
very rough around the edges.
Downloading four CDs of code to
install Linux was common, and we
had to do this for every distro
upgrade. We had to do some
tweaking of the software.
Sometimes getting the spell-check
to work with OpenOffice was a
real challenge, and/or things that
we fixed six months earlier would
break with a distro upgrade. I can
not say that this was enough to
make me quit using Linux, but I
could see quite clearly why Linux
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was not ready for "prime time".
And that was frustrating because I
knew that Linux had so much to
offer.
Then came this guy named
Mark Shuttleworth with his Ubuntu
Linux distribution: "Linux for
human beings", one disc to
download, and a promise not to
break anything, was just what I was
looking for. Finally, Linux was
making big steps towards
becoming mainstream. I have been
with Ubuntu ever since Warty
Warthog, and I have not looked
back. At one point, Google
searches for the word Ubuntu
overtook the number of searches
for Linux.
Ubuntu also made the
installation of a Debian based
distro very easy. Previously,
Debian was very difficult to install
compared to other distros, but the
.deb package management system
was far superior to them all.
Of course we also have to thank
Klaus Knopper for his invention of
the live-CD. The live-CD and the
Ubuntu distribution have
introduced Linux to many people
who otherwise would not have
tried Linux at all.
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by Shannon D Jones

started using Ubuntu in 2008
with Hardy Heron on my Toshiba
Satellite. I dual booted with
Windows Vista, which was the
reason for me using Ubuntu to
begin with, until around the
beginning of 201 0.
When Ubuntu introduced the
Unity desktop, I switched to
Lubuntu because I just didn't like
the way it looked, plus it slowed
down my computer. In 201 2 I got
an Acer Aspire One, and continued
to use Lubuntu until the fall of
201 4, when I started using
Peppermint 5. In June, 201 5, I
switched back to Lubuntu and am
now running Lubuntu Vivid Vervet
1 5.04.

by Ronnie Tucker

A

s a bit of fun I thought it'd be
nice to share my Ubuntu
story. Well, that and I needed to fill
the rest of this page somehow.

It was late 2006 (if my memory
serves me right) and I was still
using Windows XP. Right around
the corner, though, was the (now
dreaded) Windows Vista. I really
didn't like the thought of it, XP had
been giving me grief, and I was just
(in general) getting fed up with
Windows' nonsense.

time, but after the great
HDDisaster of yesteryear (see the
unfinished issue of FCM for that
debacle) I had no Kubuntu DVD to
boot from and ended up having to
use an old Mint DVD from a
magazine.

After a reboot with a Kubuntu
CD I was much happier.

I think that good ol' vanilla
Ubuntu could be my new home.

It was about six months later
that I had a crazy idea about doing
an Ubuntu magazine.

For good? Wel, only time will
tell!

That got me back into my
system again and I managed to get
I'd tried Linux briefly in the past everything reinstalled and my
cloud backups reinstalled. So, I
with the odd try of RedHat and
stayed with Mint for a while until a
Mandrake, but nothing serious.
new Kubuntu came out. Then, I
This new kid, Ubuntu, seemed to
ditched Mint and returned to
be creating a bit of a buzz, so I
Kubuntu.
decided to give it a try via a live
boot CD. It seemed OK, so I
After recent tangles with
installed it.
Kubuntu (and Plasma 5) I ditched it
again for just plain vanilla Ubuntu
Gnome was OK, but I quite
1 5.04.
fancied the look of KDE, so I
installed the KDE desktop. Well,
My biggest worry was, of
that'd didn't go down well. I now
course,
Unity. To my surprise it's
had two desktops and a 'start'
matured a great deal and is now
menu that was a mass of
very usable.
applications.

I stayed with Kubuntu for some
full circle magazine #1 00
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If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
full circle magazine #1 00
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If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

My laptop came with 1 4.1 0.
Q Should
I upgrade to 1 5.04?

A

Yes, 1 4.1 0 has expired, so
you're not getting updates.
The same thing will happen with
1 5.04, you will need to upgrade to
1 5.1 0 around the end of the year.

must have the same codec settings Manager can also be used to
for video and audio.
remove old kernels. For example,
search for "3.1 9.0" to see all the
kernel files in that series.
I get this same error message
whenever I try to update my
system (lubuntu 1 5.04): Not
I want to update from 1 2.04
enough free disk space.
to 1 4.04, but get this result:

Q

Q

A

(Thanks to Vladlenin500 in
the Ubuntu Forums) The
How can I join two webm
default size the installer assigns to
videos whilst keeping the
the /boot partition is really small,
same quality?
so small that just a few kernel
versions are enough to fill it up.
(Thanks to TheFu in the
Ubuntu Forums) One solution: The updater is complaining about
lack of space in that partition,
Put both into a mkv file using:
nowhere else.

Q

A

mkvmerge, then use mkvmerge
to append one into the other.
mkvmerge -o file1.mkv
file1.webm
mkvmerge -o file2.mkv
file2.webm
mkvmerge -o
joined_file1_2.mkv file1.mkv
file2.mkv

These commands take the
amount of time a file copy takes.
No transcoding needed. There are
some requirements. Both files

(Comments from the OP) The
command:
dpkg -l | grep linux-image-

showed nine installed kernels. To
remove one, I used a command
such as:
sudo apt-get -y purge linuxheaders-3.13.0-24 linuxheaders-3.13.0-24-generic

Gord notes: Synaptic Package
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root@xaylo-Inspiron3542:/home/xaylo# sudo dorelease-upgrade
Checking for a new Ubuntu
release
No new release found

A

(Thanks to
grahammechanical in the
Ubuntu Forums) Run Update
Manager. Click the button that
says "Settings." Then go to the
Updates tab and look at the dropdown menu for the panel called:
Notify me of a new Ubuntu
version. There are three settings.
Any new version; for long-term
support versions, and never. You
need the setting: for long-term
support versions.

up Kontact but get
Q thisI'm setting
error message after
entering my gmail email and
password: "The server for account
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"Google Mail (XXXXXX)" refused
the supplied username and
password...."

A

(Thanks to qamelian in the
Ubuntu Forums) Check the
security settings on your actual
Gmail account on the Web. By
default, Gmail now blocks access
by email client apps that Google
deems not sufficiently secure. To
work around this, you need to tell
Gmail to allow access by insecure
applications. On the Gmail web
interface, click on the cog icon to
go to settings. Click on Accounts
and Import. Under Change Account
Settings, click on Other Google
Account Settings. This opens the
My Account page. Under Sign-in
and Security, click Signing in to
Google. After the page loads, scroll
almost to the bottom. You will see
a slider that lets you toggle the
setting for Allow Less Secure Apps.

I started with an empty hard
Q drive.
I created two partitions
on the drive, and installed
Windows on the first one, then
Ubuntu on the second one.
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However, the result does not work
as I expected.

A

(Consensus of many recent
posts in the Ubuntu Forums) It
will work better if you create one
partition taking half the space and
install Windows there. Then tell
the Ubuntu install to use the
empty space.

computer that is running Ubuntu
Server
http://goo.gl/HGuda9
* I accidentally deleted the
network-manager and don't have
access to internet anymore
http://goo.gl/NmVH7A
* Do I "need" DKMS?
http://goo.gl/9DEyhf

TOP QUESTIONS AT
ASKUBUNTU

* How do unknown fonts get
substituted?
http://goo.gl/WDxEZV

* What does the command name
"dd" stand for?
http://goo.gl/rWHwuT

* syslog doesn't exist!
http://goo.gl/9VUmZH

* Why isn't Oracle Java included in
the standard Ubuntu repo?
http://goo.gl/9HXOzv

TIPS AND TECHNIQUES
Y’ER A MORON IF...

* Why does cups get updated so
often?
http://goo.gl/KlX3ah
* Getting details about a package
before installing it?
http://goo.gl/nlCYP5
* Is my hard-disk doomed?
http://goo.gl/8KmA6J
* Reason to keep a GPU in a

I

was planning to save this to be
my swan song, but the idea of
using it in issue 1 00 is compelling.
I spend quite a bit of time
winnowing the Ubuntu Forums for
the Q&A column. When I find
myself yelling, "it doesn't work
because you're a moron" at the
screen, I figure this is not really
productive. However, it might be
entertaining.
full circle magazine #1 00

"My hard drive died, and I really,
really need the files from it." And
you never heard of "backup"?

has trained us badly about upper
and lower case.

"I downloaded [some program] and
installed it, but it doesn't work."
"How can I make the fan on my
And did you read the system
computer run slower?" There are
several methods, if you don't mind requirements for [some program]?
If possible, try to install programs
your computer catching fire.
using a supported method, such as
Software Center, Synaptic or apt"My wish list is $2,000 long, and I
have found this computer for $1 98. get.
Will it do what I want?" Probably
"How do I compile such-and-such
not.
package?" Where such-and-such is
already in the repositories, so
"How can I speed up my 2008
compiling is counter-productive.
netbook?" Seven years ago you
bought the slowest computer
"I don't know how it is possible to
which was available, and you're
limit number of partitions on a
complaining about performance
particular laptop..." And maybe we
NOW?
can reverse gravity if we just work
"I wanted a file server, so I installed on it. (FOUR primary partitions is
an absolute limit in the MBR
Ubuntu Server." Which takes 1 0
partitioning scheme, and an
times as much effort to set up as
Extended partition is the way
Ubuntu Desktop, with no
around it.)
offsetting benefit, unless you're
running a high-volume web server
or some other application where a "I have a Gazorks 1 23x and it has
such-and-such problem..." And
performance gain might be
when I Google "Gazorks 1 23x
important.
Linux," the solution appears before
my eyes. Google is your friend!
"I entered the command 'cd
downloads', and Ubuntu said no
"the thing is that I encrypted my
such file or directory." OK, we all
home folder..." There are many
did this -- at least once. Microsoft
things which can go wrong, why
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add to the list?
"Program XYZ is confusing..."
Sometimes you need to spend a
little time with the tutorials, in
order to use a powerful program.
"My eight-year-old video card died,
so I bought this five-year-old video
card...." You didn't have 20 bucks
for a three-year-old video card?
"I suddenly started having odd
video effects..." And did you
consider that it might be a
hardware problem?
"I tried to install Windows on my
computer, but it just displayed a
Blue Screen Of Death, so I tried
Ubuntu...." Even a wonderful OS
can't fix hardware problems.
"I tried to install XXXXX but it
failed." Yup, that's what happens
when you don't tell us what
version of Ubuntu you are using,
how you tried to "install" XXXXX,
or how you recognized "failed."
"I screwed up my system because I
didn't know what I was doing, so to
recover, I edited a system file."
What was going through your mind
when you decided to compound
your mistake?

"I need to use this obsolete version
of Ubuntu." No, don't do that. Try
Lubuntu or Xubuntu, or Puppy
Linux or Slitaz. Nothing good
happens when you run software
which is not getting security
updates.
"I have a Dell laptop that has intel
3000 graphics as well as a Nvidia
GeForce GT 525M 525M graphics
card..." The poster asks a
reasonable question, but seven out
of seven responders demonstrate
that they can't read. For example:
"run lspci." The Original Poster
(OP) knows exactly what is in his
computer, so there is no need to
run lspci.
"How can I install my wireless
mouse?" Replace the dead battery.
"I have a Toshiba Satellite..." Which
tells the reader it's a laptop, but it
might contain just about anything
inside. Can't help without some
details!
"I was trying to set up my backup
program, and I got this error
message..." And it didn't occur to
you to tell us the name of the
backup program?
full circle magazine #1 00

"I don't know what model this
laptop is." Close the lid, flip it over,
and read what's on the label! You
might need to pop the battery.
"Why did installation fail? I got this
warning message." It's just a
warning, the installation worked!
"My resolv.conf is being ignored at
boot time." Nope, it's not ignored
at boot -- it's generated at boot. If
you tell us what your actual
problem is, perhaps someone can
help you.
"With setting up the separate user
account's, will they be able to
access the drive from there
Windows system?" If English is not
your first language, I am happy to
make allowances. If you're just
illiterate you probably won't be
able to answer my questions. (My
wife is Chinese...)
"I need to upgrade my server from
7.04 with minimum downtime and
no loss of data." Let's see, server
7.04 expired THREE YEARS AGO.
Don't be surprised when people
suggest you buy a new system, or
at least a new hard drive, and
install onto that, then copy your
data over.
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"I have saved many files, and now
all my memory is gone!" Or maybe
all your disk space.
"I want to modify the
/proc/cpuinfo file. I need to edit
the Serial parameter in the cpuinfo
file." Cpuinfo isn't actually a file, so
you can't edit it. And it doesn't
contain a Serial.
"I have Apache 2.4 set up on my
Ubuntu 1 4.04 and right now it is
way too slow." But there was no
useful information about the
computer or the installation.
Perhaps the OP should expect the
results he is seeing.
If you recognize yourself in any
of the above, I just want to say,
"I'm very, very thankful that I'm
not you."

Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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V i r u s e s : T h e F i r s t 3 0 Ye a r s

Written by S. J. Webb

hat is the age of a computer
virus? Who created the first
computer virus? Yet these simply
crafted programs can cause so
much havoc. The idea of the first
computer viruses were published
in 1 966. The article The Theory of
Self-Reproducing Automata is a
posthumously published work by
John Neumann. Apparently, in
1 949, self-replicating programs
were created to produce viruses.
John Neumann is shown below.

In 1 959 Bell Labs created a
computer game called Darwin. The
creators, Victor Vysottsky, H.
Douglas McIlroy and Robert P
Morris, designed the game where
viruses/species competed against
the PC’s processor. Further details
about Darwin can be found here:
http://www.cs.datmouth.edu/~dou
g/darwin.pdf

computers running the Tenex OS.
This virus would only display a
message “I’m the creeper, catch
me if you can!” Henceforth the
name of this virus is Creeper. While
it was annoying, this virus was not
malicious. In response, Ray
In 1 971 , the first computer virus Tomlinson wrote a program named
was created by Bob Thomas. Using Reaper which would delete the
Creeper on Tenex OS computers.
ARAPANET, this virus infected
Consequently the Reaper is the
first antivirus program created.
This is the earliest documented
programming game as shown by
the picture below. This game
eventually stalled when one of the
creators developed a virus/species
that could not be conquered.

The first malicious virus was
created in 1 974 called Rabbit. This
viral program would clone itself on
a computer hard drive. The cloning
process would sap the computer’s
resources until it eventually
crashed. The virus creator is
unknown.
A year later, John Walker
created Animal. Animal would
infect Univac 1 1 08’s. This program
would ask a series of questions to
the end user. The computer would
attempt to guess what animal the
end user liked based on the
answers. A simple OS upgrade
would neutralize this threat.
full circle magazine #1 00
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In 1 979 Millersville State
Next month Linux Lookback will
College experienced the first
finish off the history of computer
“sneakernet.” Two random seed
viruses.
instruction cards were placed into
the card stack for the Univac
computer. The seed instruction
cards simply overworked the
computer with minimalist outputs.
SJ Webb is a Linux Hobbyist and
There was no permanent damage
Research Coordinator. He enjoys
fishing, hot rodding, and spending
to the system. One person took
time with his kids and wife. He
credit for the incident and paid a
Mike Ferarri for his
minor fine for it. Consequently, the thanks
mentorship.
college instituted a tracking policy
for individuals.
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Written by Oscar Rivera

was first introduced to Linux six
years ago when I began using
Ubuntu as a result of a broken
Windows XP desktop. I was
immediately fascinated by
everything that Ubuntu had to
offer. I was also mesmerized by the
concept of Free Libre Open-Source
Software, and the myriad of gifts
that came bundled with Linux such
as the GPL, Richard Stallman's
visionary philosophy, Linus
Torvalds and his very colorful rants,
the freedom to modify whatever
software I wanted, etc. The
GNOME desktop environment at
the time made more sense to me –
coming from a restricted Windows
environment. The ability to get any
piece of software from the Ubuntu
Software Center was the most
brilliant idea ever at a time when
the Apple iOS App store and the
Android Play Store were just
getting started.
But then my smile turned into a
frown when I looked into gaming
on Linux and discovered that Tux
Racer was the most exciting game
available. There was also the
Windows Emulator, WINE, but I

didn't have a good experience with
it at first, and, for the most part,
I've been able to live without it for
the last six years.

was using a Dell Precision 360 PC
pre-installed with Windows XP that
was about six years old – Windows
7 having just been released.
Although the computer was a
Eleven Ubuntu releases later, I
workstation, due to its age (and
am more than ecstatic to say that
graphics card) it couldn't play most
the future of Linux gaming looks as AAA games available for Windows
promising as ever. I began using
at the time. When the PC broke
Linux at a time when Linux gaming down due to a virus (viruses being
was beginning to undergo its most a common nuisance for ALL
critical changes since the inception Windows users), I had to wait
of Linux back in 1 992. I've been
about two weeks for Dell to kindly
able to not only see the fruit of
send me the re-installation discs. I
those seeds blossom, but I've also eventually got two discs, one to
had the pleasure to report back my install Windows XP, and the other
findings through Full Circle
to install the outdated drivers
Magazine. It's been a wild ride so
which took me a couple of days to
far, and I'm willing to bet we're
update. However, being that I
bound to travel to unforeseen
needed a working computer, and
places which at one time might
having heard of Linux through a
have only seemed like a dream or
friend, I decided to look further
an illusion. Full Circle Magazine's
into it. After a day's worth of
1 00th anniversary couldn't have
research, I opted to install Ubuntu
come at a better time. Where
1 0.04 LTS, and I was immediately in
we've come from, where we stand, love with my PC. That old piece of
and where we're headed could
junk was now a pristine
very well be a video game, and you, workstation, faster and more
the reader, are player one. Let's
efficient than anything I'd ever
play.
used up until then. How could I not
love that? Everything was greener
When I first began using Linux, I on this side of the hill. Everything
full circle magazine #1 00
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except for the quality and quantity
of video games available for Linux.
Sure, there were some games
available, but compared to
Windows it was like David v.
Goliath. Little did I know that all of
this was beginning to change.
Having used Ubuntu for about a
year or so helped me with some
basic understanding of the
relationship between hardware
and software, and I was able to
build my own PC for the first time
ever. Because of work-related
software, I had this PC dualbooting between Windows 7 &
Ubuntu 1 0.1 0, but the games on
the Linux side of the fence still
weren't too appealing. For about a
year, whenever I was using
Windows I found myself doing a lot
of gaming, but, while using Linux, I
was actually getting work done
and learning more about how Linux
works.
Eventually, I discovered the
Humble Indie Bundle. With the
purchase of Humble Indie Bundle
V, suddenly I was positively
overwhelmed with eight of the
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best games I'd played in years, not
just on Linux but on any system or
console. Eventually, all of these
games were made available for
Linux. Amnesia: The Dark Descent,
arguably one of the best and
scariest horror games ever
conceived, was the main reason I
bought this Humble Indie Bundle
(it has since changed its name to
simply the Humble Bundle).
Playing Amnesia on Ubuntu only a
couple of years after it was
released for Windows PC gave me
hope that the tide was changing
and Tux the Penguin was about to
ride the incoming tidal wave. The
game played exceptionally well on
Linux, almost as if it had been
made exclusively to scare Linux
geeks. But this was just the tip of
the iceberg. I also discovered
Bastion, a funny and delightfully
entertaining platformer which was
compatible with my game
controller and had the most
exquisitely colorful, cartoon-like
graphics. The soundtrack could
stand on its own as a music album.
The game's narrator and his funny,
oddball comments still remain as
one of my favorites.
Then, there was Limbo, a blackand-white platformer with no
tutorial nor explanation – which

quickly became somewhat of a
sleeper hit with its minimalistic
approach and mind boggling
puzzles. Limbo was one of the first
games I played that used real
pencil drawings as backgrounds
throughout the game. A
screenshot of it is included here.
Linux sales figures from the early
Humble Indie Bundles let the
gaming industry know that there
was money to be made by catering
to Linux gamers. On average, Linux
gamers were paying almost twice
as much for early Humble Indie
Bundles as their Windows
counterparts. Indie game
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developers and distributors took
note of this and so did bigger
game distributors, like Valve.
Thank you Humble Bundle.
More than anything, Humble
Bundle's contribution was that it
let the world know that there was
money to be made from Linux
gamers. All we needed now was an
established brand to pay attention
and lead the way. Was there any
company that would risk gambling
on a system that had a <1 .0% user
base? Then it happened, Microsoft
handed us Steam on a silver platter
by releasing Windows 8, one of its
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most hated operating systems
ever. Microsoft's dreams of an
Apple-like controlled jail in the
form of the Microsoft Store
motivated Valve's owner, Gabe
Newell, to bring the Steam game
engine over to Linux.
Now, there was no looking back.
It was a slow change at first. A
handful of games began to be
ported over to Linux. However,
some of these games had already
been huge Valve hits, like Portal,
Team Fortress 2, and Left 4 Dead 2.
These Linux ports proved to
exceed everyone's expectations of
what Linux games had the
potential to be. With the
announcement that SteamOS
would be based on Ubuntu, this
meant that Steam's game library
might someday become available
on Linux. This has proven to be
something that has helped more
than just gamers. One of the
biggest hurdles we've had to
overcome has been the poor
quality of proprietary graphics
drivers for Linux. Although the
free, open-source drivers are
perfect for most of our day-to-day
uses, that's not the case when it
comes down to gaming.
Unfortunately, in order to enjoy
PlayStation 4 quality games, it is a
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necessity that your system be
equipped with the latest
proprietary graphics drivers. Since
Steam first became available for
Linux, Nvidia and AMD quickly
realized that a significant enough
portion of their consumers were
running Linux at home, and they
would not benefit from ignoring
this growing minority. Alas,
proprietary graphics drivers for
Linux began to rival the same
manufacturer's drivers for
Windows and Mac OS X. That's
when we knew that dreams do
come true. It was also then that

many dual-booting gamers began
to completely nuke their Windows
partitions as there was no longer
any need for it.

a couple of months away from the
official release of the Steam
Machines and the official SteamOS.
In fact, I've already pre-ordered my
Steam Controller and I should be
The Linux release of games such getting it delivered sometime
as The Witcher 2, Dota 2,
during October according to my
Borderlands 2, Dead Island and
receipt. At around the same time,
more recently Bioshock Infinite
there should be an ample amount
and Borderlands:The Prequel was
of Steam Machines available
proof that Valve was staying true
ranging from around $450 USD up
to its word on the SteamOS and
to $2,000+ depending on what
Steam Machines plans. Although
kind of horsepower you want and
Valve was plagued with delays
how much you're willing to shell
through most of 201 4 and the
out for it. Although Dell, HP,
early part of 201 5, we are now only Lenovo, System 76 and others have
been selling Linux PCs for a while,
this is the first time I've ever seen a
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wide advertisement, promotion &
sale of PCs pre-loaded with Linux.
Always an innovator and a
leader, Valve was willing to gamble
on Linux so it was bound to happen
that other companies would
eventually follow. It is now
common news to hear of new
game developers, distributors,
resellers, etc, bringing their games
over to Linux. Warner Brothers has
recently released Middle-Earth:
Shadow of Mordor for Linux, and
are supposed to be bringing
Arkham Knight to Linux by
November. We are currently
witnessing the greatest paradigm
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shift in the history of Linux
gaming. Thank you Valve.

game to be played on Ubuntu or
any other Linux distro, please
restart your PC and make the
Although the Humble Bundle
purchase while using Linux. Each
and Valve's Steam have been
and every Linux sale counts.
pivotal in bringing AAA games to
However, a sale of the same game
Linux, like everything open source bought through Windows (or Mac
it's been the Linux community that OS X) is yet another number
has played the biggest role in
against us. Also, support as many
bringing about this long-soughtdistributors as possible. I've been
after change. The financial support buying my games not only through
that the Linux community has
Steam, but also through Humble
invested into Linux gaming has
Bundle, GOG, and at times from
been the big game changer. As
the developer if at all possible. I've
soon as Humble Bundle began to
also financially backed games
release bundles with Linux games, through www.kickstarter.com.
it became evident that Linux
However, if you're going to go
gamers were willing to spend more through that route, I advise that
than their Windows & Mac OS X
you give your support only if you
counterparts. As you can see in the are given a Linux-playable demo
chart I've provided of Humble Indie that ensures your money will not
Bundle V's sales numbers by
go towards a game that will be
platform, the average Linux
available only on another
purchase is $1 2.47 against
operating system and not on our
Windows' average of $7.98 which
beloved Linux.
is a common thread shared by
Humble Bundles with Linux games
Gaming, or lack-thereof, has
ever since.
kept the Linux user base at around
1 % worldwide since the inception
Which leads me to my closing
of the Linux kernel. Money talks,
thought for all of you gamers out
and a vote with your wallet not
there. Let's all do the best we can only buys you a great game, but it
to improve Linux gaming by
also helps the overall ecosystem of
financially supporting Linux games. your favorite operating system. It
If you still dual-boot with
helps by letting hardware
Windows, and are about to buy a
manufacturers and software
full circle magazine #1 00

providers know that ignoring Linux
is not profitable for them, which, in
turn, makes Linux-compatible
hardware/software more widely
available, easier to work with, and
its quality greatly improved upon.
So for what's been done and
what's to come, I say to you, the
Linux user, thank you for helping
Linux be all that it is and all it will
be. The future looks bright and we
all share the spotlight.

Oscar graduated from CSUN, is a

Music Director/Teacher, beta tester,
Wikipedia editor, and Ubuntu
Forums contributor. You can contact
him via: www.gplus.to/7bluehand or
email: www.7bluehand@gmail.com
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CHA CHA CHA CHANGES
Our admin went AWOL for months, and
I had no idea if/when the site
would/wouldn’t get paid. Initially the
plan was to move the site and domain
name to my hosting, but eventually I
managed to track him down and get
the FCM domain name, and site hosting
transferred to me.
The new site is now up. HUGE thanks to
Lucas Westermann (Mr. Command &
Conquer) for taking on the job of
completely rebuilding the site, and
scripts, from scratch, in his own time.
The Patreon page that I’ve set up is to
help me pay the domain and hosting
fees. The yearly target was quickly
reached thanks to those listed on this
page. FCM is not going away. Don’t
worry about that.
Several people have asked for a PayPal
(single donation) option, so I’ve added
a button to the side of the site

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a big help.

https://www.patreon.com/
fullcirclemagazine
full circle magazine #1 00
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Full Circle Team
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FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 06th Sept. 201 5.
Release :
Friday 25th Sept. 201 5.

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Lucas Westermann
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org
Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or
click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker

Magzter - You can also read Full Circle on Magzter.com:
http://www.magzter.com/publishers/Full-Circle
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